


Contents
Part 1: ON1 Photo RAW 2021 Overview.......................................................................1

Getting Help...................................................................................................................................................................................... 2

System Requirements....................................................................................................................................................................... 3

Installation........................................................................................................................................................................................... 3
MacOS...................................................................................................................................................................................................................... 3

Windows...................................................................................................................................................................................................................4

Upgrading from Previous Versions.....................................................................................................................................................................4

Launching ON1 Photo RAW 2021................................................................................................................................................ 4
MacOS......................................................................................................................................................................................................................4

Windows 7................................................................................................................................................................................................................4

Windows 8.1 and Windows 10............................................................................................................................................................................. 5

Licensing and Registration.............................................................................................................................................................. 5
If you have purchased ON1 Photo RAW 2021:............................................................................................................................................... 5

Trial version.............................................................................................................................................................................................................. 5

Product Improvement Program..........................................................................................................................................................................6

Uninstalling ON1 Photo RAW 2021.............................................................................................................................................. 6
MacOS......................................................................................................................................................................................................................6

Windows...................................................................................................................................................................................................................6

Working with Files............................................................................................................................................................................. 6
File access when using ON1 Photo RAW 2021 as a standalone application........................................................................................... 7

File access when using Photo RAW 2021 as a plugin.................................................................................................................................... 7

ON1 Photo RAW 2021 Modules................................................................................................................................................... 8
The Module Selector.............................................................................................................................................................................................8

Using ON1 Photo RAW 2021 as a Raw Editor............................................................................................................................ 9
ON1 Photo RAW 2021 workflow........................................................................................................................................................................9

The Editing Pipeline in ON1 Photo RAW 2021................................................................................................................................................9

Using ON1 Photo RAW 2021 with Adobe Photoshop.............................................................................................................11
Editing a photo From Photoshop without preserving changes made in Photo RAW...........................................................................11

Editing a photo From Photoshop to preserve changes made in Photo RAW.........................................................................................11

Using Photo RAW with Adobe Photoshop Elements..............................................................................................................12
Editing a photo in Photoshop Elements...........................................................................................................................................................12

Using Photo RAW with Lightroom Classic CC.......................................................................................................................... 13
Using ‘Edit In’..........................................................................................................................................................................................................13

File creation characteristics when using Edit In........................................................................................................................................ 14

Using ‘Plug-In Extras’........................................................................................................................................................................................... 14

File creation characteristics when using Plug-In Extras..........................................................................................................................15

Batch processing options with Plug-In Extras ......................................................................................................................................... 16

Using Plug-In Extras to combine multiple photos as layers in Photo RAW........................................................................................17

Working with Smart Photos................................................................................................................................................................................ 18

Moving Your Lightroom Catalog to Photo RAW.....................................................................................................................18
Which Lightroom Settings are migrated?........................................................................................................................................................21

Using Photo RAW with Apple Photos........................................................................................................................................23
Non-destructive editing with Apple Photos..................................................................................................................................................23

Using Photo RAW with Corel PaintShop Pro...........................................................................................................................24



Using Photo RAW with Affinity Photo.......................................................................................................................................24
Activating Photo RAW for use with Affinity Photo (Windows)................................................................................................................. 24

Activating Photo RAW for use with Affinity Photo (MacOS).................................................................................................................... 24

Editing a Photo in Photo RAW from within Affinity Photo.........................................................................................................................25

Extras..................................................................................................................................................................................................26
How to Import Extras...........................................................................................................................................................................................27

Organizing presets..........................................................................................................................................................................................27

What type of images can I import as Extras?............................................................................................................................................27

Using Extras With Layers in the Edit module................................................................................................................................................ 28

Using Extras in Effects........................................................................................................................................................................................ 28

How to Delete Extras.......................................................................................................................................................................................... 28

Customizing Photo RAW’s Keyboard Shortcuts.....................................................................................................................29
Modifying hotkeys.............................................................................................................................................................................................. 30

Part 2: Organizing with Browse................................................................................... 31
ON1 Browse Main Screen Overview......................................................................................................................................... 32

Workflow Basics in Browse................................................................................................................................................................................33

Getting Started window................................................................................................................................................................................ 34

Working in the Preview Area........................................................................................................................................................ 35
Alternative view modes.......................................................................................................................................................................................35

Using Photo RAW to display slideshows....................................................................................................................................................35

Fast Preview mode................................................................................................................................................................................................36

Persistent Thumbnail Cache.........................................................................................................................................................................36

Focus and Clipping views...................................................................................................................................................................................36

Clipping..............................................................................................................................................................................................................36

Focus Mask........................................................................................................................................................................................................37

Working in Grid View..........................................................................................................................................................................................37

Sorting photos in Grid view...........................................................................................................................................................................38

Working in Detail View........................................................................................................................................................................................38

Working in Filmstrip View...................................................................................................................................................................................39

Working in Compare View................................................................................................................................................................................ 40

Working in Map View.......................................................................................................................................................................................... 41

My Catalogs, Browse and Presets Panels..................................................................................................................................43
Differences between My Catalogs and Browse tabs................................................................................................................................. 43

Navigating Sources........................................................................................................................................................................................ 43

Cataloged Folders............................................................................................................................................................................................... 44

Adding photos to existing cataloged folders...........................................................................................................................................45

Local Drives............................................................................................................................................................................................................45

Cloud storage services...................................................................................................................................................................................45

Using Shortcuts.................................................................................................................................................................................................... 46

Managing Files and Folders in Browse........................................................................................................................................................... 46

Deleting a folder............................................................................................................................................................................................. 46

Renaming a file or folder............................................................................................................................................................................... 46

Creating a new folder.....................................................................................................................................................................................47

Copying and moving files and folders........................................................................................................................................................47

Show in Finder/Show in Explorer.................................................................................................................................................................47

Changing a folder’s thumbnail preview......................................................................................................................................................47

Albums Pane......................................................................................................................................................................................................... 48

Creating an album.......................................................................................................................................................................................... 48



Adding photos to an existing album.......................................................................................................................................................... 48

Removing photos from an album................................................................................................................................................................ 48

Delete an album.............................................................................................................................................................................................. 48

Publishing and unpublishing an album from ON1 Cloud Sync........................................................................................................... 49

Changing the album thumbnail preview................................................................................................................................................... 49

Nesting albums............................................................................................................................................................................................... 49

Dates Pane............................................................................................................................................................................................................. 50

Advanced Search Pane...................................................................................................................................................................................... 50

Using the Advanced Search pane................................................................................................................................................................51

Using advanced search options...................................................................................................................................................................52

Saving and modifying search results...........................................................................................................................................................52

Tethered Shooting................................................................................................................................................................................................53

Recent..................................................................................................................................................................................................................... 54

The Photo Panel..............................................................................................................................................................................54
The Navigator Pane (Detail and Filmstrip views only)................................................................................................................................. 54

The Levels Pane (Detail and Filmstrip views only)........................................................................................................................................ 54

Info Pane (all views)..............................................................................................................................................................................................55

Settings Applied...............................................................................................................................................................................................55

Metadata Pane......................................................................................................................................................................................................56

Metadata templates........................................................................................................................................................................................56

Embedding metadata.....................................................................................................................................................................................57

Reading metadata............................................................................................................................................................................................57

Keyword List Pane................................................................................................................................................................................................57

Refining the Keyword List..............................................................................................................................................................................58

Using hierarchical keywords with Photo RAW.........................................................................................................................................58

Importing Photos into Browse...................................................................................................................................................... 59
Bypassing Duplicate Files During Import...................................................................................................................................................... 60

Saving Import Settings as a Preset....................................................................................................................................................................61

Using Smart Organize to Manage Duplicates and More......................................................................................................61
The Smart Organize results window............................................................................................................................................................... 62

Working through the search results............................................................................................................................................................63

Using Auto Mark............................................................................................................................................................................................. 64

Advanced search options............................................................................................................................................................................. 64

Editing Photos in Browse...............................................................................................................................................................65
Ratings, Labels and Likes....................................................................................................................................................................................65

Use Auto Advance when culling your photos......................................................................................................................................... 66

Applying Edit Module Presets in Browse....................................................................................................................................................... 66

Copying settings and synchronizing edits.....................................................................................................................................................67

Sync All Settings.............................................................................................................................................................................................. 68

Resetting edits in Browse................................................................................................................................................................................... 68

Send to................................................................................................................................................................................................................... 68

Versions.................................................................................................................................................................................................................. 69

Using ON1 Photo RAW 2021 with two displays......................................................................................................................69
Turning Dual Mode on........................................................................................................................................................................................70

Using ON1 Cloud Sync with Photo RAW...................................................................................................................................71
Viewing your ON1 Cloud Sync Status..............................................................................................................................................................71

Viewing other ON1 Cloud Sync Devices in Browse....................................................................................................................................72

ON1 Cloud Sync File Formats...........................................................................................................................................................................73



When to choose one sync format over another......................................................................................................................................73

Managing sync options in Photo RAW......................................................................................................................................................74

Basic Cloud Sync Workflow within ON1 Photo RAW.................................................................................................................................74

Syncing presets and extras with Cloud Sync............................................................................................................................................74

Cloud Sync, Photo RAW and Photo RAW for Mobile................................................................................................................................ 75

Viewing photos in ON1 Photo Mobile........................................................................................................................................................76

Photo Management and Editing with ON1 Photo Mobile....................................................................................................................76

Mobile editing limitations with synced photos.........................................................................................................................................77

Part 3: Working in the Edit Module.............................................................................78
About the Edit Module................................................................................................................................. 79

ON1 Edit Main Screen Overview............................................................................................................................................... 80

Navigator, Levels, Info and History Panes..................................................................................................................................81
The Navigator Pane............................................................................................................................................................................................. 81

The Levels Pane.....................................................................................................................................................................................................82

The Info Pane.........................................................................................................................................................................................................82

Settings Applied...............................................................................................................................................................................................82

The History Pane...................................................................................................................................................................................................83

The Tool Well...................................................................................................................................................................................84
Crop Tool................................................................................................................................................................................................................85

Crop Tool Options Bar:..................................................................................................................................................................................85

Transform (Move) Tool....................................................................................................................................................................................... 86

Repositioning a layer...................................................................................................................................................................................... 86

Resizing a layer................................................................................................................................................................................................ 86

Rotating a layer................................................................................................................................................................................................ 86

Flipping a layer................................................................................................................................................................................................. 86

Restoring a layer after a move......................................................................................................................................................................87

Transform Tool Options Bar..........................................................................................................................................................................87

Text Tool..................................................................................................................................................................................................................87

Text Tool Options Bar.................................................................................................................................................................................... 88

Adjustment Brush (Local group)....................................................................................................................................................................... 88

Adjustment Brush Tool Options.................................................................................................................................................................. 89

Adjustable Gradient Tool (Local group).......................................................................................................................................................... 91

Adjustable Gradient Tool Options Bar:...................................................................................................................................................... 91

Manipulating gradient masks........................................................................................................................................................................92

Portrait (Faces) Tool..............................................................................................................................................................................................92

Portrait Tool Options......................................................................................................................................................................................92

Masking Brush (Mask Group)........................................................................................................................................................................... 94

Masking Brush Tool Options....................................................................................................................................................................... 94

Masking Bug (Mask Group).............................................................................................................................................................................. 96

Masking Bug Tool Options............................................................................................................................................................................97

Manipulating a gradient mask......................................................................................................................................................................97

Working with multiple masking bugs..........................................................................................................................................................97

AI Quick Mask Tool (Mask Group).................................................................................................................................................................. 98

AI Quick Mask Tool Options Bar ............................................................................................................................................................. 100

Refine Brush (Refine Group)........................................................................................................................................................................... 100

Refine Brush Tool Options............................................................................................................................................................................101

Chisel Mask Tool (Refine Group).....................................................................................................................................................................101

Chisel Mask Tool Options............................................................................................................................................................................101



Blur Mask Tool (Refine Group).........................................................................................................................................................................101

Blur Mask Tool Options................................................................................................................................................................................102

Healing Brush (Retouch Group)......................................................................................................................................................................102

Healing Brush Options.................................................................................................................................................................................102

Perfect Eraser (Retouch Group)......................................................................................................................................................................103

Perfect Eraser Options.................................................................................................................................................................................103

Retouch Brush (Retouch Group).....................................................................................................................................................................103

Retouch Brush Options................................................................................................................................................................................103

Clone Stamp (RETOUCH Group)...................................................................................................................................................................104

Clone Stamp Tool Options:.........................................................................................................................................................................104

View (Zoom) Tool................................................................................................................................................................................................104

Masking Basics.............................................................................................................................................................................. 105
The Masking Tools and View Options...........................................................................................................................................................105

Masking control options................................................................................................................................................................................... 107

Color Range selections................................................................................................................................................................................ 107

Luminosity masks...........................................................................................................................................................................................108

Masking tips.........................................................................................................................................................................................................109

Presets............................................................................................................................................................................................... 110
Applying Presets................................................................................................................................................................................................... 111

Inserting presets (Effects tab only).............................................................................................................................................................. 112

Creating Your Own Presets............................................................................................................................................................................... 112

Managing Presets and categories................................................................................................................................................................... 113

Importing & Exporting Presets.................................................................................................................................................................... 113

Deleting presets.............................................................................................................................................................................................. 113

Managing categories..................................................................................................................................................................................... 113

Creating nested presets................................................................................................................................................................................114

Camera-Based Presets.......................................................................................................................................................................................114

Setting up camera-based presets...............................................................................................................................................................114

Editing photos with camera-based presets..............................................................................................................................................114

Copying settings and synchronizing edits................................................................................................................................115
Resetting edits...................................................................................................................................................................................................... 116

Soft Proofing....................................................................................................................................................................................117

Other Edit Module Preview Options........................................................................................................................................ 118
Changing the magnification view ................................................................................................................................................................... 118

Before/After previews........................................................................................................................................................................................ 119

Show/Hide Mask................................................................................................................................................................................................. 119

Focus and Clipping Views................................................................................................................................................................................120

Clipping............................................................................................................................................................................................................120

Focus Mask....................................................................................................................................................................................................... 121

Showing or Hiding Edit Module Adjustments......................................................................................................................... 121

Basic Global Editing with Develop.............................................................................................................122
Develop Adjustment Panes........................................................................................................................................................ 122

Working with panes...........................................................................................................................................................................................122

Tone & Color....................................................................................................................................................................................................... 123

Camera Profile................................................................................................................................................................................................ 123

Tone................................................................................................................................................................................................................... 123

Color.................................................................................................................................................................................................................124

Adjusting Tone & Color settings via hotkeys.......................................................................................................................................... 125



Details.................................................................................................................................................................................................................... 125

Sharpening...................................................................................................................................................................................................... 125

Noise Reduction............................................................................................................................................................................................ 126

Styles................................................................................................................................................................................................................. 126

Lens Correction.................................................................................................................................................................................................. 127

Transform.............................................................................................................................................................................................................. 128

Creating and Adding Custom Camera Profiles.......................................................................................................................................... 129

Stylizing with ON1 Effects...........................................................................................................................131
Filters.................................................................................................................................................................................................132

Filter Overview.................................................................................................................................................................................................... 132

Applying Filters with the Add Filter Button.................................................................................................................................................. 132

Applying filters with the Filter Browser.......................................................................................................................................................... 133

Searching for filter styles inside the Filter Browser................................................................................................................................ 134

Saving filter styles as favorites.................................................................................................................................................................... 134

Working with filter panes.................................................................................................................................................................................. 134

Styles...................................................................................................................................................................................................................... 135

Filter Masks.......................................................................................................................................................................................................... 135

Deleting a Filter................................................................................................................................................................................................... 136

Filter Opacity....................................................................................................................................................................................................... 136

Blending Modes..................................................................................................................................................................................................137

How blending modes work..........................................................................................................................................................................137

Master Opacity, Blending and Mask options.............................................................................................................................................. 138

Filter Types...................................................................................................................................................................................... 138
Antique.................................................................................................................................................................................................................. 138

Black & White...................................................................................................................................................................................................... 139

Tone................................................................................................................................................................................................................... 139

Toner................................................................................................................................................................................................................. 139

Film Grain......................................................................................................................................................................................................... 139

Bleach Bypass......................................................................................................................................................................................................140

Blur.........................................................................................................................................................................................................................140

Borders................................................................................................................................................................................................................... 141

Channel Mixer..................................................................................................................................................................................................... 142

Color Adjustment............................................................................................................................................................................................... 142

Color Balance...................................................................................................................................................................................................... 143

Color Enhancer................................................................................................................................................................................................... 143

Color................................................................................................................................................................................................................. 143

Color Range....................................................................................................................................................................................................144

Cross Process.......................................................................................................................................................................................................144

Curves................................................................................................................................................................................................................... 145

Dynamic Contrast............................................................................................................................................................................................... 145

Film Grain.............................................................................................................................................................................................................146

Glow......................................................................................................................................................................................................................146

Grunge..................................................................................................................................................................................................................146

HDR Look............................................................................................................................................................................................................. 147

Lens Blur................................................................................................................................................................................................................ 147

LUTs........................................................................................................................................................................................................................148

Noise Reduction.................................................................................................................................................................................................148

Photo Filter...........................................................................................................................................................................................................149

Replace Color......................................................................................................................................................................................................149



Sharpening...........................................................................................................................................................................................................150

Skin Retouching..................................................................................................................................................................................................150

Split Tone............................................................................................................................................................................................................... 151

Sun Flare................................................................................................................................................................................................................ 151

Sunshine................................................................................................................................................................................................................ 152

Textures................................................................................................................................................................................................................. 152

Tone Enhancer.................................................................................................................................................................................................... 153

Vignette................................................................................................................................................................................................................. 153

Vintage.................................................................................................................................................................................................................. 154

Weather................................................................................................................................................................................................................ 154

Retouching with Portrait............................................................................................................................. 155
Inside the Portrait Pane................................................................................................................................................................ 156

Details.................................................................................................................................................................................................................... 157

Portrait AI Workflow......................................................................................................................................................................158
Subtle vs. Strong processing Options........................................................................................................................................................... 158

Working the Individual Portrait Panes .......................................................................................................................................................... 158

Using the Retouching Tools............................................................................................................................................................................. 159

Making Manual adjustments in Portrait AI................................................................................................................................................... 159

Fine-tuning a face’s mask............................................................................................................................................................................. 159

Working with eye and mouth overlays.....................................................................................................................................................160

Dealing with missing or ‘ghost’ faces......................................................................................................................................................... 161

Local Adjustments........................................................................................................................................162
Local tab............................................................................................................................................................................................................... 162

Painting with Color........................................................................................................................................................................................ 163

Working with Local Adjustments....................................................................................................................................................................164

Manipulating a gradient mask ...................................................................................................................................................................164

Other masking options................................................................................................................................................................................. 165

Using Custom Brushes to Add Overlays To Photos................................................................................................................................... 165

Tips for using custom brushes.....................................................................................................................................................................166

Part 4: Combining Photos with ON1 Photo RAW 2021........................................ 167
Working with Layers....................................................................................................................................168

Adding a New Layer.......................................................................................................................................................................................... 169

Opening a layered Photoshop file............................................................................................................................................................. 170

Creating an empty layered file................................................................................................................................................................... 170

Creating a Color Fill Layer........................................................................................................................................................................... 170

Working with the Layers Pane ........................................................................................................................................................................ 170

Layer Visibility ................................................................................................................................................................................................. 171

Changing Opacity ......................................................................................................................................................................................... 171

Changing the Layer Order .......................................................................................................................................................................... 171

Renaming Layers ............................................................................................................................................................................................ 171

Layer pane toolbar......................................................................................................................................................................................... 171

Changing Blending Modes ........................................................................................................................................................................ 172

Layer Masks .................................................................................................................................................................................................... 172

Adding layers via Filmstrip view.................................................................................................................................................................. 172

Using the Transform Tool with Layers............................................................................................................................................................ 172

Repositioning a Layer .................................................................................................................................................................................. 172

Resizing a Layer ............................................................................................................................................................................................. 173



Rotating a Layer ............................................................................................................................................................................................. 173

Flipping a Layer ............................................................................................................................................................................................. 173

Aligning Layers.................................................................................................................................................................................................... 173

Using Layers with Synced ON1 Cloud Files..................................................................................................................................................175

Using Existing Layered Files with ON1 Cloud Sync...............................................................................................................................175

Stitching Panoramas..................................................................................................................................... 176
Batch Processing Panoramas........................................................................................................................................................................... 177

Tips for creating great panoramas.................................................................................................................................................................. 177

Photo RAW Panorama Edge Options........................................................................................................................................................... 178

Blending HDR Images..................................................................................................................................179
Batch Processing HDR Images......................................................................................................................................................................... 181

Focus Stacking...............................................................................................................................................182

Part 5: Output and Sharing.........................................................................................184
ON1 Resize....................................................................................................................................................185

When Should I Use ON1 Resize?.............................................................................................................................................. 185
Using Resize with ON1 Cloud Sync Files...................................................................................................................................................... 185

ON1 Resize Main Screen Overview......................................................................................................................................... 186

Navigating the Preview Area.......................................................................................................................................................187
Navigator, Levels and Info................................................................................................................................................................................ 187

The Navigator Pane...................................................................................................................................................................................... 187

The Levels Pane.............................................................................................................................................................................................. 187

The Info Pane..................................................................................................................................................................................................188

Crop tool...............................................................................................................................................................................................................188

Working with the Crop Tool Overlay........................................................................................................................................................189

Crop Tool Options Bar.................................................................................................................................................................................189

Crop Tool Modes...........................................................................................................................................................................................189

Leveling the Image........................................................................................................................................................................................190

Adjusting the Image Size..................................................................................................................................................................................190

Using Document Size Presets.....................................................................................................................................................................190

Settings pane....................................................................................................................................................................................................... 192

Image Type...................................................................................................................................................................................................... 192

Method............................................................................................................................................................................................................. 192

Texture Controls............................................................................................................................................................................................. 192

Sharpening pane................................................................................................................................................................................................. 193

Film Grain pane................................................................................................................................................................................................... 194

Tiling pane............................................................................................................................................................................................................ 195

Gallery Wrap....................................................................................................................................................................................................... 196

Presets................................................................................................................................................................................................................... 197

Saving a Preset................................................................................................................................................................................................ 197

Soft Proofing in Resize...................................................................................................................................................................................... 198

Understanding Resize: How Big Can I Print?...............................................................................................................................................199

How Much Resolution Do I Need?.............................................................................................................................................................. 200

Export............................................................................................................................................................ 201
File Type................................................................................................................................................................................................................201

Location................................................................................................................................................................................................................201

Rename................................................................................................................................................................................................................202



Photo Size............................................................................................................................................................................................................202

Watermark...........................................................................................................................................................................................................203

Sharpening..........................................................................................................................................................................................................203

Tiling......................................................................................................................................................................................................................204

Gallery Wrap......................................................................................................................................................................................................204

Export Presets.....................................................................................................................................................................................................205

Exporting options..............................................................................................................................................................................................205

Printing..........................................................................................................................................................206
Printing Options............................................................................................................................................................................207

Printer Pane......................................................................................................................................................................................................... 207

Printing to a file.............................................................................................................................................................................................. 207

Print Area Pane...................................................................................................................................................................................................208

Page size vs. print size..................................................................................................................................................................................208

Watermark pane................................................................................................................................................................................................209

Sharpening pane................................................................................................................................................................................................209

Basic printing with Photo RAW.................................................................................................................................................209
Printing photos from ON1 Cloud Sync devices..........................................................................................................................................210

Printing Multiple photos...................................................................................................................................................................................210

Printing contact sheets..................................................................................................................................................................................211

Sharing to SmugMug...................................................................................................................................212

Other Sharing Options (MacOS Only).....................................................................................................213

Send to Other Applications........................................................................................................................214

Part 6: ON1 Photo RAW 2021 Reference................................................................215
Browse menus................................................................................................................................................................................ 216

ON1 Photo RAW (MacOS Only)...............................................................................................................................................................216

File Menu.........................................................................................................................................................................................................216

Edit Menu........................................................................................................................................................................................................ 217

Album Menu................................................................................................................................................................................................... 217

Photo Menu....................................................................................................................................................................................................218

Settings Menu................................................................................................................................................................................................219

Cloud Sync.....................................................................................................................................................................................................220

View Menu.....................................................................................................................................................................................................220

Window Menu................................................................................................................................................................................................221

Help...................................................................................................................................................................................................................221

Edit Menus..................................................................................................................................................................................... 223
ON1 Photo RAW (MacOS Only)..............................................................................................................................................................223

File Menu........................................................................................................................................................................................................223

Edit Menu.......................................................................................................................................................................................................223

Layer Menu....................................................................................................................................................................................................224

Photo Menu...................................................................................................................................................................................................224

Mask Menu....................................................................................................................................................................................................224

Settings Menu...............................................................................................................................................................................................225

View Menu.....................................................................................................................................................................................................226

Window........................................................................................................................................................................................................... 227

Help.................................................................................................................................................................................................................. 227

Resize Menus................................................................................................................................................................................ 228



ON1 Photo RAW (MacOS Only)..............................................................................................................................................................228

File Menu........................................................................................................................................................................................................228

Edit Menu.......................................................................................................................................................................................................228

Settings Menu...............................................................................................................................................................................................229

View Menu.....................................................................................................................................................................................................229

Window...........................................................................................................................................................................................................230

Help..................................................................................................................................................................................................................230

Preferences..................................................................................................................................................................................... 231
General Settings................................................................................................................................................................................................. 231

Scrolling Controls.......................................................................................................................................................................................... 231

Preview Background Color.......................................................................................................................................................................... 231

Accent Color...................................................................................................................................................................................................231

Application Language.................................................................................................................................................................................. 231

Legacy Browse Tab........................................................................................................................................................................................ 231

Show Folder Previews................................................................................................................................................................................... 231

Check for Update on Launch.................................................................................................................................................................... 232

Open External Files...................................................................................................................................................................................... 232

Double-Click in Browse.............................................................................................................................................................................. 232

Default Browse Location............................................................................................................................................................................. 232

Portrait AI Default......................................................................................................................................................................................... 232

Files....................................................................................................................................................................................................................... 232

What to Edit.................................................................................................................................................................................................... 232

Sidecar Options............................................................................................................................................................................................ 233

Treat RAW+JPG Pairs as a Single Photo.................................................................................................................................................. 233

Default Processing........................................................................................................................................................................................ 233

Plug-Ins................................................................................................................................................................................................................ 233

Photoshop....................................................................................................................................................................................................... 233

Lightroom....................................................................................................................................................................................................... 233

Apple Photos (MacOS only)......................................................................................................................................................................234

System..................................................................................................................................................................................................................234

Memory Usage.............................................................................................................................................................................................234

Scratch Folder Location..............................................................................................................................................................................234

Browse Cache................................................................................................................................................................................................ 235

Performance.................................................................................................................................................................................................. 235

Lightroom Migration Cache...................................................................................................................................................................... 235

Services................................................................................................................................................................................................................ 235

Cloud Sync..........................................................................................................................................................................................................236

Auto Mark............................................................................................................................................................................................................236

ON1 Photo RAW Common Keyboard Hotkeys....................................................................................................................237



ON1 Photo RAW 2021 User Guide	 Part 1: Overview	 1

PART 1: ON1 PHOTO RAW 2021 OVERVIEW

ON1 Photo RAW 2021 is a complete photo editor, built around a modern photo organizer and a 
sophisticated raw processing engine. Photo RAW lets you apply quick, non-destructive edits and stylized 
effects to your photos and perform expert portrait retouching using AI-based machine learning algorithms. 
Nearly all of your edits can be made globally or locally, and Photo RAW’s advanced masking tools let you 
make and refine complex selections with a few clicks, which makes applying filters, replacing skies, or other 
operations a breeze. For more detailed projects, Photo RAW includes a layers functionality for compositing 
and blending images quickly and easily—while still preserving complete re-editability. You can also combine 
photos into beautiful panoramas, stunning HDR images, and perfectly focus-stacked photos with the click 
of a button. 

ON1 Photo RAW 2021 incorporates a state-of-the-art raw processor, which lets you work in a fully non-
destructive workflow: you can quickly import, sort and view raw photos in Browse, and finish them in 
the Edit module without having to worry about saving your edits. The next time you open your photo, 
all of your settings will be remembered, and you can easily change settings, add new ones, or start over 
from scratch, all without having to save additional versions of your photo. Photo RAW 2021 is even non-
destructive when working with such non-raw formats as JPEG, Photoshop (PSD), PNG and TIFF.

When you’re done editing, you can perform industry-standard image enlargement on your photos—with full 
printing capabilities—and can easily share your images with friends and on social media. And, when Photo 
RAW is used in conjunction with the optional ON1 Cloud Sync service, you can capture, view and edit your 
photos across multiple computers and mobile devices without having to worry about their location. You can 
even share presets, and extras like backgrounds and textures, between two computers.
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If you have an existing raw editing and workflow app such as Adobe Photoshop, Adobe Lightroom Classic 
CC, Photoshop Elements, Affinity Photo, Corel PaintShop Pro or Apple Photos, ON1 Photo RAW 2021 
can also work as a plugin to these apps, letting you perform advanced editing tasks on your photos, while 
preserving your traditional workflow. And, when you’re using Photoshop, Lightroom or Apple Photos as 
your primary editor, you can even have your work saved so that it is re-editable inside Photo RAW at a later 
time.

Getting Help
You can find an extensive collection of 
video tutorials and help documents in 
the Help section of the ON1 website 
(on1help.zendesk.com). This is the 
best and quickest way to dig into the 
entire ON1 workflow and discover new 
techniques that will help you with your 
photo editing and organizing. There, 
you can search our Knowledge Base for 
frequently asked questions, common 
issues and more. 

Inside ON1 Photo RAW 2021, you 
can use the Learning Hub to directly 
display videos for getting started with 
the app, search the ON1 online help 
system—including with and online chat 
assistant—and the ON1 Shop, where 
you can purchase add-ons and courses 
for Photo RAW. If you’re a member of 
the ON1 Plus community, you’ll also 
find access to Plus content and loyalty 
reward downloads.

The Learning Hub is accessible via the Help menu or from the Help icon at the bottom of the left bumper 
panel.  

The Learning Hub is available directly from within ON1 Photo RAW 2021, and includes links 
to videos (which can be played directly in the Hub window), ON1’s online help system, and 
the ON1 store.

https://on1help.zendesk.com/hc/en-us
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System Requirements

MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.13, 10.14, 10.15, macOS 11
Windows 7, Windows 8 or Windows 10 
current maintenance releases, 64 bit only

macOS 10.15, macOS 11
Windows 10 
current maintenance releases, 64 bit only

PROCESSOR Intel Core i5, Xeon or better processor 4-core Intel Core i5, Xeon or better 
processor

RAM 8 GB 16 GB or more

HARD DRIVE 1.5 GB for installation 1.5 GB for installation 
SSD drive

DISPLAY OpenGL 3.3 compatible video card 
with 512 MB VRAM, 1280x800 
resolution (at 100% scale factor)

OpenGL 4.2 compatible video card with 
2GB+ of dedicated VRAM, 1920x1080 
resolution (at 100% scale factor)

THIRD-PARTY APPS 
SUPPORTED (PLUGIN)

Photoshop CS6; 
Photoshop Elements 14 
Lightroom Classic 6; 
Apple Photos; 
Affinity Photo; 
Corel PaintShop Pro

Photoshop CC 2020; 
Photoshop Elements 2020; 
Lightroom Classic CC 2020;  
Apple Photos; 
Affinity Photo; 
Corel PaintShop Pro

MOBILE APPS Apple iPhone or iPad with iOS 12.3 or 
higher; Android phone or tablet with 
Android 7 (Nougat) or higher.

current maintenance releases, 64 bit only

Apple iPhone/iPad with iOS 13 or 
higher; Android phone or tablet with 64-
bit Android 9 (Pie) or higher.

current maintenance releases, 64 bit only

INTERNET A high-speed internet connection and active account for ON1 Cloud Sync, 
activation, auto-update checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports pressure-sensitive tablets for controlling brush size and/or opacity, and 
external control devices (such as those from LoupeDeck and El Gato). Supports 
ICC/ICM profiles for camera input, display, soft-proofing, and printing. Hardware 
display calibration tool is recommended

LANGUAGES SUPPORTED English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

Installation
To install ON1 Photo RAW 2021, double-click the installer icon and allow the installer to guide you. Before 
installing or updating, close any supported host applications (Adobe Photoshop, Photoshop Elements, 
Lightroom, PaintShop Pro, Affinity Photo or Apple Photos) as well as any previous versions of ON1 
products.

MACOS

The application is installed in the ON1 Photo RAW 2021 folder in the Applications folder.

All plugin files for supported host applications (such as Adobe Photoshop, Lightroom, Photoshop Elements 
or Apple Photos) found during the installation process will be installed automatically; a summary of installed 
plugins will be displayed at the end of installation.
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If a previous version of ON1’s Photo RAW, Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS

The application is installed in the ON1 Photo RAW 2021 folder in the \Program Files\ON1\ directory. All 
plugin files for supported host applications (such as Adobe Photoshop, Lightroom, Photoshop Elements) 
found during the installation process will be installed automatically; a summary of installed plugins will be 
displayed at the end of installation.

If a previous version of ON1’s Photo RAW, Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Photo RAW on your computer, the installation process will move over 
any cataloged folders, albums, and metadata presets. 

Launching ON1 Photo RAW 2021
To launch Photo RAW 2021 as a standalone app, with access to all modules, follow these steps:

MACOS

1.	 Open your Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 Photo RAW 2021 folder.

4.	 Double-click on the ON1 Photo RAW 2021 
application icon.

You can add ON1 Photo RAW 2021 to your dock for easy 
access by clicking and holding the icon in the dock and 
selecting the Keep In Dock option. If you use Launchpad it 
can be found there as well.

WINDOWS 7

1.	 Go to your Start Menu.

2.	 Select the ON1 group.

3.	 Select ON1 Photo RAW 2021.

If you selected the “Add Icon to Desktop” option during installation you can also access ON1 Photo RAW 
2021 from there.

When you first launch ON1 Photo RAW, sign in with your ON1 
User ID (which you set up when you purchased the software) 
If you downloaded the app to try out, you can see how many 
days are left in your free trial.
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WINDOWS 8.1 AND WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 Photo RAW 2021.

If you selected the “Add Icon to Desktop” option during installation you can also access ON1 Photo RAW 
2021 from there.

To launch ON1 Photo RAW 2021 from an external application, such as Adobe Photoshop or Lightroom, see 
the sections below for complete instructions.

Licensing and Registration
When you first launch ON1 Photo RAW 2021, the upper left side of the main window will have two 
buttons, Buy Now and Sign-In. 

IF YOU HAVE PURCHASED ON1 PHOTO RAW 2021:

Click on the “Sign-in” button and fill in your ON1 account information (email and password) to register the 
app with us. (You should have set up an account when you purchased the software.) If the computer you 
are signing in with does not have access to the internet, you can manually register your software by clicking 
on the “No Internet connection” link in the license dialog.

Your license lets you install Photo RAW on two computers. When you enter your ON1 account info, Photo 
RAW communicates with the ON1 activation server and registers your software for that computer.

If you wish to move your copy of Photo RAW from one registered computer to a new one, and you are not 
going to be using the older machine, it is best to sign out of the old computer first. Open Photo RAW and 
select Sign Out from the Help menu. This will deactivate Photo RAW 2021 on the current machine, and you 
can install and sign in on another machine.

You can log into your ON1 user account area (https://www.on1.com/login/) at any time to download the 
software, see the number of computers you have registered, and make basic changes to your account 
information, including your email address, password, and notifications.

If you have issues related to installing or activating Photo RAW, please contact ON1 customer support, 
which can be reached by clicking on the ON1 website’s Support tab (https://on1help.zendesk.com).

TRIAL VERSION

ON1 Photo RAW 2021 can also operate as a fully featured trial version for 14 days from when you first 
launch it. This gives you time to evaluate the product and see if it fits your needs. Each time you launch 
Photo RAW during the trial period, the Buy Now button will tell you how many days remain in the trial.

You can purchase ON1 Photo RAW 2021 at any time by clicking on the Buy Now button. Once you do that, 
click the Sign-In button the next time you launch the product and enter your ON1 account information. If 
your trial period has ended, Photo RAW will present you with an activation window when you launch the 
app. There, you can enter your ON1 account info to activate the app.

https://on1.com/login/
https://on1help.zendesk.com
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PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Photo 
RAW 2021. You can change your participation later, just click the Help menu, then Help Improve ON1 
Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 Photo RAW 2021
To uninstall ON1 Photo RAW 2021, first deactivate your product: open ON1 Photo RAW 2021 and select 
Sign Out… from the Help menu. (This will allow you to transfer your license to another computer.)

MACOS

Go to the Applications/ON1 Photo RAW 2021/Documentation folder, and double-click on the Remove 
ON1 Photo RAW 2021 application.

WINDOWS

Go to Control Panels, and under Programs select Uninstall a program. In the list that comes up select ON1 
Photo RAW 2021 and then click on the Uninstall button.

Working with Files
ON1 Photo RAW 2021 can view and open the following file types, in RGB color mode, at either 8 or 16 bits 
per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)
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• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC)

•	 ON1 Photo format (ONPHOTO) 

Photo RAW can export files in PSD, PSB, TIFF, JPEG, and PNG format.

NOTE: ON1 Photo RAW 2021 can also view and catalog most standard video 
formats inside the Browse module. While you cannot play or edit video from 
within Photo RAW, you can perform file management tasks and edit metadata. 
Double-clicking on a video file in Photo RAW will launch the default video 
player for your computer.

FILE ACCESS WHEN USING ON1 PHOTO RAW 2021 
AS A STANDALONE APPLICATION

When used as a standalone application, ON1 Photo RAW 2021 uses your camera manufacturer’s raw 
format as the default format when editing your photos. ON1 Photo RAW 2021’s non-destructive editing 
capabilities let you view your raw files—or any other supported file type from the list above—in Browse, 
and work on them in the Edit module without having to create any intermediary files. There are no multiple 
versions of images cluttering up your directory; ON1 Photo RAW 2021 remembers the edits you’ve made 
to your photos and applies them non-destructively to your original.

This means is that there is no need to “open” the files to edit them; you just work with them as desired, 
and ON1 Photo RAW 2021 will remember your edits as you travel across the modules, even when you are 
working with a layered photo. You’ll only need to save them in a different form when you wish to export or 
share them in non-raw formats, or when you wish to work with the Resize module.

FILE ACCESS WHEN USING PHOTO RAW 2021 AS A PLUGIN

If you use ON1 Photo RAW 2021 as a plugin from another image editing app (Lightroom, for example), we 
recommend using the Photoshop format (.PSD) as the exchange file format for maximum compatibility. If 
your saved file will be larger than 2GB, or more than 30,000 pixels on a side, your image will automatically 
be saved in the .PSB (or Large Document) format. This is a newer version of the PSD format designed for 
larger file sizes, and is fully compatible with Photo RAW.

When working with Photo RAW as a plugin to Photoshop, Lightroom Classic, and Apple Photos, there are 
certain conditions in which you can preserve re-editability from within the host app. See “Using ON1 Photo 
RAW 2021 with Adobe Photoshop” on page 11, “Using Photo RAW with Lightroom Classic CC” on page 
13, and “Using Photo RAW with Apple Photos” on page 23 for specifics on how to use these options.
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ON1 Photo RAW 2021 Modules
ON1 Photo RAW 2021 has three modules: Browse, Edit, and Resize. Each module focuses on one task, 
giving you access to just what you need to get that task done. Browse handles file-management operations, 
Edit performs non-destructive pixel editing—in a layered workflow, if you choose—and Resize is used to 
enlarge images, largely for printing to large-format printers.

When used as a standalone application, Browse is the default module. It is used to navigate 
through your drives and cloud services to find images, as well as to import photos and perform 
specialized image-combination tasks (like creation of HDR images). In this mode, when you take 
an image from Browse to the Edit module, Photo RAW 2021 works in a non-destructive manner, 
preserving your edits as you work. 

NOTE: Opening an image in Resize is destructive. Because the end result is 
a new, scaled file, usually intended for printing, Resize creates a copy of the 
image (generally saved in the .PSD format) and saves that to the same directory 
as your original image.

Within the Edit module are four tabs, Develop, Effects, Local Adjustments, and Portrait AI. 
Each tab has a specific area of functionality: Develop for basic editing, Effects for stylization, 
Local Adjustments for targeted editing of specific areas in your images, and Portrait for portrait 
retouching.

THE MODULE SELECTOR

The Module Selector is on the right side of the screen, visible at all times. At the top of the 
selector are icons for Browse and Edit. Clicking on one of those icons will take you to that 
module.

When you are working in Browse, the selector will also have four icons in the center that 
are intended for use when combining photos: Layers, Pano, HDR and Focus. (For more, see 
“Combining Photos with Photo RAW” on page 167.)

At the bottom of the selector is the Resize icon, and icons for printing, sharing or exporting an 
image or group. (See “Sharing” on page 212.)

Depending upon which module you are working in, and where you started—in standalone mode, 
or when you’re using ON1 Photo RAW 2021 as a plugin—some or all of the modules might be 
disabled, depending upon the following conditions:

• If you use Photo RAW as a standalone application, you can click on any module to go to that 
module.

• If you access Photo RAW as a plugin from within Photoshop, Photoshop Elements, Affinity 
Photo, PaintShop Pro or Apple Photos, only the Edit module is available; the other modules 
will be disabled. You can move freely between the different tabs in Edit when in this mode, 
can create layers. You can also print, share or export the current image from within Photo 
RAW. 
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• If you access Photo RAW from within Lightroom Classic CC, you will only be able to use the 
module chosen from within Lightroom: either the Edit module (including the Develop, Effects, 
Portrait, and Local Adjustments tabs), or Resize. You can, however, go from the Edit module  
to Resize, but not back, and still have the option to print, export or share the current image.

NOTE: Browse and the ON1 Cloud Sync service is only accessible when using 
Photo RAW as a standalone app. Cloud Sync is only available when using Photo 
RAW as a subscription product. See “Basic Cloud Sync Workflow within ON1 
Photo RAW” on page 74 for specifics. 

Using ON1 Photo RAW 2021 as a Raw Editor
ON1 Photo RAW 2021 is most powerful when used as a standalone application, independent of Photoshop, 
Lightroom or another editing application. Using it in this manner gives you access to all the modules and a 
complete raw-based workflow with non-destructive editing capabilities. In addition, if you wish to use ON1 
Cloud Sync, you must use Photo RAW in standalone mode. (See “Using ON1 Cloud Sync with Photo RAW” 
on page 71.)

ON1 PHOTO RAW 2021 WORKFLOW

When used as a standalone photo editor, ON1 Photo RAW 2021 offers true non-destructive raw editing 
capabilities. This means you can view your images in the Browse module, open a raw file in any part of the 
Edit module and apply edits—including cropping, healing and local adjustments—and Photo RAW will always 
be working with your original file. At any point, you can go back to Develop, Effects, Local Adjustments 
or Portrait and change any or all settings you have made. What’s more, when you’re working with layers, 
Photo RAW will save your work in a non-destructive format as well, using a Photo RAW-specific ‘onphoto’ 
file format. This format retains all layer and editing information, and, when you wish to export a composited 
image for sharing or other uses, you can easily export it in any format supported by Photo RAW.

When used in conjunction with ON1 Cloud Sync, you can sync your most important folders and albums 
and extras to the cloud with Photo RAW and access them from multiple computers, with full editing 
capabilities. And, with the ON1 Photo Mobile app, you can sync all of your photos from all of your devices, 
creating a complete editing and sharing workflow.

THE EDITING PIPELINE IN ON1 PHOTO RAW 2021

There are many editing operations you can make to a raw file (or other supported file format) with ON1 
Photo RAW 2021, from broad global adjustments for exposure and color, to the application of effects, to 
cropping and retouching, the addition of local adjustments to sections of a photo. Because there has to be 
some structure of how edits are applied to a raw file, it might be helpful to understand the order in which 
edits are applied to a raw file. Whenever you view an edited image without additional layers, this is the 
order in which ON1 Photo RAW 2021 applies edits:

1.	 The base image is always at the bottom of the stack. This is your original, and you can always 
get back to that file.
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2.	 Since retouching—operations like removing dust spots, editing blemishes or skin 
imperfections—is often the first thing many photographers do to their images, Photo RAW 
applies these operations first. This way, all subsequent edits will incorporate these changes.

3.	 Next are settings applied in the Develop tab. This includes the application of color profiles, 
global exposure, color correction, sharpening and noise reduction, but any adjustments 
made in the Transform pane.

4.	 Local adjustments made to an image are applied next.

5.	 Any Transform operations are applied after local adjustments. 

6.	 Edits made in the Portrait tab are applied next.

7.	 Any filters applied in the Effects tab are applied last.

8.	 Text layers sit above the image stack. 

9.	 Finally, any cropping or rotation information made to an image is applied to the file.

When working with multiple layers, steps 1 through 7 are applied for each layer, with the bottom layer at the 
bottom of the ‘stack’, and the topmost layer at the top. After all the layers’ edits have been applied, Photo 
RAW adds any text, followed by cropping and rotation information, to complete the document pipeline.

You do not have to edit your photos in this order; this is just the way in which Photo RAW 2021 applies the 
edits you make to an image. You might find a dust spot, for example, only after changing exposure settings 
in Develop or applying a filter in Effects. You can then use the Perfect Eraser to remove the spot and 
continue with your editing, and Photo RAW 2021 will apply it at the proper place in the stack.

NOTE: While editors like ON1 Photo RAW and Lightroom can open and edit 
raw files, they are not compatible with one another. Any edits made to a raw 
file in one program will not be visible in the other. For best practices, you 
should generally choose one program to be your organizational/editing tool. 
If you would like to switch your primary editing tool from Lightroom to Photo 
RAW, see “Moving Your Lightroom Catalog to Photo RAW” on page 18.
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Using ON1 Photo RAW 2021 with Adobe Photoshop
When you edit an image sent from Photoshop to ON1 Photo RAW 2021’s Edit module, you are editing 
Photoshop’s currently selected layer. By default, Photo RAW makes a copy of the layer, so your original 
layer is saved, unless it is a Smart Object (see below). If you’d like to change this preference, see the Plug-
Ins section of the Preferences window on page 233.

NOTE: If you wish to resize an image using Photo RAW 2021’s Resize module 
from within Photoshop, the entire image is sent.

ON1 Photo RAW 2021 is accessible from within Photoshop in two ways, from the File > Automate menu, 
and from the Filter > ON1 menu. From the Automate menu, you can access the Develop, Effects, and 
Portrait tabs of the Edit module, as well as the Resize module; from the Filter menu, you can access the 
Develop, Effects and Portrait tabs (Browse is not accessible from within Photoshop.)

There are two options for editing an image in ON1 Photo RAW 2021. Which method you choose depends 
upon whether you wish to be able to re-edit your image in Photo RAW.

EDITING A PHOTO FROM PHOTOSHOP WITHOUT PRESERVING 
CHANGES MADE IN PHOTO RAW

To use Photo RAW inside Photoshop, when you do not wish so be able to re-edit your operations:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then the Edit module tab you would like to start in.

4.	 When you’re finished editing your photo, click the Done button in ON1 Photo RAW 2021. 

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE CHANGES 
MADE IN PHOTO RAW

To be able to re-edit your Photoshop images at a later point inside 
Photo RAW, you will use Photoshop’s Smart Object technology:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart 
Object.

4.	 From the Filter menu, select ON1 and then the tab that 
you would like to use.

5.	 When you’re finished editing your photo, click the Done 
button in Photo RAW 2021.

Right-clicking on a layer in Photoshop’s Layers 
panel gives you the option to turn the layer into a 
Smart Object..
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To re-edit your Smart Object layer again inside ON1 Photo RAW 2021, double-click on the ON1 module 
name in the edited Smart Object layer in Photoshop. Photo RAW will then launch that module, and let you 
change your previous settings or make new ones.

NOTE: Smart Object re-editibility is not possible when you add 
a layer to your photo in Photo RAW (in addition to the original, 
base layer). When you save your work, Photo RAW will flatten 
the image before it sends it back to Photoshop.

Using Photo RAW with Adobe Photoshop Elements
When you edit an image sent from Photoshop Elements to ON1 Photo RAW 2021’s Edit module, you 
are editing Photoshop Elements’ currently selected layer. By default, Photo RAW makes a copy of the 
layer, so your original layer is saved. If you’d like to change this preference, see the Plug-Ins section of the 
Preferences window (page 233).

ON1 Photo RAW 2021 is accessible from within Photoshop Elements in two ways, from the File > 
Automation Tools menu, or from the Filter > ON1 menu. From the Automate menu, you can access the 
Develop, Effects, and Portrait tabs of the Edit module, as well as the Resize module; from the Filter menu, 
you can access the Develop, Effects and Portrait tabs (Browse is not accessible from within Photoshop 
Elements.)

EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use Photo RAW inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then the Edit module tab you would like to start in.

4.	 When you’re finished editing your photo, click the Done button in ON1 Photo RAW 2021.

NOTE: Photoshop Elements does not support Smart Objects, so all edits done 
inside ON1 Photo RAW 2021 are final, once you return to Elements.

To re-edit a Photoshop layer in Photo RAW, 
double-click the module name in the Smart 
Filters section of the Layers palette.
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Using Photo RAW with Lightroom Classic CC
ON1 Photo RAW 2021 can be accessed as a plugin from within Adobe Lightroom Classic CC, providing 
an integrated, round-trip editing workflow for your images. With the exception of the Browse module, all 
modules and features inside Photo RAW are available when acting as a plugin.

There are two primary ways to use Photo RAW with Lightroom, via the Edit In command in the Photo menu 
and Plug-In Extras command in the File menu. Using the Photo > Edit In menu gives you quick access to 
the Edit module and Resize, while File > Plug-In Extras gives you additional, and more powerful, options for 
editing inside Photo RAW, including: 

• Re-editability via ON1’s proprietary Smart Photos format (see page 18), which saves all the 
edits made in Photo RAW, so that you can re-edit them at a later time.

• Batch processing of multiple images for editing in Photo RAW (see page 16).

• The capability to export multiple photos as layers to Photo RAW, so that they can be worked 
on for compositing or other purposes (see page 17).

NOTE: Lightroom is a raw editor similar to ON1 Photo RAW 2021; while both 
programs can open and edit raw files, their raw processing engines are not 
compatible with one another. Any edits made to a raw file in one program will 
not be visible in the other. For best practices, you should generally choose one 
program to be your organizational and raw editing tool. If you are a Lightroom 
Classic user and are thinking about switching to Photo RAW as your primary 
raw editor, see “Moving Your Lightroom Catalog to Photo RAW” on page 
18 for detailed information on the process, including the different options 
available and which editing parameters are preserved during conversion.

USING ‘EDIT IN’

If you wish to make quick edits on a single image 
in Photo RAW, and don’t need to preserve your 
edits or work with multiple photos, use the 
Edit In submenu from Lightroom’s Photo menu, 
This is the easiest way to send a photo from 
Lightroom to Photo RAW. With this option, you 
are using Lightroom’s plugin export system to 
control the characteristics of the edited file.

To use this method, select your image in Lightroom, go to the Photo menu and select the Edit In submenu 
and choose the module you wish to work in (Develop, Effects, Portrait AI, or Resize). If you choose any of 
the Edit module tabs from the menu, you’ll be able to move between the other tabs—including the Local 
tab—during your editing session inside Photo RAW. You can even switch from the Edit module to Resize 
and finish the image from within that module (although you cannot travel from Resize to the Edit module in 
any scenario).

For quick editing of photos from Lightroom, you can choose Edit in from 
Lightroom’s Photo menu.
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File creation characteristics when using Edit In

When you use the Photo > Edit In submenu, Lightroom will ask you each time how you wish to edit the 
selected image. You have three editing options: 

• Edit a Copy with Lightroom Adjustments, 
which makes a copy of the file that includes 
any edits you have made in the photo;

• Edit a Copy, which copies the original photo 
without any changes made in Lightroom; or

• Edit Original, which sends the original 
version of the photo to Photo RAW, unless 
the photo is a raw file, in which case the 
option will be unavailable.

In the Copy File Options, you set the file type (TIFF, 
Photoshop PSD or JPEG), the color space and bit depth 
for the resultant file. PSD is the preferred file type, 
especially if you wish to create layers inside Photo 
RAW while editing the exported image. (The layers, 
along with any associated layer masks, will be saved, 
and can be re-edited by choosing Photo > Edit In and 
Edit Original from the Edit Photo window.)

When you have set your options and click the Edit button, Lightroom will create a new file (or send the 
original) and launch Photo RAW. There, you can make your edits in any of the Edit module tabs—or inside 
Resize, if you chose that module from the Edit In submenu. When you’re finished, click the Done button 
to save your changes, close Photo RAW, and return the file to Lightroom. To return to Lightroom without 
saving your edits, click Cancel. 

NOTE: While you cannot create a Smart Photo PSD via Edit In, you can open 
an existing Smart Photo with Edit In. Select the Smart Photo, choose Edit In 
and the Edit module tab you wish to start in (Develop, Effects, or Portrait AI), 
and choose Edit Original in the window. Photo RAW will open the image in the 
chosen tab, with your previous edits intact. Any subsequent edits you make 
will be saved with the Smart Photo when you return to Lightroom. (Information 
about the Smart Photo format starts on page 18.)

USING ‘PLUG-IN EXTRAS’

Accessing ON1 Photo RAW 2021 from Lightroom’s File > Plug-in Extras menu is the preferred way to 
access the app. It gives you access to all Photo RAW modules (except Browse) and has the most flexibility 
in how the files are handled. To edit an image (or group of images, if you want) in Photo RAW, make your 
selection in Lightroom, go the File menu’s Plug-In Extras submenu, and choose an option. What happens 
depends upon your selection:
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• If you choose Effects, Develop, or Portrait AI, Photo RAW will open in that tab within the 
Edit module, and you can move between the other tabs during your editing session. If you use 
the PSD file format as your conduit 
between Lightroom and Photo RAW, 
you can also create layers, which will 
be saved when you return to 
Lightroom. You can also move to 
Resize from the Edit module during 
your session, but when you return to 
Lightroom, the image will be saved as 
a flattened, resized Photoshop file.

• If you select multiple photos inside 
Lightroom and choose any of the Edit 
module options, you will be presented with batch options in the Edit Photo window (see 
“Batch processing options with Plug-In Extras” on page 16).

• If you choose Resize, you can only work in that module. 

• Choosing multiple files and selecting “Open as Layers” will create a layered document inside 
Photo RAW’s Edit module (see page 17 for details). 

NOTE: The Migrate Catalog to ON1 Photo item at the top of the Plug-In Extras 
submenu is designed to help you transition from Lightroom to Photo RAW as 
your standalone raw processing app. For detailed information on this process, 
see ““Moving Your Lightroom Catalog to Photo RAW” on page 18.

File creation characteristics when using Plug-In Extras

When you access ON1 Photo RAW 2021 through Lightroom’s Plug-In Extras menu, the default file-handling 
options are driven by the settings in the Plug-ins tab of Photo RAW’s Preferences window. These options 
can be configured in advance, based on your 
workflow, and can be changed as desired. The 
file export options include the following settings:

• File Type: This determines what type 
of file will be created. The default is 
PSD, which maintains layers, but does 
not support re-editability. You can also 
select Smart Photo PSD, JPG or TIFF, 
if you prefer those formats. One other 
option, Same as Source, will edit the 
original file; if that file is in the Raw 
format, it will be sent as a PSD file.

• Color Space: The color space menu 
determines which RGB working color 
space is used; Adobe RGB 1998, sRGB 
or ProPhoto RGB.

The Plug-In Extras submenu is found in Lightroom Classic’s File menu. 

When sending a file from Lightroom to Photo RAW via Lightroom‘s Plug-In 
Extras menu, the edited file will be created according to your settings in the 
Lightroom section of Plug-ins tab in Photo RAW’s Preferences window 
(highlighted in gray, above). 
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• Bit Depth: Sets the exported file’s bit depth to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of the newly created file.

• Stack with Original: When enabled, the new image is stacked with the original image upon 
return to Lightroom from Photo RAW.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the 
original file will be edited, rather than having a copy made.

• Ask Every Time: When checked, 
Lightroom will present these export 
copy options whenever you chose an 
item from the Plug-In Extras submenu. 
Turning this option off will bypass the 
file-export window inside Lightroom, 
using the options set in Plug-In 
Preferences window. 

If you have the Ask Every Time option checked, 
you’ll be presented with the Export window (shown 
on the right) inside Lightroom whenever you send 
an image to Photo RAW—or when you use the 
Open as Layers option with multiple images. The 
Export Options window lets you adjust the file 
format characteristics as needed, and is designed 
for users with variable workflow needs. If you find 
that you use the same options every time, then 
you can set those parameters in Photo RAW’s 
Preferences window by unchecking the Ask Every 
Time option.

Batch processing options with Plug-In Extras 

You can process multiple images for editing in Photo RAW modules via Plug-In Extras. Select the images 
you wish to work with in Lightroom’s Library module and chose a starting place via the Plug-In Extras 
submenu: Develop, Effects, Portrait AI or Resize. Then, the Export Options window will open with two or 
three batch options, depending upon the Photo RAW destination chosen from the Plug-In Extras submenu:

• Pause on First Photo: Use this option when you 
wish to apply the exact same editing operations to 
a group of photos. This option will open the first 
selected image inside Photo RAW. There, you can 
perform almost any editing option inside the Edit 
module (or Resize), including presets, retouching 
operations, text additions, cropping, masks, local 
adjustments and more. When you have finished with 
your edits, click Done. Photo RAW will then apply all 
of the edits to each image in the group, and return 
you to Lightroom.

• Pause on All Photos: This option lets you 
sequentially edit the images in the batch. Photo 

If you have the Ask Every Time option turned on in Photo RAW’s Plug-Ins 
Preferences window, whenever you send an image from Lightroom to 
Photo RAW, the Export Options window will come up, letting you adjust 
the export characteristics for that image.

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Photo RAW for 
editing. (If you have the Ask Every Time option set in 
Photo RAW’s Preferences, Batch Options will be 
displayed as a section in the Export Options window, and 
you will be able to set the file copy options for the photos 
in the batch.)
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RAW will open each image in the destination tab, where you can edit it as desired. When 
you are finished editing with one photo, click Done, and Photo RAW will save that photo and 
open the next one, with the previous photo’s Edit module settings applied. (You can reset 
any or all of those settings as desired.) When you have finished editing the last photo in the 
group, clicking Done will save the image, close Photo RAW and return you to Lightroom.

• Use AI Auto for all Found Faces: This option is only available when Portrait AI is chosen 
as the destination from the Plug-In Extras submenu. Clicking OK will launch Portrait AI, 
automatically find all the faces in each photo and retouch each one according to the default 
setting—Subtle or Strong—set in Photo RAW’s General Preferences. No other editing is done, 
and the batched photos are displayed inside Lightroom when the process is complete.

NOTE: When using the Pause on First Photo batch processing option, most 
Edit module tools and operations are supported and carried through to the 
subsequent images in the batch. The only things that are not replicated are any 
layer operations, and any adjustments made with the Transform tool. If you 
apply edits made with these options, they will only be applied to the first image 
in the group.

Using Plug-In Extras to combine multiple photos as layers in Photo RAW

The other primary editing option you have with Plug-In 
Extras is to send a group of images to Photo RAW as a 
single file, with each photo on a separate layer. There, 
you can perform compositing and any other operations 
you can do with Photo RAW’s Layers function. 

Select a group of images in Lightroom, and choose Open 
as Layers from Plug-In Extras. Photo RAW will open them 
as a layered file inside the Edit module. 

The Open as Layers option uses the file characteristics 
set up in the Preferences’ Plug-ins tab as the final output format, with the following conditions: 

• If you chose the Smart Photo PSD format, your layers and layer masks will remain embedded 
in the file, and any adjustments made in the Edit module on each layer will be retained when 
you save the file and return to Lightroom. (See page 18 for information on working with—
and re-editing—Smart Photos.)

• With the standard Photoshop PSD format, your layers and layer masks will remain embedded 
in the file, but any adjustments made in the Edit module on each layer will be lost when you 
save the file and return to Lightroom. You will still be able to edit the individual layers and 
layer masks inside Photo RAW or Photoshop, however. 

• When using TIFF or JPEG as your copy format, when you are finished editing in Photo RAW 
and click Done, all of the layers, layer masks and any Edit module operations will be merged 
into a single composite layer.

For detailed information about Photo RAW’s Layers feature, “Working with Layers” on page 168. 

When selecting a group of images in Lightroom to open as a 
single, layered file, the copy options are determined by the 
settings in Photo RAW’s Preferences. If you have Ask Every Time 
set, you can select the finished image file type from Lightroom.



ON1 Photo RAW 2021 User Guide	 Part 1: Overview	 18

WORKING WITH SMART PHOTOS

ON1’s Smart Photo technology is a variation of the Photoshop file format that has been engineered to 
preserve all editing and retouching operations made within Photo RAW’s Edit module: Develop settings, 
Effects filter operations, masks, local adjustments, portrait retouching, layers, text additions, and so 
forth. Smart Photos can only be created via the Plug-In Extras export method as discussed on page 14, 
although you can re-edit them via either the Plug-In Extras or the Edit In menu options in Lightroom.

When you choose Smart Photo PSD as an option in the Plug-In Extras submenu from within Lightroom, 
Photo RAW creates a standard Photoshop file with “Smart Photo” at the end of the original file’s name. As 
you work in Photo RAW’s Edit module tabs, all of your editing operations are saved in a ‘sidecar’ file that 
sits alongside the PSD on disk inside the same folder as your original image. When you are done editing and 
return to Lightroom, your edited photo will look as it did in Photo RAW, but is completely re-editable.

To re-edit a Smart Photo from within Lightroom, select the image, and choose the appropriate Edit module  
tab from either the Plug-In Extras from the File menu or Edit In from the Photo menu. Depending upon 
the method chosen and your Photo RAW Preferences, the Smart Photo will open automatically, or you will 
need to select Edit Original from the Lightroom export window. �   

There are a few things to know about with regards to Smart Photos and re-editability:

• Smart Photos have been specifically designed to work as a conduit between Lightroom and 
Photo RAW to preserve re-editability. If you use Photo RAW as a standalone app, you can 
open and view a Smart Photo from within Browse, and can re-edit the photo in the Edit 
module, and, as long as your sidecar file is present, all of your edits will be present. However, 
when you return to Browse, Photo RAW will create a new .onphoto file with all your edits.

• If you open a Smart Photo in Adobe Photoshop, the layers will be merged into a single, 
composite layer. If you make any edits to the photo and save it, re-editability in Photo RAW 
will no longer be available.

• Smart Photos are not available as an option when exporting from Lightroom to ON1 Resize.

Moving Your Lightroom Catalog to Photo RAW
If you are a Lightroom user and you wish to make Photo RAW your primary editing application, you can use 
our Lightroom Migration Assistant to transfer most of your catalog settings and metadata from Lightroom 
into Photo RAW. You can even—with a few caveats—transfer photos that have been edited in Lightroom so 
that they appear inside ON1 Photo with corresponding (non-destructive) edits applied to them. And, it does 
this without changing any of the original files in your Lightroom catalog, or the catalog itself. Instead, we 
use machine learning to migrate the actual Lightroom edits in a re-editable, non-destructive way. 

NOTE: This tool is designed for one-time migration of catalogs. As such, the 
migration process can take a long time. You can continue to use Lightroom and 
ON1 Photo RAW 2021 during the migration period. The migration process can 
also temporarily use a large amount of disk space on the drive (or drives) where 
you store your images. Make sure you have plenty of space before you begin.
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This tool performs the following tasks:

• Top-level folders in Lightroom’s Folders pane become cataloged folders in Photo RAW. All the 
photos and videos in those folders will be cataloged automatically.

• Metadata changes made in Lightroom will be migrated, and include ratings, flags, keywords, 
descriptions, GPS data, color labels, orientation, and so forth.

• Standard Lightroom collections will be migrated as well. (Smart collections are not converted.)

• Most raw processing and editing settings made inside Lightroom’s Develop module are 
migrated non-destructively—and are editable—inside Photo RAW. These operations include 
crop, retouching, local adjustments, vignettes, noise reduction and sharpening, and more. 
(See “Which Lightroom Settings are migrated?” on page 21 for exact details of which 
settings are transferred and which ones are not.)

To migrate your catalog, open it inside Lightroom, and choose Migrate Catalog to ON1 Photo from File 
> Plug-In Extras. An assistant window will open up; the first and second tabs of the window have an 
introduction about the process. If you would like to see any additional up-to-date information on the 
Migration Assistant, click the Learn More button, which will take you to a help page on the ON1 website.

Click on the Next button when you’re ready; this will take you to the Settings tab, where you can choose 
whether to have the Assistant transfer your standard Lightroom Collections (Smart Collections are not 
transferable) and any Develop adjustments made in Lightroom. Once you’ve made your selection, click on 
the Next button to go to the Copies tab.

The Intro and Prepare tabs give you information about the Lightroom Migration assistant. Click the 
Learn More button to go to the ON1 website for more detailed information about the process.

The Settings and Copies tab offer multiple options for the conversion operation.
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NOTE: If you migrated your Lightroom catalog, and your photo settings in 
Lightroom are not correct, launch the Migration Assistant again, go to the 
Settings tab and click the Roll Back button at the bottom of the tab. This will 
return your Lightroom settings to the state before you started the Migration 
process. (Click the Cancel button when the roll-back procedure is complete.)

The Copies tab lets you export copies of any photos that have Develop adjustments made to them inside 
Lightroom into a new file that includes all of those edits. These copies are created based on the options 
chosen in the Copies tab, and include the following options:

• File Type: The file type drop-down menu determines what type of file will be created. The 
default is PSD, which maintains layers. You can also select JPG or TIFF, if you prefer those 
formats and are not concerned about maintaining layers.

• Color Space: The color space drop-down menu determines what RGB working color space is 
used; Adobe RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: This drop-down menu sets the copied file’s bit depth to either 8 or 16 bits per 
pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

When the Copies option is checked, any photo that has been edited inside Lightroom will have a new copy 
created and saved in same folder as the original image. Both images will be visible inside ON1 Photo RAW 
2021 after the migration process is complete.

NOTE: Choosing the Create Copies option will create a copy of all photos that 
have any adjustment made to them. This includes such things as automatic lens 
profiling or default noise reduction, which some people use as an import preset 
when bringing photos into Lightroom. We recommend examining your catalog, 
and determine how you wish best to proceed with the migration. In some cases, 
it might be better to use Lightroom’s export dialog to selectively export edited 
photos into a new folder, and add them to ON1 Photo RAW as a new cataloged 
folder—or however you might wish to organize them inside Photo RAW.

Once you have set your options in the Assistant window, click the Migrate button. Once initiated, the 
following steps happen:

1.	 Using the Photo RAW plugin, small JPEG versions of all images in the catalog—used for 
comparison purposes during the migration—are 
exported to a temporary location, as are separate 
sidecar files that contain metadata (.on1) and edit 
information (.on1meta) for each image. 

2.	 If you checked the Copies option, those images are 
also exported and saved to the same folder as the original. 

3.	 When the process is complete from within Lightroom, Photo RAW will launch, and the 
Lightroom catalog’s folders will show up as Cataloged Folders inside the Browse module’s 

Once you’ve clicked the Migrate button, Lightroom will 
begin the process of exporting catalog information to ON1 
Photo RAW 2021.
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Folders pane. (The thumbnails for the images will initially be based on the temporary JPEGs 
exported in Step 1 above.)

4.	 In the background, Photo RAW will go through the cataloged folders and, using the 
information stored in the .on1meta files, will perform a conversion process to align edits 
between the Lightroom versions and the new ON1 Photo RAW version.

5.	 When viewing migrated catalog folders inside Browse, any image that has not yet been 
converted will have a small ‘LR’ badge in the lower right corner of the thumbnail. Once Photo 
RAW has finished the conversion on that image, the badge will change to a small ‘+/-’ badge.

6.	 As Photo RAW completes the conversion on each image, the temporary files are deleted, 
and the .on1 sidecar files are updated.

The process, which, as noted, can take quite some time, although you can continue work inside Photo RAW 
once the Lightroom export component has been completed. If you quit Photo RAW and restart it later, the 
app will continue to work in the background until all of the migrated images are translated into ON1 Photo 
RAW edits.

NOTE: Migrating the Lightroom Develop adjustments does not affect either 
the original photos or their settings inside the Lightroom catalog. What ON1 
Photo RAW does is apply a ‘translation’ of the Develop settings of your 
Lightroom edits to Photo RAW’s Develop settings, and saves those edits in 
an ON1-specific sidecar file. When you open a migrated photo inside the Edit 
module, you’ll see ON1’s approximation of the edits you made in Lightroom.

WHICH LIGHTROOM SETTINGS ARE MIGRATED?

Due to the complexities of moving editing settings from one raw development environment to another, 
not every setting in Lightroom is converted when you migrate your catalog. The following table lists key 
Lightroom features, if they’re converted, along with some notes about the specific feature mentioned.

FEATURE CONVERTED? NOTES

Folders Yes All top-level Folders in Lightroom become top-level 
cataloged folders in Photo RAW.

Photos/Videos Yes All photos/videos in the cataloged folders are added. 
This may include some photos that are not cataloged in 
Lightroom. Photo RAW only migrates available photos and 
does not migrate photos from offline volumes. 

Virtual Copies Yes Lightroom Virtual Copies become Versions inside Photo 
RAW.

Stacks No 
Collections Yes All normal collections are migrated to albums. Collection sets 

become album sets. Smart collections are not migrated.
Crop Yes 
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FEATURE CONVERTED? NOTES

Spot Removal Yes Spot Removal is migrated to the Clone Stamp when used in 
Clone mode. When used in Heal mode it is migrated to the 
Perfect Eraser. The results will not be a pixel perfect match 
but will generally remove the same spots with comparable 
results. 

Basics Yes Camera Profiles are matched for Adobe® and Camera 
profiles. Other LUTs or custom profiles are not migrated. 
Clarity is called Structure in Photo RAW. Dehaze is called 
Haze and will look a bit different. 

Black & White Yes 
Tone Curve Yes Parametric curve adjustments are not migrated, but point-

based curves are. 
HSL/Color Yes You will find this in the Color Adjustment filter in Effects.
Split Toning Yes You will find this in the Split Tone filter in Effects.
Detail Yes There are significant differences in the sharpening and noise 

reduction algorithms. We did our best to align them but they 
may require manual adjustments to taste before output. 

Lens Correction Yes We will apply automatic lens correction if we have a 
matching lens profile. Manual distortion settings are not 
migrated. 

Transform No Unfortunately, Lightroom’s Transform function is very 
different and we couldn’t find a practical way to migrate 
these settings. You can achieve similar results using the 
Transform pane in Develop in Photo RAW. 

Effects Yes You will find these in the Vignette and Film Grain filters in 
Effects.

Camera Profiles No Profiles are proprietary to the developer of the raw engine.
Red Eye No You can reduce red-eye automatically in the Portrait module. 
Graduated Filter Yes You will find these as adjustment layers in the Local module 

using the Adjustable Gradient. Range mask, Moiré and 
Defringe are not migrated at this time. 

Radial Filter Yes You will find these as adjustment layers in the Local module 
using the Adjustable Gradient. Range mask, Moiré and 
Defringe are not migrated at this time. 

Adjustment Brush Yes You will find these as adjustment layers in the Local module 
using the Adjustment Brush, including the Auto Mask 
function. Range mask, Moiré and Defringe are not migrated 
at this time. 
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Using Photo RAW with Apple Photos
ON1 Photo RAW 2021 integrates tightly with 
Apple Photos (for MacOS only) and provides a 
seamless experience for enhancing your images. 

If you have Photos on your computer when you 
install ON1 Photo RAW 2021, the appropriate 
plugin will be installed, but you will need to 
manually activate it in order to use it. To do so, 
go to Apple’s System Preferences and click on 
the Extensions icon. In the Extensions pane, 
click on Photos, then check the ON1 Photo RAW 
2021 option. This will let you send images from 
Apple Photos to Photo RAW 2021. (File Sharing 
must also be turned on in System Preferences 
for this to work.)

To edit an image in ON1 Photo RAW 2021 follow these steps:

1.	 Select the image you wish to edit in Photos.

2.	 Click on the Edit button.

3.	 On the right side of the window, at the bottom of 
the editing controls, you’ll see an Extensions pop-
up. Click that button, and choose ON1 Photo RAW 
2021. Your photo will open in Photo RAW’s Edit 
module, and you can switch between all of the tabs 
in the module during your editing session. 

NON-DESTRUCTIVE EDITING WITH APPLE PHOTOS

When you send an image from Apple Photos to Photo RAW, any settings you apply will be saved with 
the image, so that you can send the image back to Photo RAW with your edits intact, as long as you do not 
subsequently edit that image inside Photos. To re-edit an image processed inside Photo RAW, click on the 
image in Photos and follow the same three steps above. When your image is opened inside Photo RAW, 
you will see all of the changes you made in your previous session. 

Once you make any editing changes to your image inside Photos, your Photo RAW edits will be “baked in” 
to the image. You can send the image again to Photo RAW, but your original settings won’t be visible. 

If you wish to keep your original Photo RAW edits, duplicate the image inside Photos (Image > Duplicate), 
which will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the 
other one to preserve your Photo RAW edits.

After installing ON1 Photo RAW 2021 on your Mac, you must turn the Photos 
extension on via Apple’s Extensions System Preference.

In Apple Photos, click the pop-up menu next to the 
Extensions label when editing a photo and you’ll see the 
options for sending your photo to Photo RAW 2021.
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Using Photo RAW with Corel PaintShop Pro
When you edit an image sent from Corel PaintShop Pro (Windows-only) to ON1 Photo RAW, you are 
editing PaintShop Pro’s currently selected layer. To use Portrait inside PaintShop Pro, follow these steps:

1.	 Open the image you want to work on in PaintShop Pro.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select PlugIns > ON1 > ON1 Photo RAW 2021.

4.	 When you’re finished editing your photo, click the Done button in Portrait.

PaintShop Pro does not support nondestructive editing with Photo RAW; if you would like to work on a 
copy, before you send the photo to Portrait, right-click on the layer in PaintShop Pro and choose Duplicate.

Using Photo RAW with Affinity Photo
ON1 Photo RAW can be accessed from within Affinity Photo, providing an integrated, round-trip workflow 
of your images on both MacOS and Windows. To use Photo RAW as a plugin to Affinity Photo, you must 
first activate the plugin from within Affinity Photo.

ACTIVATING PHOTO RAW FOR USE WITH AFFINITY PHOTO 
(WINDOWS)

1.	 To setup Photo RAW as a plugin on Windows, go first to Edit > Preferences and click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
\Program Files\ON1\ON1 Photo RAW 2021\Plug-in Files\ON1 Photo RAW 2021.plugin. 
Click OK.

4.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Photo RAW listed in the Detected Plugins section of 
the Photoshop Plugins preferences.

ACTIVATING PHOTO RAW FOR USE WITH AFFINITY PHOTO (MACOS)

Setting Affinity Photo up for MacOS is nearly identical to the Windows activation. There is only one 
additional step.

1.	 Go first to Preferences, located in the Affinity Photo menu on the top left. Click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click on the Authorize Global button at the bottom of the window. MacOS will present you 
with a dialog box that shows the root folder of your system. Click on the Authorize button in 
this box.
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4.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
Applications/ON1 Photo RAW 2021/Plug-in Files/ON1 Photo RAW 2021.plugin. Click OK.

5.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Photo RAW listed in the Detected Plugins section of 
the Photoshop Plugins preferences.

EDITING A PHOTO IN PHOTO RAW FROM WITHIN AFFINITY PHOTO

When you edit an image sent from Affinity Photo to ON1 Photo RAW, you are editing Affinity Photo’s 
currently selected layer. To use Portrait inside Affinity Photo, follow these steps:

1.	 Open the image you want to work on in Affinity Photo.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select Filters > Plugins >ON1 > ON1 Photo RAW 2021.

4.	 When you’re finished editing your photo, click the Done button in Portrait.

Affinity Photo does not support nondestructive editing with Photo RAW; if you would like to work on a 
copy, before you send the photo to Portrait, right-click on the layer in Affinity Photo and choose Duplicate.
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Extras
ON1 Photo RAW 2021 supports a number of additional file types that can be used in various modules. 
These files are called Extras, and the file types include:

• Presets for use within the Edit module.

• Paper (type and size) presets for use within Resize.

• Backgrounds that can be imported and used with Photo RAW’s Layers feature.

• Borders than can be imported and used in Layers and Effects.

• Textures that can be imported and used in Layers and Effects.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

• Custom brush shapes, which are generally saved as black-and-white TIF files. Photo RAW can 
also import brush shapes saved in the Adobe Brush Preset format (.abr).

• Sun flares, which can be imported and used with Effects’ Sun Flare filter. 

ON1 includes a number of extras in the product when you install Photo RAW, and you can create your own, 
or add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage 
your own extras, creating categories for each type, and deleting extras that you no longer want.

The Extras Manager lets you import presets (for both the Edit module and Resize), textures, backgrounds, 
borders, look-up tables (LUTs), custom brush shapes, and sun flares for use with the different modules in 
ON1 Photo RAW 2021.
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HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu in Browse and Layers, then follow these steps:

1.	 Select the type of extras you wish to import from the list of tabs at the top. You can only 
import extras of one type at a time.

2.	 Click on the Import button in the footer of the left column. A dialog box will open; select the 
files to import. If you want to import an entire folder, open the folder, select the first file, 
then shift-click on the last file. Click Import when your selection is complete.

3.	 Select a category for your extras to live in. This is where you will be able to find it inside 
ON1 Photo RAW 2021. You can select from an existing category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

Organizing presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Photo RAW gives you the opportunity to 
add presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. If you would like to export a single preset, click on the preset from the list on the right side of the 
window and click Export.

What type of images can I import as Extras?

Backgrounds and textures may be any image file that Photo RAW can open, including JPEG, TIFF, raw or 
Photoshop files. Border files must have a large central area that is transparent, so only files that support 
transparency, such as PNG, can be imported as borders. LUTs can be in either .3DL or .CUBE format. For 
custom brushes, Photo RAW can import Photoshop-compatible brushes saved as black-and-white TIF files, 
or files saved in Photoshop’s .abr file format. Sun flare files are usually JPEG files with a black background.

NOTE: If you download an .ONPreset or .ONP file (for use with Develop or 
Effects), you can simply double-click on it to install it. For more information, see 
the Presets section of this guide, starting on page 105.
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USING EXTRAS WITH LAYERS IN THE EDIT MODULE

You can view and add extras to any open document in the Edit module by adding a new layer. Just click 
Layer > Add Layer from the File menu to open up a file browser window on-screen, where you can choose 
installed extras or any file from your computer. For more on this, see “Working with Layers” on page 168. 

USING EXTRAS IN EFFECTS

You can access your imported borders, textures, LUTs and sun flares in Effects, as you would any of the 
default extras installed with Photo RAW. To use them follow these steps:

1.	 Open an image in Effects.

2.	 In the Filter Options pane, add the filter type you wish to work with from the Add Filter 
button (Borders, Textures, LUTs, or Sun Flare).

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 Choose an extra from the imported category.

NOTE: Each filter will have a different method for choosing that filter’s extras. 
More specific information on the different filters can be found in the Effects 
section of this guide: page 141 (Borders), page 148 (LUTs), page 152 
(Textures), and page 151 (Sun Flare). For information on working with custom 
brush shapes, see “Using Custom Brushes to Add Overlays To Photos” on page 
165.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.

NOTE: If you are using Photo RAW as a subscription, the Cloud Sync option 
will sync all of your added extras between your licensed computers. See “Using 
ON1 Cloud Sync with Photo RAW” on page 71 for more about this service.  
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Customizing Photo RAW’s Keyboard Shortcuts
You can customize ON1 Photo RAW 2021’s 
hotkeys via the Keyboard Shortcuts window. 
This window lets you view and change the 
shortcuts for any tool, tool option, module, or 
menu item inside Photo RAW. You can assign 
shortcuts to menu items that don’t yet have 
a shortcut, build multiple sets of shortcuts 
as preset styles, and create a summary of 
your shortcuts that can be viewed in any web 
browser.

To view or change Photo RAW’s hotkeys, choose 
Keyboard Shortcuts from the Edit menu in any 
module. By default, Photo RAW’s shortcuts will 
be displayed, organized hierarchically by the 
following groups: 

• Modules, commands for switching 
between Photo RAW’s different 
modules.

• Develop, for applying tone and 
color adjustments directly from the 
keyboard while you are working in the 
Edit module. (See “Adjusting Tone & 
Color settings via hotkeys” on page 
125 for details on working with this 
feature.) 

• Tools, for the 18 tools available in the 
Edit module.  

• Tool Options, for the brush and 
mask viewing options available in any 
masking tool’s Options Bar.

• Menu, which includes all of Photo 
RAW’s menu items in each module. 

You open each group by clicking on the triangle 
to the left of the group name, or you can use 
the search field at the top of the Keyboard 
Shortcuts window to search for a command in 
any of the groups (right). 

Each command that has an assigned key will 
display that key in the Shortcut column. The 
Shortcut field will be empty for any command that doesn’t have an assigned key, and any field with a 
grayed-out shortcut means that you cannot modify that command’s keys.

The search field at the top of the window lets you quickly find commands 
based on keywords.

The Keyboard Shortcuts window displays a list of modifiable commands and 
operations in five distinct groups.
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NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste), and the Browse 
module shortcut (G). Also, you can’t use the Escape, Return/Enter, or Delete 
keys as a shortcut.

MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be 
modified, but you can create your own set of 
shortcuts by double-clicking on any command 
you wish to add or change. You’ll be asked if you 
want to create a new preset. Clicking Yes will let 
you name the new preset style, and Photo RAW  
will make a duplicate of the Default set.

At this point, you can change any existing 
hotkeys, or add your own to commands that 
don’t have them, by double-clicking in the 
Shortcut field for that command. The field will 
be highlighted, and you can press the key or 
key combination you wish to use. If that key is 
used by another command, a dialog will come 
up, informing you of that, and giving you the 
option of either keeping the existing hotkey/
command combination, or changing it to the new 
command.

When you change a default shortcut to a new key combination—even for commands and options that didn’t 
initially have a shortcut—a Reset arrow will appear to the right of the Shortcut field. Clicking the icon will 
reset the command to its original state, from the Default preset style.

To delete a shortcut, double-click in the Shortcut field and press the Delete key. 

The Summarize button at the top of the Keyboard Shortcuts window will create an HTML table of the 
current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it will open that table 
in your default web browser, where you can view or print the list. 

You can return to the original Photo RAW shortcuts by clicking on the pop-up menu at the top of the 
Keyboard Shortcuts window, and choosing Default from the list of preset styles. That menu can also be 
used to create a new preset or to delete an existing one that you created. The Default preset cannot be 
removed, however.

When you add or change a hotkey the first time, Photo RAW will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Photo RAW’s Default 
set—by using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Photo RAW 
will let you know, and give you the option of keeping (Cancel) or removing (OK) 
the other command/shortcut.
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PART 2: ORGANIZING WITH BROWSE
ON1 Photo RAW 2021’s Browse module is a powerful and incredibly fast photo browser and manager. It 
gives you one place to find, view and manage your images, no matter where they are located.

Browse is an ideal environment for performing quick sorts and edits after a shoot: You can import, then 
view, your photos immediately without having to wait for a long cataloging or preview-creation process. 
You can rate, add keywords and flags, create albums, and even remove photos, all from within Browse.

Browse also has a sophisticated indexing system, designed to let you get access to your favorite folders of 
images quickly; just add a folder to the My Catalogs pane, and it will index your photos in the background, 
giving you increased search capabilities and even faster access to your most important photos. 

When using the ON1 Cloud Sync service (see page 71 for more), you can easily share a cataloged folder 
or album with other computers of yours (a laptop, for example) and any of your mobile devices. 

Browse also lets you apply any editing presets from the Edit module directly to an image or group of 
images. You can copy edits made on one photo and paste them onto another, or even a group of photos.

Some of Browse’s key features:

• Find your photos fast, wherever they are: local or network drives and cloud-based services.

• Manage duplicates or similar photos (and more) quickly with the Smart Organize feature.

• Import your photos from your camera, memory card or other device.

• Add any metadata—from creator to keywords and GPS—quickly to a group of photos, and use 
metadata templates to apply often-used metadata information during the import process.

• Catalog important folders of photos, to get the fastest access to your most important photos 
across multiple sources, while still preserving your folder hierarchies and locations.

• View and cull photos from a shoot in the way that works best for you, in four different views: 
Grid, Filmstrip, Detail and Compare views. Use the Map view to see where you shot your 
photos, or add location information to photos without GPS metadata.

• Dual-display capability that lets you work more efficiently. See Grid view on one display, and 
Detail view on another, or use this mode to present photos on a TV or projector.

• Apply editing presets from the Edit module to a single image or a group of images, or sync 
existing edits from one image to a group.

• Build panoramas and high dynamic range (HDR) images directly from within Browse, and 
blend multiple photos at different focus distances to increase depth-of-field.

• Connect your Nikon or Canon camera and capture photos directly, with full manual camera 
support, using tethered-shooting mode.

• Quickly find photos based on their creation date, or any combination of metadata 
information, including time of day, camera/lens type, file type and more.

• Create albums from a selection of photos, or use advanced searching methods to create 
‘virtual’ albums based on metadata.

• Copy, move, delete and rename files.

• Sort, flag, rate or color code your images.
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ON1 Browse Main Screen Overview
The Browse module has three main sections: the Catalogs/Browse/Presets panel on the left side of the 
screen, the Preview window in the center, and the Photo Info panel on the right side.

The main components of Browse module include:

A.	Shortcuts: This palette contains shortcuts to the Getting Started window, as well as your 
most common photo storage locations. (See “Using Shortcuts” on page 46.)

B.	 ON1 Cloud Sync/Preferences/Help/Panel icons: Accesses the ON1 Cloud Sync status 
window (when available), the ON1 Learning Hub or Photo RAW’s Preferences window. The 
icon at the bottom opens and closes the left panel. (See “Using ON1 Cloud Sync with Photo 
RAW” on page 71 for more on the syncing service.)

C.	 My Catalogs/Browse/Presets Panels: Switch between the cataloged folders panel, local 
drives and cloud sources, and presets by clicking on the tabs.

D.	Cataloged Folders/Local Drives Panes: Shows your cataloged folders (shown) or local disks 
and cloud sources, depending upon which tab has been selected.

E.	 Albums Pane: This pane allows you to create albums or collections of images. Albums can be 
grouped into subfolders for easy organization.

F.	 Dates Pane: Search for photos based on the capture date.

G.	Advanced Search Pane: Search for photos in your library based on any metadata, and save 
your searches to find them later. (Formerly known as the Filters pane.)
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H.	Tethered Shooting Pane: This lets you connect your camera to your computer; you can 
capture images directly from the camera to ON1 Photo RAW.

I.	 Recent Pane: This keeps track of recently opened files and folders.

J.	 View Selector: (Icons from left) Open/close the Browse/Presets panel; toggle Dual Display 
Mode on and off; switch between Grid, Detail, Filmstrip, Compare and Map views.

K.	 Preview: The window where you can view your images in thumbnail or detail view.

L.	 Thumbnail Size/Sort Options: The slider adjusts the thumbnail size, while the Sort By pop-up 
adjusts sort order based on standard selection criteria, such as file name, date captured and 
more. (You can also create your own custom sort order.)

M.	Breadcrumbs: This shows the path of the selected image or folder in the Preview area, 
displaying the number of files and folders you are viewing.

N.	Search Field: Lets you search in the current view for any available metadata based on the 
search string. (Uses the Advanced Search pane.)

O.	Copy to My Catalogs: Clicking this button lets you add the currently selected photos to any 
of your existing cataloged folders.

P.	 Raw Preview Mode: Lets you set how you would like to view photos in Detail mode. Fast 
will use embedded previews from the photos, while Accurate will generate a color-balanced 
preview. 

Q.	Info Pane: This section will give you detailed metadata about your image when available. 
(Also displays Navigator and Histogram panes when in Filmstrip, Detail and Compare modes.)

R.	 Metadata Pane: This pane will show your metadata for the selected image.

S.	 EXIF/IPTC/Location Info: Displays additional detailed information about the selected file.

T.	 Keyword List: All keywords found in your image catalog.

U.	Reset All/Previous/Sync: These buttons let you synchronize the edit settings of one image 
on another (or group). Reset All removes all edit adjustments made in Edit from the selected 
image or group of images. Previous will past the Edit module settings from the last edited 
photo onto the currently selected photo. When you have multiple photos selected, the Sync 
button will be visible; clicking this will synchronize the edits from the photo selected first, 
and onto the other photos in the selection. 

V.	 Module Selector: Use this to switch to other modules inside ON1 Photo RAW 2021.

W.	Panorama/HDR/Focus: When multiple images are selected in Browse, use these buttons 
to create panoramas, high dynamic range (HDR) or focus-stacked images. (See “Combining 
Photos with Photo RAW” on page 167 for information on using these features.)

X.	 Export/Print/Share: Shortcuts for exporting (Resize), printing and sharing selected photos. 
The bottom icon will open and close the Info pane.

WORKFLOW BASICS IN BROWSE

When using ON1 Photo RAW 2021 in standalone mode, you have a great deal of flexibility in how you 
wish to work with your photos. You can browse for existing photos in folders that are connected to your 
computer (including cloud services like Dropbox, Google Drive and Microsoft OneDrive). You can also 
import photos directly from your camera or other device. And, once you’ve found a photo (or photos) you 
wish to work on, moving to the Edit module is a single click away. 
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If you store your photo library in a specific location on an internal or external hard drive (or multiple drives), 
you can have Photo RAW index those folders. This process ‘catalogs’ the photos, reading their metadata 
and building previews, letting you navigate and access your photo library much more quickly than if you 
were to simply look at a random folder of images. Cataloging a folder doesn’t move or change your photos; 
it just makes it easier for you to find and work with them inside Photo RAW.

Getting Started window

The first time you launch Photo RAW as a standalone app, Browse displays a Getting Started window, 
designed to help you get working quickly. This window has three options:

• Edit a Single Photo: clicking this button will give you the MacOS or Windows file-selection 
dialog, where you can navigate to a specific photo. Once you’ve chosen an image, Photo RAW 
will open that photo directly within the Edit module (starting with the Develop tab). You have 
access to all the editing tools, and when you’re done editing, you’ll be asked to save a copy 
of the edited version of your photo. (See “Working in the Edit Module” on page 78 for 
information on editing photos.)

• Browse a Folder: this button will open the file-selection dialog for your computer. There, you 
can navigate to a specific folder of photos. Clicking the Open button in that dialog will display 
that folder’s photos in the Browse Preview area.

• Catalog Your Photos: clicking this button will let you choose a folder to be cataloged by 
Photo RAW. This folder (and any subfolders of photos within it) will be added to the My 
Catalogs pane. (See “Cataloged Folders” on page 44 for info on creating cataloged folders.)

The Getting Started window can be accessed at any time by clicking the ‘+’ button in the Shortcuts section 
on the left side of the Browse window (see “Using Shortcuts” on page 46), or via the Help menu. 

NOTE: If you wish to use the full non-destructive editing capabilities of Photo 
RAW when working on your photos, do not use the Edit a Single Photo option. 
Instead, inside Browse, find the photo you wish to edit, select it, and click on 
the Edit module selector on the right side of the main window. (See “Using 
ON1 Photo RAW 2020 as a Raw Editor” on page 10 for more about non-
destructive editing and why it might be important to your workflow.)

The Getting Started window is designed to help you get working quickly with ON1 Photo RAW 2021.
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Working in the Preview Area
The Preview window is the largest part of the Browse workspace. Here, you can view folders of images 
(including all images synced via ON1 Cloud Sync) in either thumbnail or detail view, based on the folders, 
albums or filters you have chosen via the Browse panel. There are five main views in the Preview window:

• Grid, which displays a grid of thumbnails of your images. This view also displays folders, 
letting you go up and down a folder hierarchy quickly.

• Detail, which you get by double-clicking on a thumbnail. You can view this image in either ‘fit 
to window’ view, or can zoom in to see more detail.

• Filmstrip, which displays a strip of images from a folder or album at the bottom of the screen. 
The currently selected image displays in the preview area above the strip; use the arrow keys 
to move through the folder, or click on an image in the filmstrip to view it in the preview area.

• Compare, which lets you view a group of photos in separate panes inside the preview area. 
You can zoom in on one or all of the selection, and lock the panning so that, as you move 
around one photo, the others move with it. Using Compare, you can quickly find the best 
images in a sequence, whether it be for composition, sharpness, facial expressions or more.

• Map, which can be used to display locations for photos that have GPS-based location data, or 
to search for locations that can then be applied to a photo or group of photos.

You can change the viewing mode between the different views by clicking on the view selector at the 
bottom of the window, or by using the keyboard shortcuts (G, F, C, E, and M respectively). 

ALTERNATIVE VIEW MODES

In all of the preview modes inside Browse, you have three options for viewing the contents of the current 
window:

• Photo RAW’s default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys 
on the keyboard to move from photo to photo. This option is helpful when you wish to view a 
selection of photos as large as possible without any distractions. 

Using Photo RAW to display slideshows

In addition to the options displayed above, you can create 
on-the-fly, full-screen slideshows to display groups of 
photos inside Browse. To use this feature, select a group 
of photos in the preview area, and choose Window > 
Quick Slideshow > Start Slideshow. The slideshow will 
loop until you stop, by pressing the Esc key.
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The Quick Slideshow submenu has options for the amount of time between slides and whether to display a 
fade transitions between slides or have no transition at all. 

FAST PREVIEW MODE

Sometimes, when you get back to your computer after a shoot, you want to be able to go through a large 
number of photos quickly, looking for your best shots. ON1 Photo RAW’s Fast Preview mode lets you do 
just that. Simply choose Fast from the RAW Previews pop-up at the bottom of the Browse window, and 
you can jump from photo to photo quickly with minimal lag between shots.

If you are more concerned about color accuracy than speedy previews, select Accurate from the RAW 
Previews pop-up. ON1 Photo RAW will generate a full-resolution preview of your photo, using the photo’s 
embedded color profile. This will take a few seconds, depending upon the size of the raw file you’re 
working with, but you will get a better sense of the actual color in the photo.

Persistent Thumbnail Cache

When you go through a folder of photos, Browse caches thumbnails and preview images as well as 
extracted metadata. This will make it faster the second time a user browses a folder. It also stores 
user-added or adjusted metadata such as ratings, labels, keywords, captions, rotation and GPS data, 
among others. (You can adjust the size of the cache and change the storage location of the cache in the 
Performance tab in ON1 Photo RAW 2021’s Preferences window.)

FOCUS AND CLIPPING VIEWS

When you’re viewing photos with an eye toward selecting the best images in a group for editing, you 
generally want to look at issues with both exposure and sharpness. To help you with this, Photo RAW 
offers two viewing aids that are available in both the Browse and Edit modules: Clipping and Focus Mask 
overlays. In the Browse module, you can display these overlays in Detail, Filmstrip and Compare modes; in 
the Edit module, the overlays can be displayed in any of the tabs.

Clipping

Clipping occurs when the shadow and highlight 
tones in an image are suddenly cut off to 
completely white or black, rather than fading 
smoothly. (Large expanses of white pixels in a 
photo are often referred as ‘blown’ highlights, and 
can be distracting.) One of the benefits of shooting 
in raw format is that, while many photos will have 
areas of pure white or black when originally viewed 
on-screen, there is still recoverable data in the raw 
image. The Clipping overlay can help determine 
how big a problem you might have with a photo, 
and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press 
the J key; to turn it on permanently, choose View 
> Show Clipping, or press Alt (Windows) or Option 
(Mac) J on your keyboard.

Clipping view displays pure white pixels with a bright red overlay, and pure 
black pixels with a bright blue overlay.
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The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, Photo RAW’s Focus Mask 
overlay can help winnow your shots down to the sharpest 
ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt/Option J. The sharpest areas in your 
image will be represented by a bright green overlay. As you 
move from photo to photo in a folder, you’ll be able to tell 
whether you have an acceptable level of sharpness where 
you need it by the strength of the overlay. The mask will 
continue to be displayed even as you zoom in on a photo.

WORKING IN GRID VIEW

Grid view displays thumbnails of folders and images you have selected using the Folder or Albums panes. 
There are many operations you can perform from inside Grid view, including:

• Use the breadcrumbs to navigate (the ‘<’ button goes up one folder).

• Select your image while in Grid view and open the photo in one of the editing tabs.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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• Adjust thumbnail size using the on-screen slider or use “-/+” keys on your keyboard.

• Check Show Sub-Folder Contents when you want to view the contents of all sub-folders (this 
only works when you are viewing cataloged folders).

Sorting photos in Grid view

When working in Grid view, you can sort the thumbnails 
in a number of different ways by choosing the Sort 
By pop-up at the bottom of the window. The sorting 
options include: date captured or modified; color label; 
file name, type, or size; and rating. 

You can also create a custom sort order by dragging 
thumbnails inside the grid window; click and drag the 
thumbnail so that the outline sits between two images. 

Once you change the order of images this way, the Sort 
pop-up will change to Custom, and Photo RAW will 
remember the sort order for that folder until you change 
it. (Custom sorting also works—and the custom order remembered—when you’re viewing albums.)

At the bottom of the Sort pop-up are settings for sorting the view in ascending or descending order; 
selecting one of the options will rearrange the view accordingly. If you have a custom sort order, choosing 
these options will change the view in the opposite order.

WORKING IN DETAIL VIEW

To reorder a photo in Grid view, drag it between the two photos 
where you want it to be placed.

In Detail view, you can zoom to 100% to check small details and sharpness in a photo, view its histogram, and even apply a preset, all without 
having to leave Browse.
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In Detail view you get a full-screen version of your photo. When you go to Detail view, your images will 
be displayed in Fit mode, showing the entire image. You can click on the image to zoom in to 100%. This is 
useful for judging small details and sharpness. Single-clicking on a image that is magnified will return back 
to Fit mode. You can click and drag a magnified image to look around. Your zoom mode is maintained as you 
move from image to image so you can compare the same spot in several frames.

In the Navigator pane you can reposition the preview and change the magnification amount. (You can also 
view and adjust the rating and flag labels for the current image.)

When working in Detail view, you can move to the next image by using the arrow keys on your keyboard.

WORKING IN FILMSTRIP VIEW

Filmstrip view presents a large version of your current image in the preview area, displaying other photos 
from the current view in a strip of thumbnails at the bottom of the screen. The photos are sorted by the 
current sort order, which can be changed via the Sort pop-up above the strip.

The current image is represented by a blue rectangle in the filmstrip, and you can use the arrow keys to 
move from photo to photo, or you can scroll with your mouse and click on a photo to display it in the 
preview. (You can also rate and flag images inside this view.)

NOTE: Filmstrip view is also available in the Edit module; you can rate and flag 
photos there as well, using the same keyboard shortcuts.

Filmstrip view is similar to Detail view, but displays a strip of photos from the current folder (or album). You can easily move to another photo by using 
the right and left arrow keys, or by scrolling and clicking with your mouse.
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WORKING IN COMPARE VIEW

Compare mode is for those times when you shoot a sequence of photos of the same type of scene—a 
portrait session, a wedding, a landscape series, for example—and wish to narrow that group down to 
find your best ones. With Compare, you can select a group of photos, view them side-by-side to check 
composition, zoom in simultaneously to check focus, and rate your favorites and remove the rejects.

To use Compare mode, you can choose one of two methods:

• Select a group of images you wish to compare in either Grid or Filmstrip view. To select a 
group of contiguous photos (ones next to each other in order), simply click on the first one 
you wish to compare, then hold down the Shift key and click on the last photo. If you want to 
add noncontiguous photos, click on the first photo, then use the Command (Mac) or Control 
(Windows) key and click on each subsequent photo you wish to compare. When you have 
your selected photos, press the C key, or click on the Compare icon in the View Selector at 
the bottom left of the Browse window.

• You can also select photos directly in Compare mode: press the C key or click on the 
Compare icon in the View Selector at the bottom left of the Browse window. In the strip at 
the bottom of the window, you can select the photos in the same manner as the first option, 
by clicking on the first photo in a sequence, and Shift-clicking on the last, or by using the 
Command (Mac) or Control (Windows) key to select noncontiguous photos from a group.

When you enter Compare, you will see your selected photos in a grid in the Preview area, fit to show the 
entire photo. The currently selected photo will have a blue box around it, while the other items in the 
selection will have a light gray box around them. You can switch the primary selection by using the arrow 
keys on your keyboard, or by clicking inside the pane you wish to make primary. 

Compare mode displays selected photos as panes inside the preview area. The photo highlighted with a blue box is the current selection. Clicking in 
that pane will zoom the photo; if the Lock pan/zoom box is checked (above the filmstrip), then all of the compared photos will zoom with it.
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If you click once inside the current selection, the photo will zoom in to show greater detail; if you click and 
hold the mouse button down, you can pan across or down your photo, so you can check for things like 
detail, sharpness or facial expressions. (Clicking a second time inside the pane will reduce the photo to fit all 
of it in the pane.) 

To see the detail across the group of selected photos, click on the Lock pan/zoom dot above the filmstrip. 
Now, when you click on an area inside the primary photo, all of the photos will zoom simultaneously to the 
same location of your click. And, if you click and drag inside the primary photo, all of the selected photos 
will pan along with the primary. To pan one photo—which can be useful if the field of view was different 
than the rest—click on that photo to make it the primary selection, then hold down the Shift key and click 
and drag inside that pane. If you do this and wish to get back to the original zoom position, click on the 
Sync button next to the Lock pan/zoom setting, and it will reset the zoom view to the same place in each 
compared photo.

Use the spacebar if at you want to zoom between fit and 100% on the selected photo in the grid. Toggling 
the spacebar between views does not “lock” and will not sync with other photos even if Lock is turned on.

If you wish to remove a 
photo from the group, 
select it (by clicking on it 
or by pressing the left or 
right arrow keys) and press 
the / (slash) key on your 
keyboard. The photo will be 
removed from the Compare 
window, and the remaining 
photos will resize to best fill 
the available space in the 
window. (You can also add 
additional photos to the 
Compare window by using 
the selection techniques 
mentioned above.)

When using Compare, you can rate or flag a photo, apply a preset and add other metadata. These functions 
will only be applied to the primary selected photo (outlined in blue). There are two exceptions:

• Using the Sync settings button on the far right side of the Browse window, underneath the 
Info pane. Clicking on that will sync all of the Edit settings between the primary selection and 
all of the items being compared.

• Using the Create Album or Add to Album commands from the Albums menu: this adds all of 
the currently selected photos to either the new album (when you check the Add Selected 
Items button) or to the chosen album. This feature can be helpful when you have a group of 
images that you would like to keep for a client or to further segment a series.

WORKING IN MAP VIEW

Photo RAW’s Map view provides a simple mechanism to add GPS information to a photo, by searching 
for a place on a web-based map, or to view the location of a photo that already has location information 
embedded in its metadata. An internet connection is required to add or view map data.

Zooming into a photo, and panning to the common areas of concern, you can easily determine which photo is 
sharp enough for your needs.
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The Map display has three controls: the buttons in the upper left corner of the map, to switch between 
Street and Satellite views; a search area, which lets you look for a place (cities, counties, roads); and the 
controls on the lower left, which let you zoom in or out of the current map view. To move around the 
current view, click and drag inside the window. The filmstrip displays other photos in the current folder. To 
move between photos you can use the arrow keys, or you can use the mouse to select a new photo.

To view the location of any GPS-tagged photo on a map, select the photo and click on the Map view icon at 
the bottom of the main Browse window.

To add GPS data to a photo, select a photo or group of photos and 
click on the Map view icon at the bottom of the screen. There you 
can search for a location via the search bar. Once you have the 
desired area, right-click on the map to add a location for the photo (or 
photos) in that spot. If the position is correct, click inside the pop-up 
box to set the pin. 

If you would like to choose a different point instead, right-click in 
another location. 

Once added, Photo RAW will enter that position in the GPS field of 
the Metadata panel. 

Photo RAW can also look up standard location information — city, 
state, country — from the GPS coordinates in a photo, and populate 
that information in the Location tab of the Metadata pane. To do this, 
click on the photos you wish to update and choose Set Location from 
GPS Coordinates from the Photo menu. (See “Metadata Pane” on 
page 56 for more information.)

Photo RAW’s Map view can display the coordinates of a selected photo, or let you add GPS coordinates by clicking specific places on a map.

Right-clicking on a spot on the map will 
generate this pop-up. To confirm the location, 
click in the box; otherwise, you can right-click 
elsewhere to choose a different location.
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My Catalogs, Browse and Presets Panels
On the left side of the Browse window are three tabs, My Catalogs, Browse and Presets. My Catalogs 
and Browse are designed to let you organize and find your photos quickly and easily, while the Presets 
panel lets you apply Edit module presets to your photos directly in the Browse module. (See “Applying Edit 
Module Presets in Browse” on page 66.) To move between the panels, click on the appropriate tab at the 
top of the panel. You can hide the left panel by clicking on the Show/Hide Panel icons at the bottom left 
and right sides of the panel. (Pressing the Tab key will show and hide both panels simultaneously.)

DIFFERENCES BETWEEN MY CATALOGS AND BROWSE TABS

The My Catalogs and Browse 
panels share a number of the same 
panes used to provide file-related 
tasks: Albums, Dates, Advanced 
Search, and Recent. A fifth pane, 
Tethered Shooting, is used to 
capture images from select Nikon 
or Canon cameras directly to your 
computer via a USB connection. 
When using either panel, these five 
panes remain identical. The Browse 
panel includes a list of all your local 
drives and cloud storage services, while the My Catalogs panel lists all of your cataloged folders and your 
other ON1 Cloud Sync devices.

NOTE: Earlier versions of ON1 Photo RAW combined the Cataloged 
Folders and Local Drives tabs into a single Browse panel. If you prefer that 
arrangement, check the Legacy Browse tab option in the General Preferences 
screen. (See “General Settings” on page 231.)

Navigating Sources

To view the contents of any folder in the Cataloged Folders or Local Drives panes, click on the triangle next 
to the folder name. This will display the photos and subfolders within the selected folder inside the Preview 
area. To view the contents of a subfolder, either click on the subfolder inside the Folders pane, or double-
click on it in the Preview area. (You can use the breadcrumbs bar at the top of the Preview area to navigate 
back to the top of your folder system.)

TIP: Any pane in Photo RAW can be collapsed by clicking in the pane’s title bar; 
a Hide/Show link is visible when you move your cursor over the title bar, but 
the entire title bar is clickable. 

The My Catalogs view (above left) displays your cataloged folders and other ON1 Cloud Sync 
devices you have, while the Browse view (above right) displays attached local drives and any cloud 
services you have installed on your computer.
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CATALOGED FOLDERS

A cataloged folder is a shortcut for your favorite or most-used folders of photos. A folder designated as 
cataloged is cached in the background to improve the speed of loading those folders (and any subfolders) 
and their photos. Cataloged folders are ideal for portfolios, your favorite photos, or for your primary library 
of photos. Cataloged folders are necessary when using the Advanced Search feature to search for photos 
across multiple folders.

You can make any available folder a cataloged folder by clicking on the ‘+’ button at the top of the 
Cataloged Folders pane; by right-clicking on a folder in the Preview area of the Browse panel and choosing 
Make Cataloged Folder from the pop-up menu; or by choosing Add Cataloged Folder from the File menu. 
The cataloging process is designed to work in the background, so it doesn’t affect other work you do in any 
Photo RAW module. (You’ll see a small progress indicator to the right of the folder as this process happens.)  

When you catalog a folder, you will be prompted to choose the size of the previews that are generated 
during the cataloging process, and whether you wish to publish the folder to ON1 Cloud Sync. The three 
thumbnail options are:

• Standard, which extracts the image metadata and EXIF thumbnail and creates a high-quality 
thumbnail and a fit-screen-sized preview.

• Medium, which extracts metadata, EXIF thumbnail and creates a high-quality thumbnail.

• Minimal, which extracts metadata and the EXIF thumbnail only.

For most purposes, you’ll want to choose the default preview size, Standard. If, however, you are working 
with a system that has disk space restrictions, or have a network connection to your cataloged folder, 
choose either Medium or Minimal. (You can change the preview size later by right-clicking on the folder in 
the My Catalogs list and selecting the Preview Size option.)

If you would like to publish the folder to ON1 Cloud Sync, click the box and choose either Editable Preview 
or Originals from the pop-up menu. The Preview files are editable versions of your original photos, but are 
a fraction of the size. Which option you choose will depend upon your intent, and your ON1 Cloud Sync 
storage availability. See page 71 for more detailed information about the sync service.

A cataloged folder that has been published to ON1 Cloud Sync will display the Cloud Sync icon next to the 
folder name. 

To remove a cataloged folder, right-click on the folder in the pane and choose Remove Cataloged Folder. To 
unpublish it from ON1 Cloud Sync, right-click the folder and choose Unpublish from ON1 Cloud Sync.
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Adding photos to existing cataloged folders

You can add photos from any location inside Browse to 
an existing cataloged folder via the Copy to My Catalogs 
option. To use this feature, you must already have at least 
one cataloged folder. Then, when working in Browse, select 
the photo or photos you wish to add, and choose Copy to 
My Catalogs from the File menu, or via the folder icon (with 
a ‘+’ button) to the right of the search bar at the top of the 
Browse window. (You can also right-click on a photo and 
choose Copy to My Catalogs from the pop-up menu.)

Inside the Copy to My Catalogs dialog box, you can choose 
which cataloged folder you wish to copy the photos, can 
add them to a new subfolder, and choose whether to move 
the photos or copy them. If you are copying to a folder that 
has been published with ON1 Cloud Sync, those photos will 
automatically be synced to the cloud.

Moving the files is only available when you are moving the 
photos to a new location on the same drive; otherwise, a 
copy of the file is made in the new location.

LOCAL DRIVES

Browse automatically recognizes any disk (volume) inside or attached to your computer. This includes 
internal and external hard drives, optical drives, thumb drives, digital camera memory cards, digital 
cameras, any devices that support USB Mass Storage, and network-attached services (including mapped 
volumes on Windows).

Disks appear in the Local Drives pane with a hard drive icon next to them. Keep in mind that some disks, 
(like optical drives) are often read-only. You will be able to view a copy of a photo, but will be prompted to 
save the image to a new location if you wish to edit it.

Cloud storage services

Browse supports cloud storage services from Dropbox, Google Drive, and Microsoft OneDrive. These 
services—when installed on your computer and other devices—keep local copies of your images on your 
computer, and Browse finds and monitors these locations automatically. If you edit an image stored in one 
of these locations they are automatically updated to the cloud.

During the installation process, ON1 Photo RAW 2021 automatically looks for the default installation 
locations for these services. If you do not have one of these services installed, or you have it installed to a 
non-standard location you will be asked to install or locate the folder when you click on the source. You can 
hide services you don’t use in the Services tab in Photo RAW’s Preferences (see page 235).

The Copy to My Catalogs dialog box lets you copy or move 
selected photos into your existing cataloged folders.
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USING SHORTCUTS

The Shortcuts selector on the left side of the Browse panel is 
a list of icons designed to give you quick access to the Getting 
Started and Smart Organize windows, as well as six often used 
file locations, and display their contents in Browse’s Preview 
window. From top to bottom, the icons represent the Getting 
Started window, your Desktop, your Pictures folder, cataloged 
folders, local drives, cloud sources, albums, the Smart 
Organize window, and ON1 Cloud Sync devices. Clicking on 
one of the icons will display the shortcut’s contents in the 
Preview window.

By default, the Pictures shortcut uses your My Pictures folder 
(Windows) or Pictures (Mac). You can change the default 
location in the General section of the Preferences window 
(see “General Settings” on page 231).

Shortcuts can be useful when you have the right panel hidden to maximize viewing in the Preview window.

MANAGING FILES AND FOLDERS IN BROWSE

Deleting a folder

To delete a file or folder, click on it and press the Delete key or right-click and select ‘Delete’ from the 
contextual menu. Then, confirm that you wish to move the file to the trash. If you have multiple files and or 
folders selected it will move them all to the trash. If you make a mistake you can use the Undo command, 
although some files, like those on a network volume, are deleted immediately and cannot be undone.

Renaming a file or folder

You can rename a file or folder by selecting it, then choosing ‘Rename File’ from the right-click contextual 
menu. This will display a simple window where you can type in a new name for your image.

If you select multiple files, choosing the Rename Files from the contextual menu will give you additional 
options for the batch creation of new filenames. There are four choices:

• Current filename, which uses the file’s original name as part of the new name.

The Rename dialog lets you create complex filenames for a group of images.



ON1 Photo RAW 2021 User Guide	 Part 2: Organizing with Browse	 47

• Text, which lets you add any static text—a location, shoot name, etc.—to the filename.

• Serial number, which lets you sequence a group of images, starting with a specific number. 
You can use leading zeros to preserve filename sort order, and, you can start with any 
number. 

• Date, will automatically grab the image’s capture date and apply it to your new filename in 
any one of 12 different date formats. 

You can use any of the four fields, in any order and amount you wish; click on the ‘+’ button to add a new 
field, and the ‘-’ button to remove one. As you work on your naming, a sample filename is displayed at the 
top of the window. Once you have your order set, click the Apply button to run the operation.

Creating a new folder

You can create a new folder from the right-click contextual menu in the preview area or selecting Add 
Subfolder in the Edit menu. This will create a new folder inside the selected folder; if you have files selected 
in the preview area, you also will get the option to move or copy the selected images into the new folder.

Copying and moving files and folders

You can copy and move files and folders in the ways you are accustomed to on your computer. You can 
select files and folders and use the Edit > Copy command to copy them to the clipboard and then Edit > 
Paste to paste them to new location, inside or outside of Browse. You can use this to copy a file or folder 
from one place to another or to attach an image to an email for example.

You can also use the familiar drag-and-drop functions to copy or move files and folders. Dragging and 
dropping a file or folder will move it if it is on the same drive or copy it to another drive. You can drag and 
drop in and out of Browse module.

NOTE: Due to the non-destructive nature of Photo RAW 2021’s workflow, 
copying a photo and pasting it outside of Photo RAW will paste the original file. 
If you wish to incorporate any Edit module changes, use the Export or Quick 
Export commands to get a version of the photo with your edits.

Show in Finder/Show in Explorer

To view a file or folder in the Finder (MacOS) or Explorer (Windows), right-click on an image or folder in the 
Preview area and choose Show in Finder or Show in Explorer from the pop-up menu.

Changing a folder’s thumbnail preview

By default, Photo RAW chooses an image from a folder to use as the preview thumbnail for that folder. 
To change this, double-click on the folder icon and select a photo you would like to use as the thumbnail. 
Right-click on the photo and choose Set Folder Preview from the pop-up menu. 
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ALBUMS PANE

ON1 Photo RAW 2021’s Albums feature lets you organize or keep 
track of photos on a project, event or even a broader category like 
a portfolio. Albums are created by selecting images manually and 
adding them to a new (or existing album) by dragging and dropping 
photos onto the pane. You can nest albums together to help 
manage your collections, and all albums created can be published to 
ON1 Cloud Sync, which are indicated by the Cloud Sync icon to the 
right of the album name. (Any albums created on other ON1 Cloud 
Sync devices will be displayed in the Albums pane on all of your 
connected computers.)

Creating an album

Click the ‘+’ icon in the pane and choose Create Album… from the 
pop-up menu. You can also create an album by selecting photos and 
dragging them onto the ‘+’ icon in the Albums pane.

The New Album dialog box gives you options for 
adding an album name, and whether you wish 
to add the selected photos to the new album. If 
you would like to publish the album to the ON1 
Cloud, click the box and choose either Editable 
Preview or Originals from the pop-up menu. 
Which option you choose will depend upon your 
intent, and your storage availability. See page 
71 for more detailed information about ON1 
Cloud Sync.

Adding photos to an existing album

There are multiple ways to add photos:

• Dragging and dropping a photo on the album name.

• Selecting a photo or group of photos, right-clicking on the photo and choosing Add to Album 
from the pop-up menu.

• Choosing Album > Add to Album and picking the destination album from the menu.

• You can also copy a photo and paste it into an album: click on a photo, choose Edit > Copy, 
then click on the album in the Albums pane, and choose Edit > Paste.

Removing photos from an album

To remove a photo (or photos) from an album, select them in the album, then choose Remove from Album 
from the Album menu, or right-click on the photo and choose Remove from Album from the pop-up menu. 
(You can also select a photo and press Shift-Delete.)

Delete an album

To delete an album, right-click on the album name and choose Delete.
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Publishing and unpublishing an album from ON1 Cloud Sync

You can publish any existing album to ON1 Cloud Sync by right-clicking on the album name and choosing 
Publish to ON1 Cloud Sync. Right-clicking and choosing Unpublish from ON1 Cloud Sync will remove that 
album from your synced devices, but leave it on the device from which it was originally shared.

NOTE: ON1 Cloud Sync albums can only be unpublished from the device that 
they were created on, but you can delete any published album from any ON1 
Cloud Sync device. Doing this will remove that album from all of your devices. 

Changing the album thumbnail preview

To change the preview thumbnail of a nested album, double-click on the album name. Select a photo you 
would like to use for the preview, right-click on it and choose Set Album Preview from the pop-up menu.

Nesting albums

To create a set of nested albums, first create a blank album by clicking on the + icon in the Albums pane. 
You can easily add sub-albums to that new master album set by dragging and dropping the desired albums 
onto the new one in the Albums pane. When you click on the master album, Browse will display the albums 
that are part of that collection in the Preview area in a folder-style view. Double-clicking on an album icon 
will display the contents of that album. To view all the images in a master album set, click on the “Show 
Sub-Album Contents” button at the bottom of the Browse window.

When you click on a nested album set, Browse displays the sub-albums. Double-clicking on a sub-album will open that album. If you wish to view all of the images 
in a nested album set, click the Show Sub-album Contents button at the bottom of the Browse window.



ON1 Photo RAW 2021 User Guide	 Part 2: Organizing with Browse	 50

To move a sub-album from a master album to the top Albums level, drag and drop it out of the master, or 
right-click on the sub-album name and choose Move to Top.

If you drag an album onto an existing album that already contains images, you will see the top-level album’s 
images at the root level, along with any sub-albums.

NOTE: Nested albums cannot currently be published to ON1 Cloud Sync.  

DATES PANE

Photo RAW’s Dates pane offers a quick way to look for cataloged 
images based on when they were taken. Using a simple timeline 
interface, you can drill down into your photo library by year, month 
and day. It makes searching for things like birthday and holiday 
photos a snap.

Opening the Dates pane, you’ll see a list of years, with the current 
year at the top (only years that have photos taken during them will be 
present in the list). Clicking on a year will show you all of the photos 
taken during that year. Clicking on the triangle to the left of the year 
will display a list of all the months that have photos in them, and you 
can keep drilling down to the day level. Drilling down to any level in 
the pane—year, month, day—will show all photos taken during that 
period.

The Dates pane works only with cataloged folders.

ADVANCED SEARCH PANE

The Advanced Search pane (known as the Filters pane in 
earlier versions of Photo RAW) is designed to help you find 
photos in your photo library, based on a variety of criteria 
specific to photos and the metadata embedded in them. You 
can search based on any text associated with a photo, as 
well as likes, labels and star ratings, date, and keywords, and 
nearly any piece of metadata, from camera body and lens to 
aperture, ISO settings, time of day, and much more. 

Advanced Search options are flexible: they can be applied to 
the current folder view or album, or they can search any or 
all of your cataloged folders. You can also save any search as 
a preset style, so you can use it again in the future.

The pane has two modes: Basic and Advanced. In Simple 
mode, you can filter based on likes, star ratings, color labels, 
time, or basic text strings; all of the selections in this mode will match ALL of the chosen criteria to be 
found.

Advanced Search’s basic view lets you quickly search your 
current folder view, album or cataloged folders on flags, 
ratings, labels, time and text.
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The Advanced option lets you find photos based on nearly every possible metadata type or textual 
information associated with a photo, and you can set the filter to match all or any of the chosen criteria. 

TIP: Entering text in the search box in the top of the Browse window will 
automatically turn on the Advanced Search pane, and enter that text in the 
pane’s text field.

Using the Advanced Search pane

To perform a search, either type some text in the search box at the top of the Browse window, or click the 
button to the left of the Advanced Search label and set your criteria. If you want to filter based upon your 
cataloged folders, adjust the pop-up option underneath the pane’s text box. (To turn the pane off, click the 
Advanced Search button again.)

At the top of the Advanced Search pane is a set of common styles: Liked (any photo with the Like flag set), 
Five Stars, Recent (last 30 days), and Cataloged. Clicking on any one of these will run that specific search. 
Clicking on the More icon at the far right of the pane will give you a list of preset and user-defined styles, 
where you can choose additional filtering criteria, save the current search as a new style, or update it, if you 
are modifying an existing style.

Below the styles are other options for performing a quick filter operation: 

• Flags: Liked (represented by a heart filled 
in), disliked (X) or not set (empty heart). 
Click on the icon to turn that setting on.

• Star ratings from zero to five: Click on 
the greater than or equal symbol to the 
left of the stars to get a pop-up menu that 
lets you set the filter to show the exact 
number of stars, greater than or equal to 
the number of stars, or less than or equal 
the number of stars.

• Color labels: Clicking on the color will find 
all photos that have that label applied to 
them; you can select multiple color labels 
by clicking on additional colors.

• Date range: There are several preset 
relative date ranges in the pop-up menu. 
You can also set your own date range by 
choosing Custom from the pop-up menu, 
or by clicking on the calendar icon to the 
right of the pop-up.

• Text search: Find images that contain the entered text in the filename, metadata, keywords 
or description.

• Filter Current Photos/Search Cataloged Folders: This pop-up lets you apply the current 
search to either the current Browse view will apply the filter to all of your cataloged folders.

In addition to the preset styles at the top of the pane, a list of other styles 
is accessible via the More pop-up. You can also create your own custom 
styles..
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Choosing these any of these options will find photos based on all of the options chosen (i.e. 3 stars AND 
the Red color label). To filter with additional options, or to filter based on any criteria (i.e. 3 stars OR the 
Red color label), use the Advanced section at the bottom of the pane.

Using advanced search options

The Advanced section at the bottom of the pane lets you add more discrete search options, choose 
multiple conditions to search upon, and set those options to filter on any or all of the criteria selected. 
Create an advanced filter by clicking on the Advanced triangle and choose either Match All Criteria or 
Match Any Criteria from the pop-up menu directly under the Advanced tab.

By default, the pop-up underneath the Match menu is set to Everything, with an empty text box to the 
right of the option. If you would like to narrow the filter to more precise metadata, click on the pop-up 
menu and choose one of the advanced options from the list. These options range from camera metadata 
(Camera, Lens, Focal Length, Aperture, Shutter Speed, and ISO), to descriptive metadata (Keyword, Author, 
Description); to image-specific information (File Path, File Type, 
Orientation, Height in Pixels, Width in Pixels); to object type 
(Version, Original, Video). One other filter, Time of Day, lets you 
select images based on the time they were taken; you can 
choose Morning, Afternoon, Evening, or Night.

Once you’ve selected a filter, click on field to the right of the 
filter and enter (or select) the information upon which you 
wish to filter. Many of the advanced filtering options have pre-
populated data taken from indexed metadata in your library, 
while others let you enter text into the selection field. (The 
Everything filter looks for text in all of the metadata associated 
with your photos.)

To choose additional filtering options, click on the Add button 
at the bottom of the Filter pane, and choose another criterion 
from the pop-up. 

Saving and modifying search results

If you find yourself using the same search operation over and over, you can save it as a style. Just create 
the filter and choose Save New Style from the More pop-up menu at the top of the pane and give the style 
a descriptive name. It will now appear at the bottom of the More menu. To delete a user style, choose 
Delete Style from the More pop-up and select the style you wish to remove. (You can only delete styles 
you have generated, not the default set installed with Photo RAW.)

You can also update an existing style with changes made to the filter, whether it is one of the default filters 
or one of your own. To do this, select the desired filter in the pane, make the changes you wish, and select 
Update Style with Current Settings.

For example, you might want to change the Captured This Year filter to only filter on photos with 1 star or 
more. Choose the filter from the pop-up, then click on the 1-star icon, and update the style.

The Advanced section in the search pane lets you 
choose from nearly every available type of metadata. 
Here, we want to find all cataloged photos created with 
a Sony A7RIII camera and a 16-35mm lens.
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TETHERED SHOOTING

The Tethered Shooting pane lets you remotely control a camera 
connected to your computer via USB, and capture images from the 
camera to your computer. Tethered shooting is used for shooting and 
saving images in a studio setting, displaying your images immediately on 
your computer’s display. It is an excellent way to make adjustments to 
lighting and composition in the studio.

To get started with tethered shooting, connect your camera to your 
computer with the appropriate USB cable (your camera’s manual should have information on the cable 
required, if the camera didn’t come with one). Turn the camera on, then, in the Tethered Shooting pane, 
turn the pane on by clicking the button to the left of the pane’s name. 

Photo RAW will search for a connected camera and, if found, it will open the Import window. In the panel 
on the right of that window, you can choose a number of options for saving your tethered shots, including 
file name and location, metadata, any Develop or Effects settings, and time adjustments. The file naming 
portion of the Import Settings window is based upon the Batch Rename feature, described on page 46. 
(See “Importing Photos into Browse” on page 59 for an explanation of panes in the Import window.)

Once you have chosen your tethered 
import settings, click the Start Shooting 
button at the bottom right of the 
Import window, which will close the 
window. The Tethered Shooting pane 
will now have the model of your camera 
selected, with the current shot settings 
in the table at the bottom of the pane. 
The settings are, from left to right and 
top to bottom, shutter speed, aperture, 
ISO, camera shooting mode (Manual, 
Aperture/Shutter Priority), exposure 
compensation, and white balance. Any 
setting that has a drop-down will let you 
change that setting.

Clicking the Fire button in the pane will 
take a shot with the current camera 
settings, and will save it to the location you chose in the Import Settings window. If you’re in Grid View, the 
image will appear at the beginning of the end of the thumbnail grid, depending upon how your sort order is 
set up. If you’re in Detail or Filmstrip view, the tethered image will appear in the Preview area.

When you are finished with a shoot, turn the Tethered Shooting pane off by clicking the button next to the 
pane’s title, turn your camera off, and disconnect it from your computer.

NOTE: ON1 Photo RAW 2021’s Tethered Shooting feature currently supports 
most Canon and Nikon digital SLR cameras. Check ON1’s support website 
(on1help.zendesk.com) for additional camera models.

When you turn the Tethered Shooting pane on—or click on the Import Settings button in 
the pane—you’ll see the Import window, where you can set the location to save tethered 
shots, rename them, add metadata and more.

https://on1help.zendesk.com/
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RECENT

The Recent pane keeps track of recently opened files browsed 
folders. Files are listed in order of last opened. You can access your 
most recent files in this pane by clicking on the one you want and 
it will appear in your main preview window. The Recent pane only 
shows files you have opened from within Browse, not files you have 
opened from Lightroom, Photoshop, Elements or Apple Photos.

You can clear the recent list by pressing the ‘x’ icon in the title bar.

The Photo Panel
The panel on the right side of the screen contains information relative to the currently selected image in 
the Preview area, and includes three sections: Nav, Levels, and Info.

THE NAVIGATOR PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane presents a thumbnail view of the current image. 
The white square region marks the image area that is 
visible in the preview pane. You can pan your image by 
clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 50% 
and 25%). Click on one of the buttons to change the view. 
Fit zooms to fit the current canvas size, while 100 zooms 
to 100%, displaying the actual pixels.

THE LEVELS PANE (DETAIL AND 
FILMSTRIP VIEWS ONLY)

This pane gives you a color chart of the shadow, midtone 
and highlight areas based on an image’s RGB values 
(commonly known as a histogram). This is useful to show 
areas within the image that may be clipping. Clipping is 
when your image contains pure blacks or white and can 
signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of 
each end is a triangle. If the triangle is lit, there is clipping 
on that side of the histogram. If you click on the arrows, 
you will activate the clipping overlay on your image, which 
displays the areas that are clipped. Those areas with a blue overlay are pure black, while the areas with the 

The Navigator pane.

The Levels pane.
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red overlay are pure white. You can turn the clipping view off again by clicking on one of the triangles. You 
can also temporarily enable clipping view by holding down the J key at any time. (Clipping can be turned 
on or off permanently by pressing Alt (Windows) or Option (Mac) and the J key.) The clipping view is useful 
when you are making adjustments to the brightness and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

INFO PANE (ALL VIEWS)

The Info pane displays common metadata and other 
information for the currently selected image in a large, 
easy-to-read format. This metadata includes:

• Camera make and model

• Lens focal length

• Capture date and time

• File type

• ISO

• Shutter speed

• Aperture

• Exposure compensation

• Image dimensions

• File size

• Any settings applied inside the Edit module

If any of the metadata fields are unavailable they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all 
of the operations from the Edit module that have been 
applied to the current image. Clicking on the right arrow 
to the left of the label will display a list of every tab in 
the Edit module, as well as primary adjustment options, 
including cropping, retouching and text operations. If an 
image has had any adjustments made to it, that section 
of the Settings Applied area will be represented in white 
type, and you can drill down further into the Develop, 
Effects, Portrait, and Local Adjustment tabs to see which 
adjustments were made to an image. (On an image that 
has had no adjustments, all of the settings will be grayed 
out.)

Double-clicking on any of the available items inside the Settings Applied area will jump to that setting inside 
the Edit module, where you can adjust it easily.

The Info pane. with the Settings Applied option hidden. Clicking 
on the arrow to the left of the label will display specific 
adjustments made in the Edit module.

The Settings Applied section of the Info pane gives you a quick 
window into which adjustments were made to an image in the 
Edit module. Click the right arrow to open the section and view 
the individual edits. Double-click on any item in the list to take 
you to that setting.
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METADATA PANE

The Metadata pane displays more complete metadata about 
a photo than is found in the Info pane, and lets you add your 
own metadata elements, such as author, copyright, contact 
information, keywords, location information and photo 
descriptions. 

In addition, at the bottom of the Metadata pane are three 
labels/tabs for viewing or adding specific types of information 
to your photos:

• EXIF (Exchangeable Image File Format) displays all 
of the data embedded by your camera. Depending 
upon the camera, some of all of this information will 
be displayed, and many of the fields are editable. 

• IPTC (International Press Telecommunications 
Council) is an industry-standard metadata 
format, and offers much more detailed metadata 
information than EXIF. It historically has been 
used by journalists and stock photographers to 
catalog and tag photos, as well as add copyright 
information, captions, and other data.

• Location includes GPS information, as well as 
country, state/province and city information. Photo 
RAW can automatically look up this information 
for any photo that has GPS coordinates, via the Set 
Location from GPS Coordinates item in the Photo 
menu.

To go back and forth between the EXIF, IPTC and Location fields in the Metadata pane, click on the label. If 
you don’t wish to view any of the metadata tabs, click the None tab. 

When you enter text into any field in the Metadata pane, Photo RAW will add that information to the 
currently selected image. You can change the metadata in multiple images at the same time by selecting 
them all, then changing any of the fields in the pane.

Metadata templates

With ON1 Photo RAW, you can create metadata templates that apply common information to your images, 
data such as copyright, author, contact information, your website and more. These preset templates can be 
accessed in the Metadata pane, as well as via the Import feature (see “Importing Photos into Browse” on 
page 59).

Saving a metadata template is easy: you can either go to an image that has the basic metadata items you 
wish to use, or you can select an image without metadata and add your common items to the Metadata 
pane. Once you have the metadata set, click on the Preset drop-down menu at the top of the pane and 
choose Save New Preset. The Save Preset dialog will appear on-screen, and you can choose which 
metadata fields you wish to save as part of the template. For example, while you might wish to save the 
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copyright and contact information as part of your preset, you might not want to apply keyword, GPS or 
description data to a group of images. 

You can update a metadata template by selecting the preset 
in the pane, then changing the appropriate fields as desired, 
and then choosing Update Preset with Current Settings from 
the Preset drop-down. To delete a metadata preset, first 
choose the preset from the drop-down menu, then choose 
Delete Preset from the menu. 

Embedding metadata

Metadata you add in Browse is stored in industry-standard 
XMP sidecar files for raw files. This facilitates the transfer of 
metadata to any application that supports XMP. When you 
edit an image, create a copy of an image for editing or use 
the ‘Send to’ command, the metadata is embedded into the 
file automatically (with the exception of raw files). You can 
manually embed your metadata into images using the Embed 
Metadata command from the Photos menu. This will open 
each image you have selected, update the metadata and re-save it. This is supported for TIF, PSD, PSB and 
JPG files; raw and PNG files do not support direct embedding of metadata.

Reading metadata

Sometimes, when you’ve been sharing raw images across machines or with others, the metadata 
information might get ‘lost,’ or is different than your original metadata. In these instances, choose Read 
Metadata from the Photo menu, which will grab the metadata from the file or the XMP file (for raw files).

KEYWORD LIST PANE

As you add cataloged folders or browse through folders 
of non-cataloged photos inside ON1 Photo RAW 2021, 
any keywords you have added—to any photo—are stored 
in an internal database. That list of keywords is visible in 
the Keyword List pane, and from there, you can search 
for established keywords and display those photos from 
your cataloged folders, manage the keyword list, and 
apply keywords to new images. And, to help manage 
your keywords, Photo RAW 2021 will also let you create 
subcategories of keywords (see “Using hierarchical keywords 
with Photo RAW” on page 58).

If you double-click on a keyword in the list, Photo RAW will 
search your cataloged folders for that keyword, and display 
the results in the Preview window. In this search, Photo RAW 
is actually performing a search in the Advanced Search pane, so you can refine your search there, if you 
wish to add additional filter criteria. (If you would like to search the current folder only, choose the Filter 
Current Photos option in the Advanced Search pane.)

The Save Metadata Preset dialog lets you choose which 
metadata fields get saved to a preset from the currently 
selected image.
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You can assign keywords to an image in any of Browse’s views. Click on the button to the left of a keyword, 
and Photo RAW will apply that keyword to the currently selected image or images.

Right-clicking on a keyword gives you a pop-up menu with a list of options you can perform:

• Assign Keyword to Selected Photos: adds that keyword to the current selection.

• Remove Keyword from Selected Photos: removes that keyword from the selection

• Add Keyword: Lets you create a new keyword, with the option to save that keyword as a 
subcategory of the currently selected keyword.

• Edit Keyword: lets you rename the selected keyword, and applies the new keyword to all of 
the cataloged and known photos that used it.

• Delete Keyword: Removes that keyword from the cataloged and known photos that use it.

• Find Cataloged Photos with Keyword: Displays (in grid view) all of the photos in your 
cataloged folders that use the selected keyword.

Refining the Keyword List

Because the list of keywords can be extremely long, you can use the pane’s search field to look for 
keywords: as you start to type in the field, Photo RAW will display a list of keywords that contain the 
letters you’ve typed. Once you’ve narrowed your search, you can select a keyword from the list (shown, 
right), and perform any keyword operations detailed in the previous section.

Using hierarchical keywords with Photo RAW

In addition to standard keywords, ON1 Photo RAW 2021 
also supports the creation and use of hierarchical keywords. 
This option lets you “nest” keywords within a top-level 
keyword, which can be helpful to manage and categorize 
keywords. 

For example, you might want to use a master keyword for 
states that you’ve visited—“California,” “Nevada,” “Oregon,” 
etc.—and use sub-keywords for places within the state, like 
“Death Valley,” “Joshua Tree”, “Valley of Fire” and others. 

Hierarchical keywords are displayed in the Keyword pane 
with a small right arrow to the left of the top-level keyword. 
Clicking on the arrow will display the sub-keywords for that 
master, with the number of images with that keyword on the 
right side. As is the case with standard (i.e. non-hierarchical) 
keywords, you can double-click on any of the nested 
keywords to show all of the photos in your cataloged folders 
that use that keyword.

To create a keyword hierarchy, first create your master keyword by clicking on the gear icon at the top 
of the Keyword List pane and choosing Add Keyword. Enter the name of the top-level keyword and click 
Apply. (If you have photos selected, and don’t want to add the new keyword to those images, uncheck the 
“Add to Selected” box before clicking Apply.)

To create a new nested keyword, right-click on the master keyword and choose Add Keyword from the 

Hierarchical keywords can help with keyword management, 
and are extremely useful when you wish to use primary and 
secondary categories for such image categories as locations, 
people, types of shoots, and so on.
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pop-up. The dialog box should now give you a check box to nest the new keyword inside the top-level 
keyword, as well as to add the new keyword to any selected photos.

If you wish to create new hierarchies from existing keywords, it is best to first create your master keyword, 
and then drag any existing keywords onto that master. 

Importing Photos into Browse
ON1 Photo RAW’s Import function lets you quickly grab photos directly from your camera, memory card, 
phone, tablet, or other source location (like a portable hard drive loaded with images from the field).

To import photos, connect your camera, card or other device and choose Import from Browse’s File menu. 
The Import window opens, with the following options:

A.	 Import Options Bar: Lets you choose the source (camera, memory card, or other device), if 
Photo RAW should search through subfolders on the source, eject the device after importing, 

To create a hierarchical keyword set, create the top-level keyword by choosing Add Keyword from the Keyword List pop-up. Then, right-click the 
top-level keyword and choose Add Keyword. There, you will have the option to nest the new keyword inside the top-level keyword. 
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and to not import suspected duplicate images. You can also choose options for selecting all 
photos or none of them.

B.	 Preview window: Displays the images to be imported. By default, all photos are included; 
click the check mark in the corner of any image to remove it from the import process.

C.	 Thumbnail size: Adjusts the size of the thumbnails in the preview area. 

D.	Preset selector: Applies an import preset—which can include any of the settings from the 
import panel on the right—to the currently selected images.

E.	 Destination: This pane sets the location of the imported images, backup location—if you wish 
to have a copy of your photos saved as a backup to another location—and the organization of 
imported files (into a single folder, or into folders organized by month or by month and day).

F.	 Rename: This pane lets you rename the imported files, with options for custom text, 
serialization, and by date. (This pane uses the same fields found in the Rename Files dialog; 
see “Renaming a file or folder” on page 46 for more.)

G.	Add Metadata: Lets you add assorted metadata to the imported images, ranging from 
keywords, copyright information and more. To access the complete IPTC metadata fields, 
click the More drop-down; you can also add GPS coordinates and a description via this  
section of the pane. You can use existing metadata presets (or create your own in this 
window) to apply consistent metadata across multiple imports; simply enter the data you wish 
to include and choose Save New Preset from the Preset menu in the pane. (See “Metadata 
templates” on page 31  for more on metadata presets.)

H.	Photo Settings: This pane lets you apply any Edit module presets to the imported images. 
(These settings are not permanent; you can adjust or reset the adjustments via the Settings 
menu. See “Presets” on page 105 for more.)

I.	 Edit Capture Date: Use this pane when you wish to change the capture date of imported 
images. The Adjust Time Zone setting can be helpful if you forget to change your camera’s 
clock when you travel across multiple time zones.

Once you have adjusted your import settings and 
selected the images for import, click on the Import 
button to perform the operation. While your photos are 
being imported, you’ll see a progress bar displayed in 
the lower right side of the Browse window. If your import location is a cataloged folder, the new images will 
be indexed automatically in the background.

BYPASSING DUPLICATE FILES DURING IMPORT

The Don’t Import Duplicates option is helpful for those times when you re-
use a card in the field, but don’t delete the photos from it.

Each time you use the Import function, Photo RAW keeps a record of every 
imported photo’s filename and capture time. When you add a card to import, 
the app checks its import database, and if it finds a duplicate, it will uncheck 
it in the Import window, and display an “Already Imported” icon to the right 
of the checkbox.  

Because Photo RAW saves the original filename and time metadata, the 
Don’t Import Duplicates option works even if you use the Rename option 

While Photo RAW is importing images from a camera or card, you’ll 
see a progress indicator at the bottom of the Browse window.

With the Don’t Import Duplicates 
option on, any photo that has already 
been imported will be deselected.
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to rename the photos on import. And, if for some reason you wish to re-import a photo, you can click the 
selection check mark to re-import it.

SAVING IMPORT SETTINGS AS A PRESET

Photo RAW makes it easy to save often-used import settings as a preset: things like copyright and other 
metadata, file-naming conventions, import locations and more. To save an import preset, adjust the 
information and settings in any of the panes on the right of the Import window, and choose Save New 
Preset from the pop-up. Thereafter, when you choose the preset, it will apply those saved settings to the 
current import job. If you wish to change a setting for an existing preset, select the preset, make your 
changes in the panels and choose Update Existing Preset from the preset selector’s pop-up menu.

Photo RAW remembers the last-used import preset when you choose Import from the File menu.

Using Smart Organize to Manage Duplicates and More
Photo RAW’s Smart Organize feature is designed to 
help you get an unwieldy photo library under control. 
When you have a large library that contains thousands 
of photos, it can be difficult to find duplicates, or to 
manage images that are similar in appearance or date 
and time. Or sometimes, you wish to group photos 
from HDR brackets, slices for building panoramas, 
or photos to be focus stacked. Not only can Smart 
Organize find duplicates, but it can find and group 
photos that have similar appearance, location or time. 
It can help you cull your library to find just the best 
photos in a series.

To access Smart Organize, click on the icon in the Shortcuts list or choose Smart Organize from the File 
menu. This will open the start-up window, which has two sections. The first section lets you choose which 
part of your photo library you wish to search:

• The contents of the current view in Browse (Current Photos);

• All of your cataloged folders;

• A specific folder selected via your operating system’s file/folder 
selection dialog box; or 

• Any one of your individually cataloged folders.

The second portion of the start-up window lets you choose which search mode to use. There are four 
options:

• Duplicate Photos. This option looks for potential duplicate images, based on name, date 
taken, file size, and dimensions.

• Similar Appearance. This option uses machine learning to find photos that are similar to each 
other, looking at similar tones and colors. This makes it easy to group and sort through series 
of photos, such as portraits of different people.
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• Same Time. Selects photos that were shot in the same general time frame. When you wish to 
group panorama slices or HDR brackets, you can use this option to group sets of images. 

• Same Place. Uses GPS data to display photos taken in the same general vicinity of each other. 

Clicking the Find button will perform the search, and open the Smart Organize Results window, as shown 
on the following page.

NOTE: When working with large collections of photos, Smart Organize can 
take quite a bit of time to display results.

THE SMART ORGANIZE RESULTS WINDOW

The Smart Organize results window contains the following elements:

A.	Results: the total number of photos found, and the number of sets.

B.	 Group heading: displays the group number and the number of photos marked in that group.

C.	 Preview area: displays search results as grid of thumbnails, by group. 

D.	View Selector: zoom factor (top left); switch between Grid and Compare views (bottom left); 
file path for the currently selected photo.

E.	 Reject/Delete and Auto Mark settings. 
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F.	 Group-specific options: let you create a new subfolder with the selected images: reject/
delete marked photos in the group: and Skip the group and remove it from the window.

G.	Search Options: includes the original search type, but you can also perform a new search by 
selecting items from the pop-up menus in the panel.

H.	Info Panel: displays EXIF and size information for the currently selected photo. Works 
identically to the standard Info panel in ON1 Photo RAW 2021 (see page 55)

I.	 Settings Applied: shows all of the operations from the Edit module that have been applied to 
the current image (see page 55).

J.	 Close buttons: Reject/Delete All Marked closes the window and does either deletes/rejects 
the marked photos in all groups; Done closes the window without making any changes.

Working through the search results

When you perform a search with Smart Organize, the results window is organized into groups, based on 
the search mode you chose. Groups can consist of a pair of photos, or larger numbers, based on your library 
and the type of search. You can use the view slider of the window to make the thumbnails larger or smaller, 
and you can view the photos in Grid or Compare modes, which work in the same manner as those views in 
the main Browse window. 

The idea behind the results window is that you’ll work group by group, evaluating the photos in that group, 
and making decisions on the group’s contents based on the type of search you originally made. Photos that 
you wish to do something with—remove in one form or place into subfolders—you apply a checkmark to. 
Then, you’ll move on to the next group. The top section of each group has the following items:

A.	Group Information: Displays the number of the current group (out of the total number of 
groups) and the number of photos marked in the group. You can also use the right and left 
arrows on the left side of the bar to move to another group.

B.	 New Subfolder: Creates a subfolder with the marked photos in the group.

C.	 Reject/Delete All: This will apply the reject flag or delete all of the photos in the group, based 
on the Reject Mode option chosen at the top of the search results window.

D.	Reject/Delete Marked: This will apply the reject flag to, or delete all of the marked photos in 
the group, based on the Reject Mode option chosen.

E.	 Skip Group: Removes the group from the results, without making any changes.

In each group, you mark photos you want to deal with—ones you wish to reject/delete or move to a 
subfolder—with the checkbox in the upper corner of that photo’s thumbnail. You can select multiple photos 
in a group, and when you choose one of the actions, it will apply to the checked photos. Clicking on the 
New Subfolder, Reject/Delete All, or the Reject/Delete Marked buttons will apply that action to the group 
and remove the group from the results list. Clicking on the Skip Group button will remove that group from 
the results window and not make any changes to those photos.

When you’re using Smart Organize to look for and group photos—for HDR, panoramas, focus stacking, or 
other organizational uses, use the New Subfolder option. Mark the photos that you wish to group, and click 
on the New Subfolder button. You’ll be prompted for a folder name; enter the name and click OK. Photo 
RAW will move the marked photos to that new folder. 
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NOTE: If the marked photos do not reside in the same folder the New 
Subfolder button will be grayed out.

Using Auto Mark

When you have the Auto Mark option checked 
at the top of the results window, Photo RAW 
will mark the photos in each group that it 
believes should be checked, based on criteria 
found in the Auto Mark tab of the Preferences 
window. This tab can be opened in the search 
results window by clicking on the gear icon to 
the right of the Auto Mark checkbox.

That window displays a collection of 10 criteria—
file type, editing status, various image metadata 
items, and more—that you can set, and that 
Photo RAW will utilize when performing a Smart 
Organize search. For example, you can choose 
to prefer Raw files over ONPhoto, JPG or PSD files, and, when creating each group, Photo RAW will mark—
or not in the case of finding duplicate files—the appropriate images.

Auto Mark is intended to be an aid in helping you select and mark photos, especially when you’re dealing 
with large groups of photos. It doesn’t, however, automatically delete or reject photos; in each found group, 
you can choose to accept its recommendations, change them, or ignore them completely and skip that 
group. If you prefer to mark images in groups by yourself, simply turn the Auto Mark option off at the top 
of the results window.

Advanced search options

If you would like to perform a different search than the one 
currently displayed in the Smart Organize results window, 
you can do so via the Search Options pane on the left side 
of the results screen. The top of that pane has pop-ups for 
the search locations and the four search types (duplicates, 
appearance, time and location). However, there are two other 
options you can change, depending upon the type of search 
operation you are making.

In all four search types, the bottom of the pane has a menu 
with three options related to the aspect ratio and size of the 
photos selected. You can choose to refine the selection to 
files of the aspect ratio, the same pixel dimensions, or none. 

When you are searching for photos based on similarity, time or location, an Advanced section will be visible 
in the Search Options pane. The three Advanced options (and which search type they work with) are: 

• Matching Level (Find Similar): This slider adjusts the results of grouped photos. The smaller 
the number, the less they have to match to be grouped. 
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• Time Gap (Group by Time): This lets you adjust the time in between shots by which you wish 
images to be grouped.

• GPS Distance (Group by Location): Sets the range (in meters) by which location-based photos 
are grouped.

When you have set the parameters of your new search, click the Search button, and Smart Organize will 
generate a new results window.

Editing Photos in Browse
While most of ON1 Photo RAW 2021’s image-editing power is found within the Edit module, you can 
perform many editing tasks on photos inside Browse. This includes changing metadata, labels and ratings, 
but you can also apply presets to an image or group of images, and can even copy Develop/Effects settings 
from one photo and paste them onto other photos directly within Browse. These operations are also 
available to any photos shared via ON1 Cloud Sync.

RATINGS, LABELS AND LIKES

Using a standard rating and label system, it is easy to sort and cull your favorites from the throw-away 
shots. Browse offers three ways, aside from keywords and subfolders, to mark and group similar images. All 
of these methods may be set several ways: from the Photo menu, the right-click contextual menu, clicking 
the badges on the image thumbnail or in the footer of Image view. There are also keyboard shortcuts 
associated with each classification option.

• Star ratings: Set from zero to five stars. Photographers 
often use five stars for their favorite images and one star 
for images they don’t want to keep, but you can use this 
system in whatever way works best for you. You can adjust 
the rating using the 1 through 5 keys on the keyboard. You 
can also clear the stars on any image with the ` (backquote 
or grave) key.

• Color labels: There are five color labels as well. Color 
labels are a great way to mark sub-sets of images for 
special handling. You can set the color ratings by pressing 
the following keys: 6 (red), 7 (yellow), 8 (blue), 9 (green), 0 
(purple).

• Likes: A common need for photographers is to mark their 
favorite images and the ones they want to delete. This is best accomplished with the Like 
classification. There are three options: Like (icon with a filled-in heart), Dislike (‘X’ icon) and 
Not Set (empty heart). By default, images are in the Not Set category until you change them. 
You can set your Liked images with the P keyboard shortcut, Dislikes with the X key, and clear 
settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are 
stored in the metadata and will be available in other photo editors and managers, like Lightroom. (Likes are 
proprietary and will only appear in ON1 Photo RAW 2021.)

An example of a photo in Grid view with a 
ratings, color and favorite attached.
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Use Auto Advance when culling your photos

Photo RAW’s Auto Advance feature—which can be turned on or off via the Photo menu—was designed to 
help you rank a group of images quickly: with Auto Advance turned on, apply a rating, color label or flag to 
an current image and Photo RAW will make the change and automatically move to the next image.

APPLYING EDIT MODULE PRESETS IN BROWSE

ON1 Photo RAW 2021 has a preset system that lets you save your complete settings from the Edit module. 
These presets are always available in Browse, so you can apply your favorite presets quickly and easily to a 
photo or a group of photos.

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1, as well as any presets you might have created or installed yourself. The panel is divided into 
categories, like Architecture, Landscape, Portraits, and more. Clicking on a category name will open it and 
display any presets within that category, each with a tiny thumbnail showing 
your selected image with that preset applied to it.

To see a larger representation of what your selected photo will look like, click 
the Quick View Browser icon in the preset category’s title bar. That will display 
an overlay window with all of the presets in that category.

To apply a preset to a photo, simply click on the preset in either the Category 
preset browser or in Quick View Browser mode. Presets applied in Browse are 
not cumulative; after you’ve applied one preset, clicking on another preset will 
remove the previous one and apply the new one. (If you have applied edits in 
either Develop or Effects, those modules’ settings will be erased if the preset 
has settings in those modules.)

You can easily add a preset to any photo (or group of photos) in Browse, in any Preview mode (Grid, Detail, Filmstrip or Compare). Just 
click on the Presets tab, navigate to the category you wish to use, and click on the preset thumbnail to apply. If you don’t like the look, 
you can Undo, or choose another preset. You can also use the fade slider to reduce the amount of the effect.

The Presets panel has a broad 
range of preset types, all of 
which can be applied in the 
Browse module.
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Because Photo RAW is non-destructive, going to any of the Edit module tabs will display all of the settings 
applied by the preset. Once in Edit, you can adjust the settings, switch preset, or make any other editing 
changes.

To remove a preset from a photo, click on the photo and choose Reset All Settings from the Settings menu. 
You can also remove individual settings made in either the Develop or Effects tabs, if you prefer.

(For more detailed information about how to create and edit presets, see “Presets” on page 105.)

NOTE: If a photo has had a preset applied in Browse, 
or has otherwise been edited in one of Photo RAW’s 
editing tabs, you will see a small badge with a ‘+/-’ icon 
in the lower-right corner of the thumbnail. These badges 
are visible in the Grid, Filmstrip and Compare views. (See 
the image on the right for detail.)

COPYING SETTINGS AND SYNCHRONIZING EDITS

In addition to applying presets, you can copy all of the 
existing edits made in one photo and paste them directly 
onto other images in the Browse module. This includes 
every editing operation you can perform in the Edit module. 
There are two primary methods for doing this—Copy/Paste 
and Sync—but they achieve the same end goal: it’s more a 
matter of preference in which operation you choose.

To copy the edit settings from an image, click on the source 
file and choose Settings > Copy Settings. Then, click on the 
new image and choose Settings > Paste Settings. A window 
will appear, giving you the option of applying any or all of 
the edits on the original photo, or you can select which 
edits—everything from individual settings in Develop’s Tone 
and Color pane, to masks, cropping, and text if used—you 
wish to paste into the new photo. (You can also select a 
group of photos and paste the edit settings onto the group.)

The Copy/Paste Settings commands can be useful when 
you wish to paste settings across a number of photos in 
different folders. As long as your Browse session is active, 
Photo RAW will remember the last copied settings, and you 
can paste them onto other photos as you wish.

With the Sync Settings command, select the image you 
want to use as your source. Then, holding down the 
Shift key (if you are selecting an image or group that is 
contiguous with the source), or the Command (Mac) or 
Control (Windows) key, and click on the image(s) that you 
wish to apply the source file’s edits. Your selection should 

In the Apply Settings window—accessible from either Paste 
Settings or Sync Settings—you can apply nearly all Edit 
module operations to another image or group of images. 
Filled circles to the left of a setting mean that the setting will 
be applied; click the circle if you don’t wish that setting to be 
applied.
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have the source image highlighted in blue, and the target images highlighted in gray. If that is correct, click 
on the Sync button at the bottom of the Preview area, or choose Sync Settings from the Settings menu. 
The Apply Settings window will open, and you can follow the same procedure to synchronize your edits.

Sync All Settings

If you’re sure that you want to sync everything from a source photo to another photo or group of photos, 
the Settings > Sync All Settings command will let you bypass the Apply Settings window. Select your 
source  and destination photos and select the command. Note that all settings—including cropping, text and 
masks—in the source image will get synced.

RESETTING EDITS IN BROWSE

Any edits you have made with ON1 Photo RAW 2021 can be completely reset from within the Browse 
module. This includes photos you might have pasted or synchronized settings onto inside Browse, or 
anything done within the Edit module.

The Settings menu offers eight options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom of the Browse window.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset Portrait AI Settings: Removes only the settings applied in the Portrait tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original, uncropped size.

• Reset Text: Removes any text blocks.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: The Reset settings options—as well as the Copy/Paste and Sync 
options—are not available when you are working with layered photos in Browse. 
You can, however, Copy and Paste settings between layers in the Edit module.

SEND TO

Browse lets you send images you are viewing to other applications for 
editing. This is done via the Send to option, which is available from the 
right-click contextual menu or the Edit menu. Browse detects the following 
common photo managers or editors and lists the latest installed version:

• Adobe Photoshop
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• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos to. Simply select the Send to Other 
Application option. Then select the application you want to send your photos to. The application will be 
remembered and listed with your other Send to options. (For example, if you use an email client you can 
add it to easily email photos.)

When you send an image to another application, you will 
be presented with the Edit in dialog box from ON1 Photo 
RAW 2021. There you’ll have the option to send either the 
edited photo or the original, unedited image. If you choose 
to send a copy, you’ll have options for choosing the file type, 
color space, bit depth and resolution. If you use the same 
set of options every time, you can check the “Don’t ask me 
again” box in the window, and you won’t be prompted again. 
(To change this setting, go to the Files tab in Photo RAW’s 
Preferences.)

VERSIONS

ON1 Photo RAW’s Versions feature lets you create a ‘virtual’ copy 
of an image, which you can edit in a completely different manner 
than the original file, but without actually duplicating the image. 
This lets you easily try different preset treatments, crops, and 
retouching operations on a copy of the same image without having 
to lose any work—or see your disk space increase. 

Creating a version is easy: in any of Browse’s view modes, choosing 
Create Version from the Settings menu (or choosing Command-’ 
or Control-’) will create a new version of the currently selected 
(or viewed) photo. A copy of the image will be created next to 
the existing one in your library, with a ‘v1’ added to the filename. 
(Additional versions will be numbered sequentially.)

A version acts like most images inside Photo RAW. You can open it 
in any of the Edit module tabs; crop or make any adjustments with 
all of Photo RAW’s tools and filters; and you can edit its metadata independently of the original. You can 
even export a versioned photo or use it in Resize (Photo RAW creates a rendered file in those instances). 
You can not create a version of an .onphoto file that has layers in it, however. You must first flatten the 
image inside the Edit module. (See “Working with Layers” on page 168 for more.)

In Grid view, versioned photos will have a small square badge split into light and dark triangles.

Using ON1 Photo RAW 2021 with two displays
You can use Photo RAW’s Dual Mode feature to display a second copy of your photos in an added browser-
style window. Here, you can view folders of images as thumbnails, and navigate through them, while 

The Edit In dialog, with the Copy Options section expanded.

A versioned photo will have a ‘v1’ (or higher) 
attached to the end of the filename, and a small 
badge, split into dark and light triangles, in the 
lower right corner of the thumbnail.
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displaying the full-size images in the primary window. This can help your productivity when you have an 
additional monitor connected to your computer, reducing the need to switch between Grid and Detail, 
Filmstrip or Compare view. It can also be useful when you wish to present photos on a projector or TV, and 
don’t want to display the entire Photo RAW application window.

Dual Mode only works with the Browse and Edit modules. In Browse, you can choose how you wish the 
second window to act, either displaying in Grid view, with the primary window working in the three other 
view modes (Detail, Filmstrip or Compare), or vice versa. As you navigate images in the Grid, the other 
window will display the currently selected image.

When in the Edit module, the second window works solely in Grid view, displaying thumbnails of the 
current folder. If you click on another image in the grid, that image will be presented in the main window. 

TURNING DUAL MODE ON

To use this feature, chose Dual Mode > Show from the Window menu, or click the Dual Mode icon at the 
bottom left of the main window. The first time you use Dual Mode, the second window will open on your 
primary display. Simply drag the window to your secondary display, and from that point on, Photo RAW will 
remember the location of the second window. (When the window is placed in the second display, you can 
choose Dual Mode > Full Screen Mode from the window menu to have the window fill the entire screen.)

The icons at the bottom of the secondary window are a subset of the main Photo RAW application window: 
in Browse, you will see options for Grid, Detail and Compare views; in Edit, only the Grid view icon will 
be visible. The Size slider can change the size of thumbnails (in Grid view) or the zoom level (in Detail and 
Compare view).

Photo RAW’s Dual Mode lets you open a new browser-style window, which can be placed on a second display, or be used to present on a TV or projector.
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Using ON1 Cloud Sync with Photo RAW
ON1 Cloud Sync is an optional cloud storage service and sync technology that lets you 
capture, edit, and access photos seamlessly between multiple computers and mobile 
devices. The service is designed to share photos when you’re using the subscription 
versions of ON1 Photo RAW 2021 and ON1 Photo Mobile. Cloud Sync also lets you sync 
custom presets and extras between two installations of Photo RAW (Mac and Windows).

There are two storage options for ON1 Cloud Sync accounts, 200GB and 1TB, and multiple methods for 
signing up. If you have purchased an ON1 Photo RAW subscription, it will automatically be available in both 
Photo RAW or ON1 Photo RAW for Mobile after you have signed in to your ON1 account. 

From ON1 Photo RAW 2021, photos are published and synced to the ON1 Cloud via cataloged folders 
or albums, and you can choose to publish photos either as editable previews or in their original format 
(including raw). See “ON1 Cloud Sync File Formats” on page 73 for specifics on the different file types 
and why you would use one over the other.

When you’re using the ON1 Photo Mobile app on your smartphone or tablet, all photos on that device are 
published to the cloud in their original format, and reside in a single folder called Local Photos. (You can 
also create albums with ON1 Photo Mobile.)

VIEWING YOUR ON1 CLOUD SYNC STATUS

In the lower right section of the left sidebar is the ON1 Cloud Sync status icon, which has a small colored 
dot—in one of four colors—that indicates the status of ON1 Cloud Sync on the current computer. The 
indicator colors are:

• If there are no uploads or downloads in process, and the connection to the ON1 
Cloud is on, the dot will be green.

• When Photo RAW is in the process of uploading or downloading images or other 
information from the cloud, the dot will be blue.

• If there is a problem with the internet connection, you aren’t logged in, or if you are running 
low on available space, the dot will be red.

• It will be gray if you do not have an ON1 Cloud Sync account.

Clicking the status icon will bring up your ON1 
Cloud Sync dashboard (shown on the right). 
This window shows the status of any current 
uploads, your available cloud storage, and 
includes links to the iOS and Android versions 
of the ON1 Photo Mobile app. Clicking on the 
Account button will take you to your account 
page on the ON1 website. The Learn button 
displays a window with information on how to 
get started with ON1 Cloud Sync.

The Turbo button is used to speed uploads; it 
will take as much processing power as it can to sync photos, to the limit of your upload bandwidth.
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VIEWING OTHER ON1 CLOUD SYNC DEVICES IN BROWSE

When you have shared ON1 Cloud Sync devices, you can see a list of them by clicking on the ON1 Cloud 
Sync icon in the Shortcuts bar on the top left side of the Photo RAW window. 

ON1 Photo RAW 2021 will display your connected devices in the preview area as folders in Grid view. 
Clicking on one of those folders will open with a list of that device’s synced photos. For mobile devices, you 
will see a single folder, Local Photos, which contains all of the photos that are on that device. For Windows 
and Mac computers, you will see a list of all cataloged folders from that device. 

You can view and edit any of the photos on a synced device from within ON1 Photo RAW 2021, and you 
can drill down into the folders in the same manner you would for any other folder in Photo RAW. You can 
sort the photos, add them to new or existing albums, adjust metadata and add keywords to them. 

Clicking on the ON1 Cloud Sync icon at the bottom of the Shortcuts bar on the left will display a list of your connected devices. Each device 
will appear as a folder. Mobile devices will display a single folder, called Local Photos, while any Mac or Windows computer will display a list of 
the cataloged folders synced with the ON1 Cloud Sync service.

Photos synced to the ON1 Cloud from other devices will have a badge when you are viewing a folder or album in Browse’s Grid view. If 
the synced photo is an editable preview, it will have the Sync badge in the lower right corner of the thumbnail (image left, above). If it is an 
original, it will also have a badge with an ‘OG’ label (center). And, if the photo has been edited, you will also see the ‘+/-’ label (right).
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When viewing photos in Grid view, you can tell if a photo is synced from another device by the small Cloud 
Sync badge in the lower right portion of the thumbnail. If the photo in question is an original — as opposed 
to an editable preview — there will also be a badge with the initials ‘OG.’ These badges will be displayed on 
all published folders, devices and albums when you are working in Grid view.

ON1 CLOUD SYNC FILE FORMATS

With ON1 Photo RAW 2021, you have the option of publishing photos to the ON1 cloud in one of two 
formats, the original photo, or an editable preview, which uses a proprietary compressed-raw file format 
developed by ON1. This editable preview can be up to 75% smaller than the original raw file, while 
preserving the original’s tone and color fidelity. Using this option lets you keep more of your photos in the 
cloud, and, with either format, you can still edit a photo on one device, and your edits will be synced back 
to the originating computer, so that your original file is updated with those edits (and any other metadata 
changes you might have made).

As noted, the savings in storage space can be quite great. Use these basic guidelines for photo storage 
options:

• With a camera that creates 30MB raw files, you should be able to store more than 5,500 
raw originals in the cloud with a 200GB ON1 Cloud Sync service plan, and more than 27,000 
photos with the 1TB plan.

• If you are shooting JPGs with that same camera, we estimate that you would be able to store 
more than 20,000 JPG originals with the 200GB plan, and more than 100,000 photos on the 
1TB plan.

• If you chose to upload editable preview files instead of originals, you should be able to store 
more than 33,000 photos in the cloud with the 200GB plan, and more than 160,000 with the 
1TB storage plan.

Remember, while you can store photos in the ON1 Sync cloud using either format, and in any combination, 
your originals are always stored securely on the device that created or imported them. 

NOTE: Photos taken or imported with the ON1 Photo RAW for Mobile app are 
always uploaded in their original format. 

When to choose one sync format over another

In most cases, if you are working on two computers (a desktop and laptop, for example), working with 
editable previews should be more than sufficient for most workflow requirements. You can edit and update 
any metadata, including ratings, keywords and more, and work within all of the tabs in the Edit module. The 
fidelity and tonal range of the preview files is excellent, and all of your edits will be applied to the originals 
on the other device. 

You should sync folders and albums as originals when you want to work with an original photo on another 
computer. There are four primary reasons for this: you wish to create layered files; build HDR, panorama 
or focus-stacked composites; resize a photo with the Resize module; or you wish to print a photo at the 
highest-possible quality. 
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In these instances, if you have an original photo on another ON1 Cloud Sync device, you can download 
a copy of that original from the cloud to your current computer by right-clicking on the photo in Browse 
and choosing Download Original from the pop-up menu. If the original version is in the cloud, you will be 
prompted to save the copy in a location on your computer. 

Depending upon your intent, you can delete this copy later, or save it back to a published folder or album. 
For more information on these instances, see “Using Layers with Synced ON1 Cloud Files” on page 175, 
“Using Resize with ON1 Cloud Sync Files” on page 207, and “Printing photos from ON1 Cloud Sync 
devices” on page 184.

Managing sync options in Photo RAW

Photos published to ON1 Cloud Sync are managed in ON1 
Photo RAW 2021 at the folder or album level. What this 
means is that you can set up different folders or albums to 
sync as editable previews or originals, and you can change 
this option at any time by right-clicking on the folder or 
album and choosing the Sync Options item from the pop-
up menu. 

It is worth noting that you cannot change the sync option for individual photos: it can only be done at the 
album or folder level. You can however, selectively change the sync option for the subfolders in a cataloged 
folder.

BASIC CLOUD SYNC WORKFLOW WITHIN ON1 PHOTO RAW

As noted in the sections on cataloged folders (page 44) and 
albums (page 48), publishing photos from ON1 Photo RAW 2021 
is straightforward. When creating an album or cataloged folder, you 
have the option to publish and sync those photos as either originals 
or previews, or you can wait until a later time and publish them by 
selecting the item and choosing Publish to ON1 Cloud Sync from 
the pop-up menu. By default, when you publish via the pop-up, 
Photo RAW will upload editable previews to the cloud, but you can 
change this via the Sync Options menu item, as described in the 
previous section.

When you’re working with any photos that are based on a remote 
Cloud Sync device, regardless of whether it was created on a 
computer with Photo RAW or on a mobile device with ON1 Photo 
Mobile, you will be able to perform any changes to metadata, or make any edits in the Edit module, and 
those changes will be synced back to the original file on the original device. This doesn’t matter if the file in 
the cloud is an editable preview or an original.

Syncing presets and extras with Cloud Sync

You can also sync your Photo RAW presets and imported extras between your licensed computers 
with Cloud Sync. This option can be turned on or off via the Sync Presets checkbox in the Cloud Sync 
Preferences pane (see page 236).

You can publish (or unpublish) an album or cataloged folder at 
any time by right-clicking on the item name and choosing 
Publish/Unpublish to ON1 Cloud Sync from the menu.

To change the publishing status of an album or 
folder, right-click on the item and choose the 
appropriate format from the Sync Options pop-up 
menu.
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CLOUD SYNC, PHOTO RAW AND PHOTO RAW FOR MOBILE

On mobile devices, which includes both smartphones and tablets, the ON1 Photo RAW for Mobile app acts 
as a camera — with full raw-capture support — and an import device, which can add your photos 
immediately to ON1 Cloud Sync. ON1 Photo Mobile also has a subset of Photo RAW’s Edit module built 
into it. You can shoot photos with your phone, edit them using ON1 Photo Mobile, add them to existing 
Cloud Sync albums and they will automatically be shared to the cloud for viewing and editing. 

All of the photos shot and imported onto a mobile device with ON1 Photo RAW for Mobile are captured to 
a location on the device called Local Photos, which is what you see when you look at a mobile device in the 
ON1 Cloud Sync pane in ON1 Photo RAW 2021. (See “Viewing other ON1 Cloud Sync Devices in Browse” 
on page 72.)

There are four tabs in the ON1 Photo Mobile app:

• Local Photos, which displays the photos on that device;

• Cloud Sync, which displays your synced devices, and lets you drill down into them to view the 
photos on those devices;

• Albums, which displays synced ON1 Cloud Sync albums, and lets you create your own synced 
albums directly from your mobile device; and

• Camera, a full-featured, pro-level camera capable of capturing raw images and syncing them 
immediately to the ON1 cloud.

ON1 Photo Mobile uses the same RAW processing engine developed for ON1 Photo RAW, and has a 
nondestructive raw editor built into the app. The basic editing controls are similar to those found in 
the Develop tab of Photo RAW’s Edit module: there are adjustments for Exposure, Contrast, Shadows, 

The ON1 Photo Mobile app, available for both iOS and Android phones and tablets, is designed to share and edit your mobile photos, and access and edit 
photos on your other ON1 Cloud Sync devices. The app has four tabs, a Local Photos container (above left), which is where your photos from that mobile 
device reside; ON1 Cloud Sync (center left), which lets you access the photos from other shared devices; Albums (center right), which displays existing Cloud 
Sync albums (and lets you create new albums); and Camera (left), which is a full-featured smartphone camera capable of capturing raw photos.
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Midtones, Highlights, Whites, Blacks, White Balance, Noise, and Sharpening. The app also includes five 
filters from the Edit module’s Effects tab.

Viewing photos in ON1 Photo Mobile

You can view all of your photos — local or synced from the cloud — in ON1 Photo Mobile via standard 
gestures and taps. Tapping on an album, for example will display a grid of that album, and you can pinch 
two fingers together and apart to change the grid size. Tap on a photo to view it in Detail view, and pinch to 
zoom in. 

Photo Management and Editing with ON1 Photo Mobile

When you wish to share or edit a photo with 
ON1 Photo Mobile, tap on it from any Grid view 
screen. This will display the photo in Detail view 
with the photo’s name, and three icons at the 
bottom of the screen: one for sharing the photo, 
one for editing, and the other to delete the 
current photo (this only applies to photos that 
reside in that device’s Local Photos folder).

Sharing options include saving a copy of the 
photo to your camera roll, or to be shared via 
your device’s social media sharing options. The 
sharing window includes sizing options (medium, 
large, and full-size) for your exported photo.

Editing photos with the app is similar to editing 
photos in Photo RAW, although ON1 Photo 
Mobile doesn’t have all of the tools and filters 
found in the desktop app. ON1 is committed 
over time to bring the mobile app as close to 
parity with the desktop version as possible.

Tapping the Edit icon at the bottom center of the screen will display eight editing functions underneath the 
photo:

• Crop: resizes and levels your photo.

• Tone: for adjusting exposure, contrast, 
highlights, shadows, midtones, white 
and black points, and for adding structure or applying dehaze.

• Color: lets you adjust the color balance of the photo.

• AI Auto: performs an automatic tone adjustment on your photo using a proprietary ON1 
algorithm.

• Details: for applying sharpening and noise reduction.

• Presets: ON1 Photo Mobile includes a variety of presets in multiple categories, letting you 
achieve a great look with one click.

• Effects: lets you apply nine of Photo RAW’s Effects filters: Black & White, Color Adjustment, 
Curves, Dynamic Contrast, Film Grain, HDR Look, Glow, Split Tone, and Vignette.

When you’re viewing a photo in ON1 Photo Mobile, tapping the center icon at 
the bottom of the screen will take you into Editing mode.
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• Local Adjustments: In the same way that Photo RAW lets you apply targeted adjustments to 
portions of a photo, ON1 Photo Mobile has a Local Adjustments module, where you can fine 
tune portions of your photos, with the same masking tools found in the desktop app.

• Reset: The rightmost icon will reset all of your edits, returning your photo to its original state.

For more information about the various editing options available in ON1 Photo Mobile, and how they relate 
to the ON1 Photo RAW 2021 editing engine, see “Working in the Edit Module” on page 78. 

NOTE: ON1 updates Photo Mobile regularly, adding new effects and other 
features to the app. For an up-to-date list of features and enhancements, see 
the What’s New in Photo Mobile page on the ON1 website.

Mobile editing limitations with synced photos

While ON1 Cloud Sync and ON1 Photo Mobile have been designed to provide a seamless editing 
experience between desktop and mobile devices, there are two instances where you might run into an 
situation where you can view, but not edit a synced file inside ON1 Photo Mobile:

• When you’ve edited a synced ON1 Cloud photo with Photo RAW using any Effects filter that 
is not present in ON1 Photo Mobile.

• Any .onphoto file cannot be edited with ON1 Photo Mobile. This includes HDR, panorama 
and focus-stacked composites, as well as layered files.

Any photo synced with ON1 Cloud Sync that has not had editing adjustments made to it can be edited with 
any ON1 Photo RAW 2021 or ON1 Photo Mobile device, whether the photo in question is an original or 
an editable preview. And all ON1 Cloud Sync photos will be visible on all Cloud Sync devices, regardless of 
their originating format.
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ABOUT THE EDIT MODULE
ON1 Photo RAW 2021’s photo-editing power is found in the Edit module, which consists of four distinct 
editing functions, separated into tabs:

• Develop is where you perform basic, global editing operations—adjusting tone and color, 
removing noise, sharpening and more. It is the perfect place to begin editing your photos, 
especially if you are using Photo RAW as a standalone editor. (See page 122.)

• Effects is the stylization center of Photo RAW, with 31 filters—offering such operations as 
black and white conversion, HDR stylizing, glows, color enhancement and more— that can be 
stacked in any order, all with extensive blending and masking options. (See page 131.) 

• Portrait AI uses machine-learning algorithms to automatically find and retouch all the faces in 
a photo, apply smoothing, reduce blemishes, and brighten eyes and teeth. (See page 155.)

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease. You can 
also add custom-brush overlays to an image via the Local Adjustments tab. (See page 162.)

Switching between the different tabs in the Edit module is as simple as clicking on the appropriate tab. 
While you work on an image, all of your settings in each tab are saved while you edit. If you use Photo 
RAW as your editor of choice (in conjunction with Browse), all edits you make to an image are preserved 
non-destructively, and you can go back to any image at any time and make changes or corrections to it

Photo RAW 2021’s Edit module also includes a Layers pane, which lets you stack multiple images together 
to achieve sophisticated composites that aren’t available in many standalone photo editors. And, because 
the Edit module is entirely non-destructive when you use Photo RAW as a standalone app, you can re-edit 
your compositions without worry. (See “Working with Layers” on page 168 for more.)

When using Photo RAW as a plug-in from Lightroom Classic, Affinity Photo, Corel PaintShop Pro 
or Photoshop Elements, you can still move from tab to tab in the Edit module (and use the Layers 
functionality), but your photos will not be re-editable once you leave Photo RAW. If you’re using ON1 as a 
plug-in with Photoshop Smart Objects (page 10) or with Apple Photos (page 10), your work will be re-
editable, as long as you don’t add additional layers.

To help you save time and create the looks that you love best, ON1 Photo RAW 2021 also includes a robust 
preset system that lets you save settings made in any of the editing tabs—including local adjustments and 
masks—for applying to other photos. Editing presets can be applied in the Edit module, and in Browse, and, 
like all other elements of Photo RAW 2021, are re-editable. (Presets are discussed in detail on page 105.)

In addition to presets, you can copy and paste Edit module settings from one file to another, or synchronize 
the edits on one photo to a group of photos. These operations can all be performed in any of the editing 
modules, as well as in Browse, adding to ON1 Photo RAW 2021’s extreme flexibility. (See “Copying settings 
and synchronizing edits” on page 115 and “Applying Edit Module Presets in Browse” on page 66.)

If you are using the ON1 Cloud Sync service, your synced photos are editable in ON1 Photo RAW, 
regardless of which sync storage format you choose. All of your edits will be synced back with the photos 
on their originating device, and will be fully re-editable in Photo RAW. The primary exception to this is 
when you are using Layers, which necessitates the creation of a new, .onphoto file, and which must be 
stored on the device that created the layered file. See “Using Layers with Synced ON1 Cloud Files” on page 
175 for a more detailed description of the workflow for Layers and ON1 Cloud Sync.
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ON1 Edit Main Screen Overview
Edit provides you with an easy-to-use work space for editing your photos. Below is an overview of the main 
window sections of the Edit module:

A.	Tool well: Tools for working within the Edit module.

B.	 ON1 Cloud Sync Status/Preferences/Help: Shortcuts to ON1 Cloud Sync status, preferences 
and help.

C.	 Preset panel: List of all installed presets (by category). When working in the Effects tab, a 
Filters panel is visible as well. 

D.	Search: Searches presets (and filters, when working in Effects) by name.

E.	 Window options: (from left to right) Open/close the Presets panel; toggle Dual Display Mode 
on/off; switch between Detail and Filmstrip views (Filmstrip shown).

F.	 Preview Window: Displays the current photo in detail view.

G.	Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask, turn soft proofing and preview on or off.

H.	Tool Options bar: Options and settings for currently selected tool.

I.	 Photo Information pane: Navigator, Levels (histogram), general photo information, History.

J.	 Layers pane: Add, edit and manage layers here.

K.	 Edit tabs: Tabs for accessing the Develop, Effects, Portrait, Local Adjustments. Clicking on 
each tab brings up the settings for that tab.
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L.	 Reset bar: Reset all (all Edit module settings), Reset (resets the current tab’s settings), Sync 
settings with previously edited photo (when in Filmstrip view)

M.	Module selector: Switches between Browse and Edit modules (if you are editing a photo as a 
plug-in, the Browse icon will be disabled).

N.	Output: Shortcuts for switching to the Resize module (disabled when accessing Photo RAW  
as a plug-in), as well as for printing, exporting and sharing the current photo.

The look of the Edit module in ON1 Photo RAW 2021 is similar to that of Browse, with slight variations that 
are specific to photo-editing tasks. The left side of the window contains a tool well with Edit-specific tools, 
and a Presets pane (when using the Effects tab, you will also see a Filters tab alongside Presets).

The right side of the screen contains the same panes at the top—Navigator, Levels/Histogram and Info—as 
well as a History pane, the Layers panel, and tabs for the four editing areas inside Edit: Develop, Effects, 
Portrait and Local. Clicking on a tab will bring up the options and settings for that area. When viewing 
images, you can work in either Detail or Filmstrip view, both of which work the same as they do in Browse 
(See “Working in the Preview Area” on page 54 for more).  

Photo RAW provides several ways to navigate and view your image in the Edit module’s Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Levels, Info and History Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info and 
History panes. These tools can be useful for inspecting and viewing details of your image, as well as for 
looking at all of the Edit module adjustments made during a session.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white 
square region marks the image area that is visible in the 
preview pane. You can pan your image by clicking and 
dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 50% 
and 25%). Click on one of the buttons to change the view. Fit 
zooms to fit the current canvas size, while 100 zooms to 100%, displaying the actual pixels.
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THE LEVELS PANE

This gives you a color chart of the shadow, midtone and 
highlight areas based on the image RGB values (commonly 
known as a histogram). This is useful to show areas within 
the image that may be clipping. Clipping is when your 
image contains pure blacks or white and can signify loss of 
highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of each 
end is a triangle. If the triangle is lit, there is clipping on that 
side of the histogram. If you click on the arrows, you will activate the clipping overlay on your image, which 
displays the areas that are clipped. Those areas with a blue overlay are pure black, while the areas with the 
red overlay are pure white. You can turn the clipping view off again by clicking on one of the triangles. You 
can also temporarily enable clipping view by holding down the J key at any time. The clipping view is useful 
when you are making adjusts to the brightness and contrast of your image. (See “Focus and Clipping views” 
on page 36, for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in an 
easy-to-read format. This metadata includes camera make 
and model; lens focal length; capture date and time; file 
type; ISO setting; shutter speed; aperture; and exposure 
compensation.

The Info pane also displays file-specific data, including image 
dimensions and resolution. If any of the metadata fields are 
unavailable they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all of 
the operations from the Edit module that have been applied 
to the current image. Clicking on the right arrow to the left 
of the label will display a list of every tab in the Edit module, 
as well as primary adjustment options, including cropping, 
retouching and text operations. If an image has had any adjustments made to it, that section of the Settings 
Applied area will be represented in white type, and you can use the arrows to the left of the label to drill 
down further into the Develop, Effects, Portrait, and Local Adjustment tabs to see which adjustments were 
made to an image. (On an image that has had no adjustments, all of the settings will be grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside the Edit module, where you can make any desired changes.
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THE HISTORY PANE

ON1 Photo RAW 2021 has a robust Undo capability, 
which is helpful when you wish to back up a few steps 
during the editing process. When you want to go back 
further, it can be tedious to keep pressing Command/
Control-Z. That’s where the history pane can be 
extremely useful. It displays every adjustment made 
during an editing session. From the History pane, you 
can scroll through your edits, all the way back to the 
state of your photo when you opened it for editing.

As you work, the History pane tracks all of your 
edits—even when working with layered files—adding each change you make to the top of the pane. History 
displays not only the adjustment, but in many cases will display the settings of sliders in the various panes 
and filters. 

You can scroll through the list, and, if you click on an item, Photo RAW will “roll back” your edits to the spot 
you clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire 
Edit history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that 
point on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo. If you go back to Browse, open another image for 
editing from the Filmstrip, or switch to Resize, the History pane resets. 

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.
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The Tool Well
The Edit module has 17 tools available for you when you are working on a photo, and are accessible via 
the Tool well on the left side of the screen. Some tools—Transform, Crop, Text, Faces, and View—are self-
contained within the tool icons. Others are nested within a tool group—Local, Mask, Refine, and Retouch—
and are accessible via the Tool Options bar at the top of the screen when you click on one of those tool 
icons:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Transform (Move) Tool: Moves and changes the size and rotation of your layer. 
Shortcut key: V

• Text Tool: Adds text blocks to your document. Shortcut key: T

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Shift+K

• Faces (Portrait) Tool: Finds faces in the current image, and opens the Portrait 
tab, where you can paint skin in or out to fine-tune each face’s mask. Shortcut key: 
Shift-I

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect 
Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any filter 
(or to the entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Create high-quality masks with only a few 
strokes as guidance. Shortcut key: W

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help 
mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-H

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more 
naturally. Shortcut key: L

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines.  
Shortcut key: Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. 
(Includes Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another 
area. Shortcut key: Shift-S

• Healing Brush (Retouch group): Paint over a distraction and a matching area of your photo is 
magically blended on top to replace it. Shortcut key: Q 

• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

For nested tool groups, the icon of the currently selected tool will be visible in the Tool Well. 
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To access a tool, simply click on the tool, or use the shortcut key attached to the tool. When selected, the 
cursor will change, and you will see a set of options for the tool in the Tool Options bar above the Preview 
window. If the selected tool is part of a tool group, you will see the other tools in that group, on the left 
side of the Tool Options bar.

CROP TOOL

This tool lets you crop your image, 
and is fully non-destructive in 
the Edit module when you are 
using ON1 Photo RAW 2021 as a 

standalone app.

To crop an image, select the Crop tool from the 
Tool Well. Select any preset crop ratio you would 
like to use from the Options bar; the default is 
Freeform, which lets you crop in whatever size or 
ratio you would like. Adjust the corner handles 
of the crop tool overlay to get the area you wish. 
(The area outside the crop box appears darkened 
for guidance.) You can resize and move the image 
inside the crop box. When you are satisfied with 
your settings, press the Apply button in the 
Options bar or press Enter.

To move the image inside the crop box, simply 
click and drag inside the box. You can also nudge 
the image using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the 
handles. Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side 
handle allows you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s 
proportions are maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

Crop Tool Options Bar:

• Preset pop-up: Lets you choose from Freeform or constrained preset ratios

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop 
box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that 
should be level.

• Angle: See and adjust the angle of rotation.

The Crop interface, with the Crop Preset pop-up open.

Crop preset ratios.
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• Reset: Resets the crop area to the size of your original photo.

• Apply: Applies the crop.

NOTE: The Crop tool is disabled when you use Photo RAW as a plug-in; you 
should use the host application to crop your photos. Also, when used inside 
Resize, the Crop tool is destructive. (See page 185 for specifics the Crop tool 
inside the Resize module.)

TRANSFORM (MOVE) TOOL

The Transform tool is used to manipulate the contents of a layer, and works even if the 
only layer you have is the base photo layer. A layer may be repositioned, sized or rotated 
using the Transform Tool. When the tool is selected, handles will appear on the edges of 
the selected layer. You use these handles to manipulate the image. When you are done, 

click the Apply button in the Tool Options bar.

The Transform tool is layer-dependent, and each document layer can have its own transform operations. 
It is useful when compositing photos, or applying backgrounds and textures in a multi-layered file. The 
Transform tool is disabled when using Photo RAW as a plug-in.

Repositioning a layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

Resizing a layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

Flipping a layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.
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When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a layer after a move

The Reset All command inside the Edit module will not reset transforms made with the Move tool. To reset 
your layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 

Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.

• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 

TEXT TOOL

The Text tool lets you add blocks of text to your photo or composite, for everything from 
simple watermarks to more complicated text-based layouts. Within each block you have 
complete control over the font, type size, line spacing, letter spacing, color and alignment of 
the text. You can 

also add a background fill color 
and can set the opacity of each 
text block and background.

To add a text block, click the Text 
tool, and then the Add button 
in the Tool Options bar. A new 
text block will be added, with 
placeholder text selected. You can 
start typing, or first choose the 
font, sizing and other options you 
wish to use in that block. To add 
another text block, click the Add 
button again.

To edit an existing text block, 
choose the Text tool, and double-
click in the block you wish to edit, then make your changes. If you would like to remove an existing block, 
click on the block with the Text tool and choose Delete from the Options bar.

The Text tool lets you add multiple text blocks to a document, with full character-level control of 
font, size and styles. 
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Photo RAW will remember the last settings you used, which can be helpful if you like to use a specific font 
and size—in text for a watermark, for example.

The Text tool also lets you add metadata 
from the current photo into a text block. 
To do this, create a text block and right-
click inside the block. The Text from 
Metadata submenu contains a list of 
embeddable metadata items. You can 
add multiple items from the list, style 
them, and even add items to different 
text blocks. When you’re done adding 
metadata, click outside the block to see 
the final text (right).

Text Tool Options Bar

• Font pop-up: Displays a list of available fonts on your system. 

• Size pop-up: Sets the font size for the block (or selected text).

• Color: Selects a color for the selected text or block.

• Style: Applies Bold, Italic or Underline styling to the selected text or 
block.

• Alignment: Set the selected text to align left, or center.

• Text Options: Additional options for the text block, including line 
and character spacing, color fill for the background, and separate 
opacity controls for both the text and the background (right).

• Delete: Deletes the currently selected text block.

• Add: Adds a new text block.

NOTE: The Text tool can be used to add text-based watermarks to a photo, 
but Photo RAW’s Export feature also lets you apply a graphic watermark to 
exported photos. See “Export” on page 201 for more information. 

ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which is used within the Local Adjustments tab, works like a 
standard masking brush tool, with adjustable sizes, feathering and opacity. You can paint an 
adjustment in or out via the Mode pop-up in the Tool Options bar, and adjust the size and 
feathering of the brush via the bar or with the bracket keys on your keyboard. The 

The Text Options pop-up includes 
spacing option, and settings for 
the background color and opacity 
of the text box.
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Adjustment Brush is especially powerful when used with the Perfect Brush option, represented by its icon 
at the right of the Tool Options bar.

The Perfect Brush incorporates a color-based, self-masking technology to help create precise 
selections and masks. When you turn the Perfect Brush option on, the Adjustment Brush 
collects the colors under the center of the brush and applies the effect only to those colors. 
This protects the adjustment from being applied across edges. A great of example of using 
the Perfect Brush would be if you wanted to darken the sky in an image, but didn’t want to 
darken a group of mountains on the horizon.

TIP: You can turn the Perfect Brush on and off using the Command-R keyboard 
shortcut (Control-R on Windows). You can also temporarily lock the color to 
remove by holding down the Control key (Windows) or the Command key 
(Mac). This is useful when brushing through areas with a lot of openings like 
tree branches.

Photo RAW lets you mask with custom brush shapes when you are using either the Adjustment Brush or 
the Masking Brush. When you use a custom brush on an adjustment layer, in conjunction with that layer’s 
Paint with Color option, you can add overlays and other embellishments. When used with custom brushes, 
the Manual Spacing option lets you control the distribution of the strokes as you brush. (See “Masking 
Basics” on page 105 for more detailed information about masking brush techniques with any of the 
masking tools.

Adjustment Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several other ways:

• The left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Your mouse’s scroll wheel (this can be set in the General Preferences; see page 231).

• Your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 

Perfect 
brush icon.
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in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys.

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. You can control the opacity in two other ways:

• Press Option (Mac) or Alt (Windows) key on your keyboard and one of the number 
keys. Each number represents an opacity percentage from 10% (1) to 100% (0).

• Use your Wacom pressure-sensitive tablet.

TIP: Opacity is really the shade of gray being painted onto the mask. White 
represents 100% of an effect showing and black represents no effect showing.

• Flow: Flow is the rate at which the brush color is applied, up to the Opacity setting. With a 
low flow number, as you brush back and forth across a stroke, the brush color will build up to 
the Opacity setting. At a flow of 100, the brush stroke color will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection technology to 
help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Options bar—the Masking Brush 
collects the colors under the center of the brush and applies the 
effect only to those colors. This protects the adjustment from 
being applied across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the 
brush tip as you apply a stroke. This is primarily used when painting with custom brushes. See 
“Using Custom Brushes to Add Overlays” on page 165 for more. 

• Pressure options: Photo RAW supports pressure-sensitive tablets from Wacom with the 
Masking Brush. You can enable pressure sensitive controls for the brush size, brush opacity, 

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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or both simultaneously. To turn this support on, click on the gear icon in the Tool Options 
bar. You can activate pressure sensitivity for both size and opacity by clicking the appropriate 
buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Photo RAW 2021 starts on page 162. There is 
also a short section, “Masking Basics” on page 105, that includes best practices for using the different 
masking tools in Photo RAW.

NOTE: The Adjustment Brush can also be used to apply custom brushes to an 
adjustment layer. See “Using Custom Brushes to Add Overlays” on page 165.

ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool is very similar to the Masking Bug (see page 96), but it is 
solely for use within the Local Adjustments tab. It lets you create a linear or radial gradient 
mask across part of your image, The gradient mask goes from dark to light in tone, applying 
more of the adjustment where the gradient is lighter, and less of the adjustment where the 

gradient’s tone is dark. The most common use of gradient masks is to darken the sky in an image, while 
preserving the brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes six settings for the Adjustable Gradient tool (top down, 
bottom up, left and right, and circular vignettes), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum opacity or density of the 
mask.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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• Color Range: When enabled, this detects the color under the gradient and applies the mask 
to only that color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating gradient masks

Once you’ve added a gradient to an image, you can modify it by 
accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the 
gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag 
along the dashed line.

• To rotate the mask, click the smaller circle near the gradient 
center and drag.

Detailed information on using Local Adjustments in ON1 Photo RAW 
2021 starts on page 162.

PORTRAIT (FACES) TOOL

Clicking on the Faces icon will open the Portrait tab, and 
search the photo for faces. Any faces it finds will be added to the tab as separate panes. 
When a face is selected, the tool works in a manner similar to the Masking Brush; it is 
designed to paint the face’s mask—the skin, in case of Portrait—in or out. More information 

on using Portrait starts on page 155.

Portrait Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush 
at high magnification for precise work, and a large brush at fit to screen for general work. In 

The Edges gradient shape lets you create 
such masking effects as customized, 
adjustable vignettes.
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addition to the Size control, you can change the size of the brush several ways:

• The left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Your mouse’s scroll wheel, which can be set in Preferences’ General tab (page 231).

• Your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys.

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. You can also control the size of the brush in other ways:

• Press Option (Mac) or Alt (Windows) key on your keyboard and one of the number 
keys. Each number represents an opacity percentage from 10% (1) to 100% (0).

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. 

• Flow: This is the rate at which the brush color is applied, up to the Opacity setting. With a 
low flow number, as you brush back and forth across a stroke, the brush color will build up to 
the Opacity setting. At a flow of 100, the brush stroke color will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, 
this setting has no effect; it is more useful when working with 
custom brush shapes. You can also rotate the brush shape by 
pressing Shift-Option (Mac) or Shift-Control (Windows) and the 
left or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic 
edge-detection technology to help create precise selections and 
masks. When you turn the option on—by clicking on the Perfect 
Brush icon in the Options bar—the Masking Brush collects the 
colors under the center of the brush and applies the effect only 
to those colors. This protects the adjustment from being applied 
across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. :

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the brush tip as you apply a stroke. 
This is primarily used when painting with custom brushes. See “Using Custom Brushes to Add 
Overlays” on page 165 for more. 

• Pressure options: Photo RAW supports pressure-sensitive tablets from Wacom with the 
Masking Brush. You can enable pressure sensitive controls for the brush size, brush opacity, 
or both simultaneously. To turn this support on, click on the gear icon in the Tool Options 
bar. You can activate pressure sensitivity for both size and opacity by clicking the appropriate 
buttons in the drop-down menu.

Detailed information on using Portrait AI in ON1 Photo RAW 2021 starts on page 155. There is also a 
short section, “Masking Basics” on page 105, that includes best practices for using the different masking 
tools in Photo RAW.

MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects, as well as for 
creating masks in Layers. When you select the Masking Brush, your cursor changes to look 
like two concentric circles, one representing the inner hard edge of the brush, the other, the 
soft outer, feathered edge of the brush. At the center of the brush is either a plus or minus. 
The plus means that you are painting “in” a filter’s effect, while minus means the brush 

mode is set to paint out. As is the case with the other masking brushes, you can use Photo RAW’s Perfect 
Brush to help create fine selections.

Masking Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

TIP: If you would like to invert the mask (turn it from black to white), in order 
to paint a filter’s effect into your image, select the Masking Brush tool, then 
choose Invert Mask from the Mask menu.
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• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• The Size pop-up in the Tool Options bar.

• The left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Your mouse’s scroll wheel, which can be set in Preferences’ General tab (page 231).

• Your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys.

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. Other ways you can adjust the opacity include:

• Press Option (Mac) or Alt (Windows) key on your keyboard and one of the number 
keys. Each number represents an opacity percentage from 10% (1) to 100% (0).

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
White in a mask represents 100% of an effect and black (0%) represents no 
effect, and opacity settings in between will show a percentage of the effect. 
This is useful when blending masks in a realistic manner.

• Flow: Flow is the rate at which the brush is applied, up to the Opacity setting. With a low 
flow number, as you brush back and forth across a stroke, the brush color will build up to the 
Opacity setting. At a flow of 100, the brush stroke will be 
applied at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the 
default, round brush shape, this setting has no effect; it is more 
useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-
Control (Windows) and the left or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic 
edge-detection technology to help create precise selections and 
masks. When you turn the option on—by clicking on the Perfect 
Brush icon in the Options bar—the Masking Brush collects the 
colors under the center of the brush and applies the effect only 
to those colors. This protects the adjustment from being applied 
across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
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on the gear icon in the Tool Options bar:

• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the brush tip as you apply a stroke. 
This is primarily used when painting with custom brushes. See “Using Custom Brushes to Add 
Overlays” on page 165 for more. 

• Pressure options: Photo RAW supports pressure-sensitive tablets from Wacom with the 
Masking Brush. You can enable pressure sensitive controls for the brush size, brush opacity, 
or both simultaneously. To turn this support on, click on the gear icon in the Tool Options 
bar. You can activate pressure sensitivity for both size and opacity by clicking the appropriate 
buttons in the drop-down menu.

Detailed information on using the Masking Brush in Effects starts on page 94, while information about 
Layers starts on page 168. There is also a short section, “Masking Basics” on page 105, that includes 
best practices for using the different masking tools in Photo RAW.

TIP: You can turn the Perfect Brush on and off using the Command–R (MacOS) 
or Control-R (Windows) keyboard shortcut. You can also temporarily lock the 
color to remove by holding down Command (Mac) or Control (Windows)

MASKING BUG (MASK GROUP)

The Masking Bug is used for blending masks and layers by creating radial, gradient and 
reflected gradient mask shapes. It works in a similar manner to the Adjustable Gradient tool 
in the Local Adjustments pane. The mask goes from dark to light in tone, applying more of 
the adjustment where the gradient is lighter, and less of the adjustment where the 

gradient’s tone is dark. The most common use of 
gradient masks is to darken the sky in an image, 
while preserving the brightness of the 
foreground, similar to using a gradient filter on 
your camera lens, or to adjust the effect of a 
filter mask in Effects.

To apply a standard gradient to a filter in 
Effects, click on the Masking Bug in the Tool 
well, then click in the image roughly where you 
wish the gradient to go. You’ll see the outline of 
the gradient, which is called a bug. You can use 
the handles on the bug to move your gradient In this image, a Dynamic Contrast filter has been applied in Effects. To keep the 

effect out of the clouds, a Masking Bug has been added.
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around, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Masking Bug Tool Options

• Preset: The preset pop-up includes six settings for the bug’s mask (vignette, strong vignette, 
top down, bottom up, and linear left and right), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum opacity or density of the 
mask.

• Color Range: When enabled, this detects the color under the gradient and applies the mask 
to only that color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a gradient mask

Once you’ve added a gradient to an image, you can modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at 
the center of the gradient and drag.

• To resize a radial gradient, click and drag on the 
solid line.

• To adjust the feather (or hardness) of the mask, 
click and drag along the dashed line.

• To rotate the mask, click on the smaller circle 
near the center of the gradient and drag.

Working with multiple masking bugs

You can have up to six masking bugs per layer. Each bug is re-editable when you’re using Photo RAW as a 
standalone app, or when you use Smart Filters option from within Photoshop (see “Using ON1 Photo RAW 
2020 with Adobe Photoshop” on page 11 for more).

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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To add another masking bug, press the Add button or click outside of the current bug while the Masking 
Bug tool is selected.

Only one masking bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

Masking bugs are subtractive. Each bug hides more and more of the current layer. When masking bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the masking bugs.

AI QUICK MASK TOOL (MASK GROUP)

Powered by machine learning, the AI Quick Mask 
tool creates high-quality masks with just a few 
strokes. To use it, you paint areas you want to 
keep in green and areas you want to drop in red. 

Then, using its artificial intelligence, Photo RAW analyses the color, 
tone and texture of the marked regions to learn what you want to 
make out and then automatically finds the edges and creates the 
mask for you. Use it with layers to replace skies or with filters to 
selectively apply them quickly. 

You can use this tool on a filter in Effects or on a layer. If you wish to use it on a filter, to mask some of the 
filter’s effects out of your photo, first add the filter in the Effects tab, and select the AI Quick Mask Tool. To 
use it on a layer, make sure that the only thing selected is that layer. In both cases, you’ll follow these steps:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 

When you first use the AI Quick Mask tool, Photo 
RAW will display a ‘HUD’ that explains what you 
need to do to use the tool.
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Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

2.	 Now press the Apply button in either the Tool Options bar or the AI Quick Mask HUD. This 
will generate a temporary mask to preview the results. Areas that are filled with red will be 
masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the AI 
Quick Mask HUD. If there are areas that are incorrect, you can continue to improve the 
results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 
Photo RAW switches to the Refine Mask tool.

Once you click on the Done button, Photo RAW will create the finished mask (shown here as a red overlay), applied to the 
current filter. You can refine the mask further with any of the refine mask tools.
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AI Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Effects, these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the AI 
Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is a plus, 
you are painting keep (green) areas. You can change the mode in the Tool Options bar, or by 
pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

• Use the Size pop-up in the Tool Options bar. 

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ . 

• Use your mouse’s scroll wheel (this option can be set in Photo RAW’s Preferences). 

• Use your Wacom pressure-sensitive tablet. 

Further settings for the AI Quick Mask tool can be found by clicking on the gear icon in the Tool Options 
bar. There, you can set the following options (shown right): 

• Pressure Adjusts Size: This option lets you control 
the size of the brush using a pressure sensitive tablet. 
The harder you press, the larger the brush becomes 
up to the current setting of the size slider.  

• Refine Edge: This applies the Refine Mask Brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This is on by 
default and is recommended for most photos.

• Show HUD: This displays the AI Quick Mask HUD 
dialog (shown on page 98), which provides guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green mask overlays on top of your image. A 
setting of 100 displays only the mask; the default setting is 50.

REFINE BRUSH (REFINE GROUP)

This tool cleans up intricate areas and the borders along a mask, and is helpful for cleaning 
up a mask created with the Masking Brush. For example, when you wish to apply an effect 
to a subject, and there are areas such as hair, or tree branches that are difficult to remove 
with the Masking Brush.

To use the Refine Brush, select the tool in the Options bar and paint along the edges where you would like 
the mask to be refined. The brush strokes are displayed as a red overlay, and when you let up off the mouse 
button, Photo RAW will work to make making the mask edge more defined, improving the overall mask.
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Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which refines to remove from the 
mask, Paint In, which refines to add to the mask, or Auto, which does both at the same time. 
Paint Out is recommended in most cases.

• Size: This adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.

• Pressure Adjusts Size (gear icon): If you have a Wacom tablet you can control the size of the 
brush with pressure when this setting is turned on.

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or 
halos along the hard edges of a mask; just click and drag along the edges of a mask you 
wish to refine. Fringes are common when the background to be removed is brighter than 
the foreground. The chisel works like a chisel or plane in a wood shop: It removes just a 

sliver along the edges, and, because it only works on the edges, you don’t have to be too careful when 
using it.

Chisel Mask Tool Options

• Mode: Select remove or add

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool icon to apply the chisel to the entire mask.

BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the 
tool over the edges you wish to blur. Softening the edges on blurred or semi-transparent 
subjects like hair can make them blend with a new background in a more realistic manner. 
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Blur Mask Tool Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur tool icon applies the blur to the entire mask.

HEALING BRUSH (RETOUCH GROUP)

The Healing Brush is a tool for 
removing distractions like dust 
spots, power lines and unwanted 
people from your photos, using 

sophisticated content-aware fill technology. 
Like the other retouching tools, you can 
apply the brush to multiple portions of an 
image. Unlike the other tools, however, the 
Healing Brush is fully nondestructive: each 
area you apply the brush to is individually 
editable (and removable).

To use the brush, paint over a distraction 
and a matching area of your photo will be 
blended on top to replace it, using content-
aware technology. You’ll see two circular 
markers: red, which is the area that has been 
removed, and green, which is the area that was used to fill the source. Each marker is movable by clicking 
and dragging; sometimes, you’ll want to try a different area to match to your source. Non-active markers 
will be displayed as gray squares until you click on them. (Press the Delete key to remove the current area.)

The Healing Brush has two modes: Heal and Stamp. When you use the brush in Heal mode to remove a 
distraction it applies content-aware matching from a nearby area to mask the object or area painted out.  
When you use the brush in Stamp mode, it acts like the Clone Stamp, applying the actual pixels from the 
area used to mask the object out; unlike that tool, however, this option is nondestructive.

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a 
specific marker will display the source and area used to fill the source. You can then 
readjust its placement, or delete the area.
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• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: selects either Heal (content-aware) or Clone (pixel-exact) mode when brushing an 
area. 

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.

PERFECT ERASER (RETOUCH GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. It uses a 
content-aware algorithm that replaces the pixels with a natural-looking result within the boundaries that 
are painted.

Using the tool is easy: paint over the area you wish to remove, making sure you cover the entire area. A 
red overlay appears where you paint. If the first attempt does not give you a perfect result, paint over it 
again and it will improve with each pass. You can also fine tune the area after applying the tool by using the 
Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of two options; brush size, and Wacom tablet support The 
default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking on 
the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. The 
maximum brush size is 500 pixels. If you have a Wacom pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

RETOUCH BRUSH (RETOUCH GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.
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• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the Wacom sensitivity controls.

CLONE STAMP (RETOUCH GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.

VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in the Edit module, 
adjusts the magnification of the image in the Preview window. With the Zoom tool selected, 
click in the Preview window to zoom in and center the image at the location clicked. Hold 
down the Option/Alt key to display the Hand tool, which lets you pan around the magnified 

image. You can also double-click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) 
magnification view, which shows every pixel. This is best when examining small details.
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Masking Basics
One of Photo RAW’s most powerful features is its masking 
capabilities. Every filter in Effects, every adjustment panel in the 
Local tab, and every layer can have a mask associated with it. And, 
when you’re retouching a face in Portrait AI, that face has had a 
mask automatically generated for it.

At its simplest level, a mask shows or hides the effect of the 
filter or adjustment. Masks have no color: they are grayscale, and 
the tones range from pure white to pure black. A mask that is 
completely white displays the entirety of the effect being used, a 
mask that is completely black hides that effect. (A common way 
to remember it is via the phrase “black conceals, white reveals.”) 
Shades of gray are in effect the opacity of the mask. Darker shades 
reduce the effect, lighter shades let more of it through.

The beauty of the masks is that you can paint with black, white or 
any shade in between, so you can “mask” portions of your photo so 
that they will not have that effect—or will have a reduced effect. 
You can also copy masks from one filter and past them into other 
filters. Using this feature, you can mask out the sky in one filter, 
copy the mask, paste it into another filter and invert it, applying a 
different effect to everything but the sky. Photo RAW even lets 
you create luminosity masks, which are masks that are solely based 
on the brightness of the pixels in the image. You can view your masks, either as a red overlay or as the 
grayscale version of the actual mask, which can be helpful when you wish to look at the edges of mask.

Creating masks can be as simple as dropping a gradient on a photo, or as complex as using multiple tools 
and masking functions. For instance, you can drop a gradient on a photo, use the Masking Brush to paint in 
places where don’t want the gradient applied, or you can use the Color Range tools to select portions of an 
image based on color. 

THE MASKING TOOLS AND VIEW OPTIONS

Inside ON1 Photo RAW 2021, there are three basic tools used to create masks: the Masking Brush, the 
Masking Bug, and the AI Quick Mask tool. There are variants of the first two that are specific to Local 
Adjustments (Adjustable Brush and Adjustable Gradient), while the Portrait AI brush is a version of the 
Masking Brush specifically for use in retouching portraits.

You can use the gradient and masking brush tools cumulatively, meaning that you can add to or subtract 
from the current mask. However, if you select the AI Quick Mask tool, it will replace any existing masks on 
that pane or layer.

The Refine group of tools—Blur, Chisel and Refine—are designed to help work with edges and halos that can 
crop up when you have areas of strong contrast between a masked area and an unmasked one.

In addition to the masking tools, each mask has a set of controls you can use to manipulate the mask to 
refine it further. 

Three views of a mask, here shown attached to a 
Glow filter in Effects. When you first add a filter (or 
a layer), the mask is empty (top). If you click on the 
empty mask, Photo RAW will automatically 
generate the mask, here shown filled with white, 
which means all of the effect will come through 
(middle). When you use any of the masking tools, 
the areas masked out (partially or completely), will 
be shown in the filter’s mask view (bottom). You 
can use the View Mask options to show the current 
mask as an overlay or in grayscale to give you a 
much more accurate display of the mask with your 
photo.
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When you add a filter or a layer, the mask is technically hidden. You can create a mask by either using one 
of the masking tools, or by clicking the Show/Hide Mask icon in the title bar of the pane, to the right of the 
filter name. The contents of the Show Mask icon will represent the mask on that layer. (Local Adjustment 
panes automatically create a black layer mask, so you can ‘paint in’ the adjustment to the image.)

Photo RAW has two primary options for viewing the contents of a mask: either as a red overlay on top of 
your image (the default) or a view only of the mask itself, represented as grayscale. The grayscale view can 
be helpful when checking edges, or when refining some of the advanced masking controls. These mask 
view options are available from the Mask menu; select Show Mask to see the mask, while the View Mode 
option lets you switch between the two modes. You can also set the app to display the red overlay when 
you are brushing with the Masking Brush and its cousins. (Photo RAW will remember the previous settings.)

Here is a local adjustment—using the Adjustable Gradient tool—that has been applied to a photo to darken the sky. The Show 
Mask option has been turned on, so you can see where the effect has been masked out (shown in red). The gradient mask is 
softer at the top of the gradient, and entirely opaque at the bottom of the gradient. These smooth transitions can create a 
better look for your photos.

The two Mask View options help in different ways. The Red Overlay option (above left) can give you an idea of what portions of your photo are successfully 
masked in or out. The Grayscale option (above right) lets you view the mask solely as luminance values, where pure black indicates portions that have been masked 
out completely, pure white is where the effect is applied completely, and the levels of gray indicate partial application of the effect. The Grayscale option is 
especially useful when you wish to check the edges along a mask border.
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When you’re viewing a mask in either overlay or grayscale modes, you have access to all of the tools in the 
Edit module. You can zoom in, to view the mask in greater detail, you can use the Refine masking tools to 
adjust the fine edges of your mask, or you can use any of the other the masking options described below.

MASKING CONTROL OPTIONS

When you click on the Mask icon at the top of a pane or in a layer, Photo RAW will display a set of options 
for that mask. This section has the following contents, as shown, using the Color Enhancer filter as an 
example:

A.	The Show/Hide Mask icon, which displays 
the contents of the current mask. The 
default mask contents are white when you 
add an effect, and black when you add a 
local adjustment layer.

B.	 Buttons for opening the blending options, 
resetting the filter, and removing the filter 
from the stack.

C.	 Sets the overall opacity of the effect.

D.	Larger display of the current mask, option 
to invert, reset, copy, paste, create a 
luminosity mask, and view/hide the mask.

E.	 Density adjusts the overall mask density 
from black (100) to white (0). Feather blurs 
the mask.

F.	 The Levels and Window settings let you 
adjust the black and white points of the 
mask, fine tuning them in different ways.

G.	The Color Range option lets you choose a color (selected via the dropper tool), and make or 
tune the mask based on the range of the color selected.

The buttons at the top portion of the Mask Options can be quite helpful, especially when you’re working 
with complex masks, or when you wish to reuse masks in other parts of Photo RAW. There functions are as 
follows:

• Invert reverses the contents of the mask, swapping the tones.

• The Reset button erases the current mask, leaving it filled with white. 

• The Copy and Paste buttons let you copy the current mask, to paste it into another filter, 
local adjustment or layer. 

• The View button toggles the Mask View on and off.

• The Lumen button creates a luminosity mask of the image (see page 108). 

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 

Overview of the Mask Options section of a filter pane in Effects. Mask 
Options is also applicable when working in the Local Adjustments tab, or 
on a layer in the Layers pane.
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click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Mask Options 
section of the pane. When you add a gradient mask and click on the Color Range option in the Tool Options 
bar, the color chosen is sampled from the center of the gradient control, but you can open the Mask 
Options pane and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug.

Luminosity masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Photo 
RAW. This mask uses the brightness (or luminance) values in your image to let you target specific tonal 
ranges with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very 
specific areas of an image. They can be used for targeted sharpening and contrast operations, highlights 
control, and much more.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. Because luminosity masks take the brightness levels of a photo, 
when you view the mask, it will look like a grayscale version of the image. With a luminosity mask, your 
effect will be applied in an increasing amount depending upon the brightness value of the pixel underneath: 
if the pixel is black, none of the effect will be applied; if it is white, it will be entirely applied; for all other 
tones, the effect will get applied as a percentage of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 

Here, we’ve created a mask using the Color Range option in the Mask Options section for this Color Enhancer filter in Effects. We 
clicked on a blue color in the sky to use as the base for the selection range. Adjusting the Color Range slider while viewing the mask lets 
us fine tune the selection.
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bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

MASKING TIPS

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create and modify masks. For example, you can start 
with a luminosity mask, adjust the tonal range of the mask with the Levels or Window sliders, 
and then further refine your mask by painting in or out with the Masking Brush or Masking 
Bug. Adding a luminosity mask always overrides the current mask (as is the case with the AI 
Quick Mask tool), however, so you should start there.

• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at the 100, all of your mask is viewable, at 0, the mask is entirely white.

• Don’t forget that masks aren’t just for Effects filters and Local Adjustments; you can create 
a master layer mask that will apply your selection to the cumulative adjustments made in the 
Edit module. To do this, click on the Mask icon to the right of the layer.

• Because it can sometimes be helpful to use the same mask on different filters, use the Copy 
button to grab the contents of a mask from one filter and the Paste button to paste that onto 
the mask of another filter. The Invert command can be invaluable when you wish to apply a 
filter to the opposite portion of a photo. Think of applying one effect to a sky, and the other 
to your foreground.

• Because masks are tied to the actual pixels of the current photo (or layer), they cannot be 
copied from one photo to another, or between layers in a multi-layered document.

Viewing a luminosity mask is similar to a black-and-white version of your photo; the lighter the tones, the more the 
intended effect will be, and the darker the tones, the lower the effect.
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Presets
Presets are stored “recipes” that include sets of Edit module adjustments, and can be applied to one or 100 
images with ease, in Browse or Edit. Presets are a fast way to get consistent results when editing a group of 
images, helping you hone your own look. You can also easily create your own presets.

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of presets. (The 
view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various presets, with a thumbnail 
of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name.(Hot Desert is shown above in the preset 
category list.) Clicking on that icon will open a full-screen window showing your photo with that category’s presets applied to it. (See the following page for 
a screen shot of the Quick View Browser.

Photo RAW lets you create your own custom presets and categories, and you can also create subcategories of presets. (See “AI quick mask HUD” on page 
98 for more.)
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ON1 Photo RAW 2021 comes with more than 200 built-in presets, in more than a dozen categories, ranging 
from landscapes to portraits, color grading, film looks and much more. You can create your own presets, or 
import presets from other ON1 users and photographers.

You can create presets that apply Develop adjustments, Effects settings, Portrait operations and local 
adjustments that use the Adjustable Gradient tool, and any combination of these.

Presets can also store the camera profile used, Develop’s Auto settings, crop settings and retouching 
information, as well as masks created with brush tools, Effects’ Masking Bug, and the Adjustable Gradient 
Tool in the Local Adjustments panel. If you apply a preset that contains these options, you should check to 
make sure that you have the desired result; if not, you can reset the various individual operations via the 
Settings menu. 

APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There 
you will see any built-in presets supplied by ON1—ordered by 
category—as well as any presets you might have created or 
installed yourself. Clicking on a category name will open it and 
display any presets within that category, with a tiny thumbnail showing your selected image with that 
preset applied to it. To change the size of the thumbnails in the Presets panel, select the Browser Mode 
option from the View menu and choose One, Two or Three Column View.

If you’d like to see a larger representation of what your selected photo will look like with a category’s 
presets, click on the Quick View Browser icon in the category’s title bar. That will display a window with all 
of the presets in that category. (Press the Escape key to close the Quick View Browser.)

To apply a preset to a photo, click on the preset in the mini-browser or in the Quick View Browser. Presets 
are not cumulative; clicking on another preset will remove the previous one and apply the new one.

A preset category with the Quick View Browser 
icon shown.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a 
full-screen representation of that category’s presets, giving you a larger representation of how that preset will look on your image.
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Once you’ve applied a preset, you can reduce its overall effect by hovering over the chosen preset. There, 
you will see a Fade slider, where you can lower the opacity of any Effects filters applied with the preset. 
(Develop, Portrait, and local adjustments are not reduced.)

After you have applied a preset, you can still make changes to any of the settings—
in Develop, Effects, and Local Adjustments—add or remove adjustments, switch to 
another preset, perform any retouching or more. 

If you don’t like a preset, clicking on another one will replace the settings of the 
previous preset with the settings of the new preset. To remove a preset entirely, 
choose one of the reset options from the Settings menu, or remove the individual 
settings from the appropriate panes in Develop and Effects. (The latter approach 
is recommended if you have created masks or local adjustments that you wish to 
preserve.)

You can save a preset as a favorite by hovering over its thumbnail in the browser, 
and clicking on the heart icon. This will add that preset to a Favorites category that resides at the top of the 
Presets panel. To remove a favorite, click again on the heart icon.

Inserting presets (Effects tab only)

When you click on a preset, Photo RAW’s default behavior is to remove 
any existing adjustments and apply the newly chosen preset to your 
photo. Sometimes, however, you would like to add a preset on top of your 
adjustments. To do this, open the Presets pane, right-click on the preset 
you wish to add, and choose Insert Preset from the pop-up menu. This will 
add the preset’s filters above the currently selected filter pane  and will 
preserve any edits you made in the Develop or Local Adjustment tabs. 

Inserting a preset will only add that preset’s Effects filters to your currently edited photo. Develop 
adjustments and local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that you wish 
to save, go to the Settings menu and select Save Preset. 
The Save Preset dialog will appear, with options for which 
module’s settings you wish to save, naming the preset, 
and adding it to an existing or new category. Nearly all 
of the Edit module settings can be saved as a preset, 
including cropping, retouching, text blocks and masks.

If you have applied a preset to an image, and 
subsequently updated any of the edit settings (or add 
or remove adjustments), you can update the preset 
with the new settings by choosing Update Preset with 
Current Settings from the Settings menu. This will only 
change the preset in your app; any images that had the 
old version of the preset will keep those settings unless 
you reapply the preset. (You can also update a preset by 
right-clicking on the preset in the Preset Browser.) 

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset. To 
find it, just hover over the 
applied preset in the 
Presets pane.

The Inset Preset option is only available  
when working in the Effects tab.

The Save Preset window is similar to the Sync Settings window 
(see “Copying settings and synchronizing edits” on page 67), 
and includes all of the operations possible in the Edit module, 
with the exception of layer operations. Filled circles to the left of 
a setting mean that the setting will be saved in the preset; click 
the circle if you don’t wish that setting to be saved.
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If you would like to create a new preset category—which will be added to the Presets panel throughout 
Photo RAW—choose Add New Category from the category pop-up. 

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Photo RAW will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 Photo. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category from 
the pop-up.

• Choose Rename category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image in 
Develop or Effects.

Right-click on a preset category to get the 
category pop-up menu.
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Creating nested presets

To help manage large groups of presets, Photo RAW’s Extras Manager lets you nest preset categories. See 
“Organizing Presets” on page 27 for details on how to create and manage preset category subfolders.

CAMERA-BASED PRESETS

In addition to using presets in the Browse and Edit modules, you can also have Photo RAW automatically 
apply a preset to any new photos from a specific camera, even down to the serial number.

This can come in handy if you have created a custom camera profile or if you have converted a camera to 
infrared. Camera-based presets are automatically applied to photos in cataloged folders, imported photos, 
and any time you open a folder in Browse. It’s important to note that any photo that has already had any 
adjustments made in the Edit module will not have the preset applied to it.

So, if you always find yourself making the same basic adjustments to most photos from a specific camera, 
just make a preset and it will apply to all photos from that camera. You can also choose to have the preset 
applied to Raw or JPG photos from that camera, or both if you shoot Raw+JPG.

Setting up camera-based presets

To use this feature, first define the preset you wish to use. Because presets are applied globally to all of 
that camera’s images—except for those that have been edited previously—you probably want to keep the 
adjustments within a narrow range of categories, like a specific camera profile, Develop’s Tone and Color 
and Details settings, and minimal Effects filters, if any at all.

To connect the preset to the camera, open the 
Files tab of the Preferences screen (page 232). 
At the bottom of the window is the Default 
Processing section, which contains a list of all 
the cameras that Photo RAW knows you have 
shot with. The list includes the camera name, 
serial number (if your camera records that in the 
image metadata), preset and file types. Scroll 
down to the camera you wish to use and click on 
the Preset pop-up, which contains a hierarchical 
list of your presets, and select the one you wish to use. The default file type is Raw; if you wish to apply the 
preset to JPG files, or both Raw and JPG files, choose the appropriate setting from the File Types menu. 

When you close the window, Photo RAW will update your database and apply that preset to all of the 
photos created by that camera. And from that point on, when you add photos taken with that camera, 
Photo RAW will apply the preset automatically to all those photos.

Editing photos with camera-based presets

Because Photo RAW is non-destructive, any photo with a camera-based preset applied to it can be edited 
and changed in the Edit module, or have a new preset applied via Browse. However, you must either apply 
a new preset, or change the individual settings in the Edit module. You can’t choose the Reset All Settings 
option from the Settings menu, because the default settings for that camera’s images are now those applied 
by the preset.
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Copying settings and synchronizing edits
In addition to applying presets, you can copy all of the existing edits—of any operation you can perform in 
the Edit module—made in one photo and paste them directly onto other images. There are two primary 
methods for doing this—Copy/Paste and Sync—but they achieve the same end goal: it’s more a matter of 
preference in which operation you choose.

To copy the edit settings from an image, click on the source file and choose Settings > Copy Settings. Then, 
click on the new image and choose Settings > 
Paste Settings. A window will appear, giving 
you the option of applying any or all of the 
edits on the original photo, or you can select 
which edits—everything from individual settings 
in Develop’s Tone and Color pane, to masks, 
cropping, and text if used—you wish to paste 
into the new photo. (You can also select a group 
of photos and paste the edit settings onto the 
group.)

The Copy/Paste Settings commands can be 
useful when you wish to paste settings across a 
number of photos in different folders. As long 
as your Edit session is active, Photo RAW will 
remember the last copied settings, and you can 
paste them onto other photos as you wish.

With the Sync Settings command, select the 
image you want to use as your source. Then, 
holding down the Shift key (if you are selecting 
an image or group that is contiguous with the 
source), or the Command (Mac) or Control 
(Windows) key, and click on the image(s) 
that you wish to apply the source file’s edits. 
Your selection should have the source image 
highlighted in blue, and the target images 
highlighted in gray. If that is correct, click on the 
Sync button at the bottom of the Preview area, 
or choose Sync Settings from the Settings menu. 
The Apply Settings window will open, and you 
can follow the same procedure to synchronize 
your edits.

If you’re sure that you want to sync everything 
from a source photo to another photo or group 
of photos, the Settings > Sync All Settings 
command will let you bypass the Apply Settings window. Select your source  and destination photos and 
select the command. Note that all settings—including cropping, text and masks—in the source image will get 
synced.

In the Apply Settings window—accessible from either Paste Settings or Sync 
Settings—you can apply nearly all Edit module operations to another image or 
group of images. Filled circles to the left of a setting mean that the setting will 
be applied; click the circle if you don’t wish that setting to be applied.
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RESETTING EDITS

Any edits you have made with ON1 Photo RAW 2021 can be completely reset from within the Edit module. 
This includes photos you might have pasted or synchronized settings onto inside Browse, or anything done 
within the Edit module.

The Settings menu offers eight options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom right of the Browse and 
Edit windows.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset Portrait Settings: Removes only the settings applied in the Portrait tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original, uncropped size.

• Reset Text: Removes any text blocks.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: When working in the Edit module, the Reset, Copy/Paste and Sync 
settings work only on the currently selected layer.
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Soft Proofing
ON1 Photo RAW’s soft proofing feature lets 
you see how a photo will look when printed, 
using the color profiles that get installed with 
your printer. Soft proofing helps you determine 
where there might be issues when you print, so 
that you can adjust your tone, color and effects 
to give you a print that is closer to your editing 
vision.

Normally, when you’re viewing an image in 
Photo RAW, you are viewing it through the 
lens of your monitor’s display profile. The color 
gamut of your computer’s display is wider than 
that of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or 
by clicking on the soft proofing icon to the left 
of the Preview button at the bottom of the main 
Photo RAW window. You soft-proof various 
paper types by choosing an installed printer 
profile from the Profiles submenu. The image 
will change to approximate the color of the 
paper you’re profiling. You can also turn on an 
overlay that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in the 
View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu lists the currently available printer profiles. Choosing one 
will change the on-screen display to use that profile. You can also import profiles via this 
submenu.

• Intent: Photo RAW offers two different rendering “intents” when soft proofing, which are 

These three screen shots show the results of soft proofing options, as viewed 
in the Edit module. The top image is with soft proofing off (and is using the 
display color profile). The middle image is with soft proofing turned on, and 
using a printer profile for Epson’s Exhibition Matte Paper. The bottom image 
has the Gamut warning turned on; out of gamut colors are highlighted by the 
bright red overlay.
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used to convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
Photo RAW to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft proof 
is tone, contrast and color accuracy between screen and print. When 
using a home printer, use test prints to hone in on the right mix of 
Edit module adjustments. Photo RAW’s Versions feature can be extremely helpful when you’re tweaking 
settings to get a print just right (see page 69 for more on working with Versions).

Other Edit Module Preview Options
In addition to soft proofing, ON1 Photo RAW 
2021 offers a few other previewing options 
in the Edit module, which can be found in the 
previewing section at the bottom of the Photo 
RAW window. With these options, you can 
compare the before and after views of a photo—in either split-screen or full-screen views—see the current 
mask, and turn soft proofing on or off. 

CHANGING THE MAGNIFICATION VIEW 

Photo RAW includes various options for zooming in or out of a photo while you’re working on it. In addition 
to the Zoom tool and the Navigation pane (see page 104 and page 81, respectively), you can change 
the zoom view by moving the magnification slider. You can either click on the control and slide it to the 
right to zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main Photo RAW window includes 
options for adjusting the preview magnification, turning compare (before/after) 
view on or off, viewing the current mask, turning soft proofing on or off, and 
for viewing the original photo, with all edits removed.
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BEFORE/AFTER PREVIEWS

As you work in the Edit module, it can be helpful to see how individual edits—via items in the different edit 
tabs—affect your photo, as well as to see the cumulative changes made to the original image. The Edit 
module’s Compare mode displays a side-by-side view of your photo, with the original version on the left, 
the edited version on the right. There is a movable slider in the middle of the screen, which lets you view 
more or less of each view; click on the box at the center of the slider and drag it to the left (to view more of 
the edited image) or to the right (to view more of the original. While working in Compare view, you can use 
the magnification slider to zoom in or out of the image, which can be useful when you wish to see the 
effects of your edits on smaller sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

ON1 Photo RAW 2021 has extensive masking capabilities throughout the Edit module. While you’re in the 
process of creating a mask, you have two options for displaying the contents of a current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Edit’s Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and contracting 
the different views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in the Edit module. 
You can also, via this option, show the mask as a red overlay only when you are brushing a mask. 

You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 Photo RAW 2021, see the details on the 
respective masking tools, starting on page 88, and “Masking Basics” on page 105.

FOCUS AND CLIPPING VIEWS

Two additional previewing tools that can be quite powerful aids when you are editing photos are the 
Clipping and Focus Mask overlays. These options can be displayed in any of the Edit module tabs (as well as 
in the Browse module).

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

The two options for viewing a mask are with a red overlay (left), which shows the masked areas in red, and a grayscale mask (right), which shows only the mask, in a 
range of tones from white (not masked) to black (completely masked). Tones in gray represent varying percentages of the mask’s opacity.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.
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Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a lot 
of photos from a shoot, it can be a bit tedious to check focus 
at that level. Luckily, Photo RAW’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will continue to be displayed even as you zoom in 
on a photo.

Showing or Hiding Edit Module Adjustments
You can also show or hide many individual 
adjustments made throughout the Edit module. 
Most of the panels in the Develop, Effects, Portrait 
and Local tabs have a Show/Hide control in the 
upper left-hand corner of the panel. You can make 
your adjustments, and can click the control to turn 
the effect on or off. 

That this option is not solely for previewing an 
effect; if the adjustment is turned off, it will not be present in the edited image. This can be helpful if you’re 
trying different filters in Effects, for example, and you want to see if one looks better than another, or if 
you wish to see if it truly helps the photo or not. To turn the adjustment back on, click on the Show/Hide 
control so that the circle is filled.

The only adjustment inside the Edit module that cannot be turned off in this way is the Tone & Color panel 
in the Develop module. If you wish to view your photo without those adjustments, you need to press the 
Reset icon, which is represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in most Edit module panels, see “Filter Overview” on page 132.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.

To turn an effect or other adjustment off, click on the Show/Hide control 
in the upper left of an adjustment’s panel. If the control’s circle is empty, 
that effect is not implemented. Clicking the control will turn it back on.



ON1 Photo RAW 2021 User Guide	 Part 3: Working in the Edit Module	 122

BASIC GLOBAL EDITING WITH DEVELOP

Develop is the module for performing basic global editing operations—adjusting tone and color, removing 
noise, sharpening and applying transforms to a photo. It is the perfect place to begin editing your photos, 
especially if you are using ON1 Photo RAW 2021 as a standalone editor. And, with the full non-destructive 
editing capabilities of Photo RAW, you can return at any time to Develop and adjust your edits.

Develop Adjustment Panes
To edit your images, the Develop tab has four adjustment panes found in the Overall Settings panel. Unlike 
the Effects tab, which lets you stack filters in any order, the Develop tab’s adjustments are applied in the 
following order:

1.	 Tone & Color

2.	 Details

3.	 Lens Correction

4.	 Transform

WORKING WITH PANES

The Tone & Color pane is at the top of the stack, followed by the Details, Lens Correction and Transform 
panes. These panes are not removable from the stack, although you do not have to apply any of these 
operations to a photo. The remaining panes can be applied based upon what you wish to do with your 
photo. Clicking on the button to the left of the pane’s name will turn that pane on or off, which can be 
helpful if you want to see the effect in the context of other edits you have made. The Reset button—
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designated by the circular arrow icon at the top right of each pane—will reset that pane’s settings to their 
default state.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the bar, but the entire title bar 
is clickable). If you don’t want to have to scroll up and down the Settings panel 
when you have a lot of open panes, choose Solo Mode from the Window menu. 
This will leave only the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

TONE & COLOR

This pane adjusts the tonal and color characteristics of an image, 
letting you correct and enhance exposure, contrast, detail and 
color. It is split into two sections, Tone and Color, with a Color 
Profile option at the top of the pane.

Camera Profile

Camera profiles apply alternative interpretations of the raw data in 
an image based upon different genre types or intents. The pop-
up menu displays Photo RAW’s built-in profiles: ON1 Standard, 
Landscape, Portrait, Vivid and Neutral. If your camera has its own 
embedded profiles, you will see those profiles in the list as well, 
and you can also import your own custom camera profiles using 
Photo RAW, and X-Rite’s ColorChecker and ColorChecker Camera 
Calibration software. (See page 129 for more information on how 
to create and import custom camera profiles into Photo RAW.)

Photo RAW’s camera profiles are non-destructive, and work 
independently of any changes you make to tone or color.

Tone

The Tone sliders control the global tonality, or brightness and  
contrast of the image. You can adjust each of the following:

• Manual, AI Match and AI Auto buttons: The AI 
Match button uses artificial intelligence technology to 
automatically adjust the controls in the Tone panel to 
closely match your photo as you saw it on the back of 
your camera’s display. The AI Auto button performs 
an automatic tone adjustment on your photo using a 
proprietary ON1 algorithm. If you don’t use either of 
these options, or if you make subsequent adjustments, 
the Manual button will be highlighted.  
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• Auto Tone slider: This option is only available when using the AI Match or the AI Auto option. 
Using this slider will let you ‘fade’ the effect of those options.

• Exposure: Adjusting this slider to the right will lighten your image. Adjusting to the left will 
darken your image.

• Contrast: Increase or decrease the contrast in your image.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Recover Highlight Hue: When checked, Photo RAW will attempt to recover highlights while 
maintaining subtle hues in areas like the sky.

• Structure: Adjusts the detail in your image by changing the local contrast.

• Haze: When moved to the left, this will remove haze or fog from your photos; moving it right 
will enhance fog or haze.

NOTE: The AI Match and AI Auto buttons only affect the tone and saturation 
of your image; they don’t adjust the white balance. If you wish to change the 
white balance, use the Auto button in the Color section of the panel, or adjust 
the Temperature and Tint sliders as desired, as described below.

Color

The Color sliders control the Temperature, Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. By default, when working with raw (or DNG) files, the color temperature is 
measured in degrees Kelvin (°K), which gives you a larger and more accurate range to make adjustments. 

The settings in this section of the Tone & Color pane include:

• Auto Button: The auto button attempts to detect and remove a color cast. It makes 
adjustments to the Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray.

• White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, 
Custom). The default is As Shot, which is the color temperature that the camera recorded 
when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow). When editing 
a raw file, the °K button will be blue, which means that the temperature is measured in 
degrees Kelvin. Clicking the button will change the slider to a relative color ramp. (The Kelvin 
ramp is only available when working with raw photos; other formats use the relative slider.)

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases/decreases the color of muted tones, leaving more saturated colors alone.
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• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Adjusting Tone & Color settings via hotkeys

When you’re working in any tab inside the Edit module, 
you have the capability to adjust the basic tone and color 
settings for your current image directly from the keyboard, 
based on the hotkeys found in the Keyboard Shortcuts 
window. These include the following sliders: Exposure, 
Contrast, Highlights, Midtones, Shadows, Whites, Blacks, 
Temperature, Tint, Saturation and Vibrance.

To use this feature, first invoke the setting you with to 
change with the appropriate keyboard shortcut. An on-
screen overlay label will appear, indicating that you are 
changing that setting. Use the Up and Down arrow keys to 
increment or decrement the chosen slider. When you’re done, press the Escape key, or click in the window.

This feature can be helpful when, for example, you apply a set of filters in Effects and feel that they caused 
the shadows to darken in your image. Using the keyboard shortcut for the Shadows adjustment, you can 
make changes dynamically without having to go back to the Develop tab.

Photo RAW has a set of pre-assigned keys for these adjustments in the Develop section of the Keyboard 
Shortcuts window, but you can change them easily. See “Customizing Photo RAW’s Keyboard Shortcuts” on 
page 29 for more. 

DETAILS

The Details pane incorporates sharpening and noise reduction, two 
adjustments that often compete with each other when working on 
a photo. We’ve added them together into a single pane to help you 
achieve the right balance between sharpness and noise during your 
initial photo editing. 

Sharpening

The sharpening section of the Details pane is designed to visually 
sharpen an image based on its initial state from your camera—for 
example, to bring back some sharpness that might have been lost. 
It has two basic controls: Amount and Threshold. Amount controls 
the strength of the sharpening applied, while Threshold reduces 
sharpening in areas of low detail via a threshold mask. 

Hold down the Option (Mac) or Alt (Windows) key as you adjust 
the Amount slider to display your photo in grayscale, which can 
make it easier to view the degree of sharpening you’re applying.

You can view (and change) the hotkeys for the primary Tone 
& Color adjustments from the Keyboard Shortcuts window, 
which is found in the Edit menu.
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With the Threshold slider, a setting of 0 means that the sharpening amount gets applied to every 
pixel. As you increase the amount, it focuses the sharpening only where there is a difference between 
neighboring pixels. To help you determine which edges are sharpened, you can use the same Option/Alt 
key trick mentioned above. In this view, as you adjust the Threshold slider, everything that is white will get 
sharpening applied to it; everything displayed as black will not have sharpening applied.

NOTE: When you are adjusting the sharpening or the noise in a photo, it is 
best to be working at 100% view. To do this, you can click on the 100 button in 
the Navigator pane, choose View Actual Pixels from the View menu, or press 
Command-Option-0 (Mac) or Control-Alt-0 (Windows) on your keyboard. 

Noise Reduction

The Noise Reduction section reduces luminance and color noise, while maintaining image detail. By default, 
ON1 Photo applies a small amount of noise reduction on your photo, based on the camera type used. You 
can then further refine both luminance and color noise, as defined below:

• Luminance: Adjusts the overall strength of the noise reduction applied to the luminance or 
detail of the image. Hold down the Alt/Option key to see just the luminance while adjusting 
this slider.

• Color: Controls the amount of noise reduction applied just to the color noise or chroma, of 
the image.

• Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.

• Remove Hot Pixels: If you have any individual, blown-out pixels in your image, turning 
this setting on will remove them, changing that pixel’s color to one that blends in with the 
surrounding pixels. This setting can also be helpful in reducing noise in long exposures.

The Details pane is intended to adjust the base-level sharpening and noise reduction of a photo. If you wish 
to apply further sharpening for printing or other output uses, you can add more targeted sharpening and 
noise reduction in the Effects tab, or the Resize module, if you wish to sharpen for output. 

NOTE: ON1 Photo RAW 2021 uses an improved noise reduction engine, which 
is available via the Version pop-up in the Details panel. In order to provide 
editing compatibility, photos that have been edited in previous versions will 
default to the 2017 noise reduction model, while new photos that are edited 
in ON1 Photo RAW 2021 will default to the new model. You can change any 
image to the other model via the Version pop-up.

Styles

The Details pane has a set of built-in styles in the top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you get started in the pane, or to apply a specific effect.
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You use a style by clicking on the style’s icon in the pane, and then can adjust the sliders as desired to get 
the right effect for your photo.

You can save your own settings as a style. Simply click on the More icon on the far right side of the styles 
list for that pane, then choose Save New Style from the pop-up. Name your style, and it will then be 
added to the top of the More menu. To apply a saved style, choose the style from the More pop-up menu. 
To adjust the settings for a saved style, apply it, make any changes you would like to the sliders or other 
options, then click on the More pop-up and choose Update Style with Current Settings from the menu.

LENS CORRECTION

The Lens Correction pane detects the lens used in a photo (from 
its metadata), and searches Photo RAW’s internal lens database 
for an appropriate profile. If found, the profile will be applied 
automatically, reducing distortion, chromatic aberration and 
peripheral fall-off. 

Photo RAW also detects embedded lens profiles in modern lenses 
from Panasonic, Fujifilm, Canon, Nikon and Sony; providing high-
quality corrections automatically and without waiting for software 
updates.

Lens profiles can only be applied to raw photos that are opened via 
Browse. If you use Photo RAW as a plug-in, lens profiles will not 
have any effect on your photo, although adjustments made in the 
Manual section of the pane will get applied to your final photo.

If Photo RAW doesn’t have a built-in profile for your lens—or 
you wish to apply further correction to a photo—you can make 
manual adjustments by clicking on the Manual triangle. There, you 
can adjust lens distortion—either pincushion (where lines in a photo curve inward) or barrel (lines curve 
outward)—by moving the slider to the right or the left. The Manual section also can help remove any purple 
or green color fringing that might occur along edges, and can reduce the light fall-off (vignetting) that can 
occur at the outer edges of a lens.

TIP: If you have a lens that doesn’t have a profile, open a photo shot with it and 
adjust the Lens Correction pane’s Manual settings to fix any lens abnormalities. 
Click on the Style pop-up and choosing Save New Style. When you open 
additional photos shot with that lens, choose that Style from the Style pop-up.

A list of the currently supported lens profiles can be found on the ON1 support website, via this link.
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TRANSFORM

Transform applies distortion and perspective correction to your 
image, and offers rotation and scaling options as well. You can 
use these settings to make small adjustments to perspective or 
distortion.

The three icons at the top of the pane let you apply specific 
transforms to the current photo:

• Keystone lets you project your image as if it were on an 
angled surface. This type of effect is often used to help 
adjust the perspective in architectural photos. Selecting 
the Keystone option will give you a box with four handles 
at the corners. You can extend the handles in any 
direction. Once you’re done, click on the Apply button at 
the center of the keystone box.

• Level works in a similar fashion to the one found in the Crop tool (found on page 87). 
Select the tool and click and drag across an element in your image that should be level.

• Move lets you adjust the image’s position on the canvas. Click and drag to reposition.

The Transform pane’s Keystone option can help with perspective issues in a photo. Clicking the Keystone icon gives you a box that you can use to align the four 
corners of an object that should have parallel lines (above left). Once you have the edges of the object aligned, click the Apply button in the center to create the 
transform, and apply a crop as necessary. (Sometimes, you’ll find that using the manual section of the Lens Correction pane can help reduce some of the distortion 
that the Keystone operation can create.)
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Keystoning can be helpful when you want to adjust the perspective in a photo; just adjust the four corners 
to align with an object that should have parallel lines, like a window or door, then click the Apply button. 
The Transform pane doesn’t apply a crop when you apply a transformation; use the Crop tool to do that.

In addition to the above tools, the following options will apply specific transform operations:

• Vertical: Adjusts the vertical perspective.

• Horizontal: Adjusts the horizontal perspective.

• Rotation: Rotates the canvas up to 45° clockwise or counterclockwise.

• Scale: Scales your image up from the center, to 100%.

• Aspect Ratio: Stretches your image horizontally (moving the slider to the left) or vertically (to 
the right).

• Shift: Translates the image left or right.

• Rise: Translates the image up or down.

The Grid pop-up menu at the bottom of the Transform pane lets you displays a grid overlay while you are 
adjusting the pane’s sliders. The default for the pane is No Grid, but you can also choose between 10% 
(large), 5% (medium) or 1% (fine) grid settings.

The Transform tool works best most of the time in small amounts. It’s not necessarily going to fix a photo 
with an extreme perspective, but it can often help with slight adjustments, especially if you fine-tune them 
with some of the Transform panel’s other controls or the Manual section of the Lens Correction panel. In 
addition, the tool does not apply a crop after an operation; if you are happy with the transform results, use 
the Crop tool to finish your work.

CREATING AND ADDING CUSTOM CAMERA PROFILES

As noted in the section on the Tone & Color panel (page 123), you can create your own custom camera 
profiles and import them into Photo RAW. Custom camera profiles can help improve the fidelity of color 
reproduction in your photos, and for some photographers, this can be a useful tool. 

To build a new profile, you’ll require a color profiling target and special software that creates the profile. 
ON1 worked with X-Rite Inc. during the development process to create a workflow that helps ease this 
process and ensure consistent results when building camera profiles. In addition to ON1 Photo RAW 2021, 
you’ll need a reference target, such as one of the ColorChecker series, and X-Rite’s ColorChecker Camera 
Calibration app. 

NOTE: You can find the different ColorChecker options on the X-Rite website 
at xritephoto.com/camerasolutions.

The process for creating a custom profile is as follows:

• Turn off automatic white balance on your camera; set it to the lighting conditions—daylight, 
tungsten, flash, fluorescent—in which you are shooting the target.

• Place the color reference target in the center of your scene, with even light. Take the photo.

• Open the photo in Photo RAW’s Develop tab.
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• In the Camera Profile section of the 
Tone & Color panel, choose the Linear 
Raw profile from the pop-up.

• Click on the dropper icon in the Color 
section of the Tone & Color panel (see 
page 124), and click on one of the 
light gray patches in the target. This 
will neutralize the image.

• Using the Export feature, export 
your photo as a TIFF, selecting the 
Camera Calibration color space from 
the pop-up under the file type option. 
(See page 201 if you need help with 
exporting photos from Photo RAW.) 

• Using X-Rite’s ColorChecker Camera 
Calibration software, open the 
exported TIFF file. The app should 
find and align the target; if so, click 
the Create Profile button, and save 
the exported profile. If it doesn’t find 
the target, follow the guidelines in 
the software to help improve your 
chances with a new photo.

• In Photo RAW, go to the Develop 
module with a photo created with the 
camera you profiled. In the Tone & 
Color panel, click on the Import Profile 
item in the Camera Profile pop-up 
menu. Find the exported profile and 
choose Open. Your profile is now 
installed.

When you open the photo with the color target, set the camera profile to 
Linear Raw, and use the gray dropper to neutralize the photo, by clicking on 
one of the light gray targets (circled, above).

When exporting your neutralized target, set the 
file type to TIFF, and the color space to Camera 
Calibration Space.

Using X-Rite’s ColorChecker Camera Calibration app, you can open the 
exported TIFF file, and create your own custom camera profile. Then, import 
the profile via the Camera Profile pop-up in Develop to use it with any photos 
taken with that camera.
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STYLIZING WITH ON1 EFFECTS

If Develop is the base from which you start editing your photos, Effects is the finishing school. With 31 
filters that can be stacked in any order, and with extensive blending and masking options, Effects lets 
you create stunning, pro-level photos with ease. And, since it is built upon ON1 Photo RAW 2021’s non-
destructive editing engine, you can go from Browse to Develop to Effects and back again, preserving your 
edits, masks and more without having to worry about saving multiple versions of your files.

While Develop and Effects share the same tools, Effects is much more customizable in how adjustments—
called filters in Effects—are applied. The editing stack inside Develop is fixed, while the stack in Effects is 
extremely flexible. Here are just a few of the things you can do with an image in Effects:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Add blending options to all or some of the filters and set the opacity of each filter individually.

• Create complex masks for each filter you add, letting you selectively apply a filter to specific 
portions of an image.

In addition to creating and using presets, you can copy and paste Edit module settings from one file to 
another, or alternatively, synchronize the edits on one photo to a group of photos. These operations can 
all be performed in any of the editing modules, as well as in Browse, adding to ON1 Photo RAW 2021’s 
extreme flexibility. (See “Copying settings and synchronizing edits” on page 115 for details on how to 
copy edits between photos.)



ON1 Photo RAW 2021 User Guide	 Part 3: Working in the Edit Module	 132

Filters
Filters are the building blocks of Effects’ editing power. Each filter is an adjustment type, much like the 
basic adjustment panes inside Develop, but Effects filters have much more functionality than the Develop 
panes. Each filter is like a movable, editable layer over the base image you are working on. You can use 
Effects’ masking tools to apply a filter to only part of an image and can change the blending mode (and 
opacity of the filter) to alter the way the filter interacts with those above and below it in the stack.

The Effects tab has 30 filter types, added either by the Add Filter button found at the top of the Effects 
tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and you can 
have more than one instance of a filter in the stack. (This can be helpful when you are creating complicated 
masks on an image and wish to apply the same filter differently in parts of the photo.)

FILTER OVERVIEW

Each filter pane has a different set of adjustment 
options and controls, but every filter pane has the 
same five sections:

A.	Filter on/off button (left); Show/Hide 
Mask (right)

B.	 Displays blending mode options (left); 
Resets filter (middle); Deletes filter from 
the stack (right).

C.	 Filter opacity setting.

D.	Styles pane for filter presets.

E.	 Control area for adjusting that filter’s 
specific settings (dependent upon the 
filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the top of 
the Effects tab, the Filters window opens up, 
with a list of all 30 filters. If you run your cursor 
over a filter name, the right side of the window 
will have a small before/after thumbnail, a short 
description, and a list of keywords that relate to 
that filter. To add a filter, click once on the filter 
name, and it will add it to the stack, above the 
current filter. If there aren’t any filters in the 
stack, the new filter will be at the top of the 
stack. You can click and drag the title bar in any 
filter to move it up or down in the stack.

If you’re not sure what you might looking for, 
you can search for filters using keywords, like 

The Filters window opens when you click on the Add Filter button at the top of 
the Effects tab.

Overview of a filter—in this case, the Cross Process filter—inside Effects.
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“monochrome,” “contrast,” “sharpening,” and so forth. Photo RAW will then narrow down the search to 
those filters that match your search terms.

APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel found 
throughout the Browse and Edit modules, 
Effects has an additional Filter panel on the 
left side of the screen. This panel lets you 
browse all of the filters inside Effects, and 
display previews of the available styles for 
that filter. 

To choose the Filters panel, click on 
the Filters tab. A list of the filters will 
appear, and clicking on a filter will display 
thumbnails of your image with that filter’s 
available styles. To choose one, click on the 
style, and Effects will add that filter to the 
Overall Settings pane. Note that this will 
replace the currently selected filter in the 
stack; to add a new one on top of the stack, 
click the Add Filter button at the top of the 
Effects tab on the right, then choose a filter 
from the list. (You can also click and drag 
the title bar of any filter and move it up or 
down in the stack.)

If you’d like to see a larger representation 
of what your selected photo will look like 
with a filter’s styles, click on the Quick View 
Browser icon in the category’s title bar. That 
will display a window over the entire Photo 
RAW interface with all of the presets in that 
category. (Press the Escape key to close the 
Quick View Browser.)

To change the size of the thumbnails in the 
filter styles panel, select the Browser Mode 
option from the View menu and choose 
One, Two or Three Column Thumbnail View. 
(If you choose Thumbnail from the Browser 
Mode submenu, the Filters and Presets 
panels will display as thumbnails.)

If you’d like help with what the different 
filter operations do, click on the Info button at the top right of the panel. With that button checked, when 
you hover over a filter, Photo RAW will display a small pop-up window containing the same description 
(with before/after thumbnail) found in the Add Filter window. Click the Info button again to turn off this 
display.

The Filter Browser has a list of all the filters available in Effects (left). Clicking on a 
filter will display thumbnails of the filter’s styles using your photo (right). 
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Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name you’re looking for in the search field at the 
bottom of the panel. The search results will appear in a new sub-folder called search results, which will be 
selected automatically.

Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or the Quick View Browser, you’ll 
see a heart icon. Clicking the icon will fill the heart in and add that style to your Favorites category. This 
category resides at the top of the filter list, and contains all filter styles you have selected as a favorite. To 
remove a favorite, open the Favorites category, and click again in the heart icon.

To apply a filter style to a photo, simply click on the style in either the Filter Browser or in the Quick View 
Browser.

WORKING WITH FILTER PANES

By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, 
you will see those filters in the stack. Clicking on the button in the top left corner of the filter pane will 
turn that effect on or off, which can be helpful if you want to see the effect in the context of other edits 
you have made. If you don’t like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The 
Reset button, which is next to the Delete button, represented by ‘⟲,’ will reset that pane’s settings to their 
default.

The Filter panel’s Quick View Browser option works identically to the one for the Presets panel: click on the icon to the right of the filter name, and Photo RAW 
will display the current photo with that filter’s styles applied.
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To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title 
bar is clickable). If you don’t want to have to scroll up and down the filter stack 
when you have a lot of open panes, go to the Window menu and choose Solo 
Mode. This will leave the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

STYLES

All of the Effects filters have a set of built-in styles in the 
top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you 
get started in the pane, or to apply a specific effect.

You use a style by clicking on the style’s icon in the pane, 
and then can adjust the sliders as desired to get the right 
effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

FILTER MASKS

Every filter has a mask associated with it, which lets you apply that filter’s effect to specific areas of an 
image, using the Masking Brush and Masking Bug tools. By default, the mask is white, which means that the 
effect is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the 
effect in areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and 
choose to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

Photo RAW has two options for viewing the contents of a mask: either as a red overlay on top of your 
image (the default) or a view only of the mask itself, represented as grayscale. These options are available 
from the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch 
between the two modes. (Photo RAW will remember the previous settings.)

Styles for the Split Tone filter.

Saved styles appear at the top of 
the More menu.
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The Mask section of any effect or local adjustment has the following contents, as shown below (using the 
Color Enhancer filter as an example):

A.	The Show/Hide Mask icon, which displays the 
contents of the current mask. The default mask 
contents are white when you add an effect, and 
black when you add a local adjustment layer.

B.	 Buttons for opening the blending options, 
resetting the filter, and removing the filter from 
the stack.

C.	 Sets the overall opacity of the effect with the 
mask.

D.	Larger display of the current mask, with buttons 
to invert, reset, copy, paste, create a luminosity 
mask, and view/hide the mask contents.

E.	 Density adjusts the overall mask density from 
black (100) to white (0). Feather blurs the mask.

F.	 The Levels and Window settings let you adjust 
the black and white points of the mask, fine 
tuning them in different ways.

G.	The Color Range option lets you choose a color 
(selected via the dropper tool), and make or tune the mask based on the range of the color 
selected.

For more details about creating and manipulating masks in Photo RAW, see “Masking Basics” on page 105; 
information on the Masking Brush and Masking Bug tools starts on page 94. 

DELETING A FILTER

You remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter to an image, but would like a faded, muted color effect, 
simply reduce the opacity of that filter. The more you reduce the opacity, the less effect the Black & White 
will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. Mask Options is also applicable 
when working in the Local Adjustments tab, or on a layer in the 
Layers pane.
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BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 Photo RAW 2021’s blend modes also let you apply a blend mode to specific colors 
or tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options gear icon at the top of a filter’s pane. The 
Blending Options area will drop down from the top of the panel. The blending option controls are:

• Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a specific color or tonal range. The 
options are; All (the default), Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 
Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and clicking on a color in your image.)

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts 
the selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your 
adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Photo 
RAW 2021, it might be difficult to know which 
ones to use in any given situation, but they can 
easily be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 
Most often, when you know how you want to 
apply an effect —by darkening, for example—
you’ll need to perform a bit of experimentation 
with the different modes in that category to determine which mode works best.
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MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master blend mode options for the entire image stack, and includes a 
Master mask option. The Master Opacity slider, found at the top of the Effects tab, controls the strength of 
the composite filter stack against the original image—if you haven’t performed any other editing operations 
on it—or against the image as it has been inside the Edit module.

The Master Blend Mode options can be accessed via the gear icon at the top of the Edit tab. It has the same 
blending options found in the individual filter panes, although it does not have the more advanced options, 
such as Density and Feather.

To create a Master mask, click on the mask icon next to the Save Preset icon in the Edit tab. This mask 
works on the entire effects stack.

Filter Types
Effects has 30 filter types available for you to use inside ON1 Photo RAW 2021. Each filter has a set of 
styles in the top row, providing a range of popular or useful options for using that filter. You can also save 
your own preset styles by clicking the More pop-up at the end of the Styles row.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or hand 
colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the 
slider to the left decreases the saturation; moving it to 
the right increases it.

• Film Grain: Amount controls the strength and size 
dictates how large the grain appears.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, and, while it shares some of the same settings as the Black 
& White pane in Develop, you’ll find additional toning features in 
Effects.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane is similar to the one 
in the Tone & Color pane in Develop: you can adjust brightness, 
contrast, highlights and shadows, whites and blacks, and detail 
directly within the filter pane.

Toner

The Toner section of the filter is designed to approximate many 
traditional and popular darkroom-based paper toners, from sepia 
tones to platinum, selenium, coffee and more. You can choose 
from more than 20 toning options via the Type pop – up menu, 
and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by 
the Shadows). To tune your options, you can adjust the Hue or 
Amount of each setting, and use the Swap tones icon (next to the 
Highlights color well) to swap the highlights and shadows colors. 
The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, 
like the Toner section, is designed to add a classic film grain look to 
your photos. To add film grain, choose from the drop-down list of 
popular black and white films. The Amount slider controls the strength of the effect, while the Size slider 
adjusts the scale of the grain.
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BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or 
by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: This adds the appearance of movement.

• The Amount slider controls the strength of the 
blur, and Distance controls the blur relative to the subject and camera. Angle sets the 
angle of the blur, and the Smoothing slider softens the lines created by the motion.

• Radial: These blurs are circular, zooming out from a central point.

• Amount controls the strength of the blur. Quality controls how noisy the blur is, with 1 
being grainy and 100 smooth. Smoothing softens the lines created by the motion.

• The Radial blur type includes a center spot selector at the bottom of the pane. Click on 
the icon, then click on the part of the image you want to make the center of the blur.

• Surface: These blurs tend to maintain edges but add blur to the details. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.

• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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BORDERS

ON1 Photo RAW 2021 has a large collection of pre-made borders 
and edges that you can add to your photos. These borders range 
from classic film borders to viewfinders to artistic effects to 
emulsion transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager (available in Browse). 
Border files need to be a standard PNG file type with a large 
central transparent area

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are 8 built-in categories, sorted by type. Any user-
imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending 
mode and opacity, and, if the border has color, you can adjust its 
hue, saturation and brightness. Alternatively, if the border is black 
or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you 
scale the border up or down in size, to help you get the look you’re 
after, and the Fit Image slider adjusts the size of the image under 
the border.

You can rotate or flip the currently selected border by clicking the 
buttons at the bottom of the screen.

NOTE: See “Extras” on page 26 for information on how to use the Extras 
Manager to import borders, textures and other extras, along with additional 
information for preparing files for the Borders and Textures filters.
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CHANNEL MIXER

The Channel Mixer filter adjusts the intensity and color of the 
individual red, green and blue channels in a photo. You can use it 
for black and white conversions, channel swapping for infrared 
shots, or to shift entire color ranges.

Click on the channel icons to select a specific channel, and use 
the Red, Green and Blue sliders to increase or decrease the pixel 
values for that channel. 

The Constant slider affects the luminosity of the currently selected 
channel. 

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings include:

• Range: This slider lets you narrow or widen the range of 
the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color 
range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to adjust the hue, saturation or brightness dynamically. 
To do this, click on the tool and choose which parameter you would like to adjust. Then click in your image 
on a color you would like to adjust and drag the cursor to the left or right to decrease or increase the effect.
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COLOR BALANCE

This filter lets you adjust the colors in a photo’s highlights, 
midtones and shadows tones. This can be useful when you wish 
to color grade a photo, remove color casts from shadows or 
highlights, or to create duotone- or tritone-style images.

To use the pane, click on the tone you wish to adjust (Highlights, 
Midtones, Shadows) and raise the Amount slider. After that, use 
the Hue and Brightness controls to adjust the look you wish to 
achieve. 

The Color patch, which will originally be represented as 18% gray, 
will change, representing the combination of all three sliders for 
that tone.

COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect 
and remove a color cast. It makes adjustments to the 
Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. 
Click the icon to activate, then click on an area in the 
image that should be gray. The sliders will automatically 
adjust according to the sample you have selected.

• White Balance: This pop-up lets you change the white 
balance according to common color temperatures 
(As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, 
Florescent, Flash, Custom). The default is As Shot, the 
color temperature that the camera recorded when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).
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• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors 
alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.
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CURVES

The Curves pane is a powerful—and advanced—tool for adjusting 
contrast, tone and color in your image. The buttons at the top of 
the pane let you adjust the composite RGB channel (All), or you can 
adjust the individual Red, Green or Blue channels independently, 
creating a number of targeted or special effects.

In the main part of the pane, the left side of the X-axis represents 
the dark tones in your image, while the right side represents the 
light tones. By clicking on the line at the center of the pane and 
dragging it up or down, you adjust those specific tones making 
them lighter or darker. (It is often helpful to keep an eye on the 
Histogram when making adjustments with Curves.)

The Style pop-up for the Curves filter has a number of options, 
including settings for color negatives, matte-style looks, and more.

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.
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FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

ON1 Photo RAW 2021 has a wide range of grain types from classic 
black-and-white negative films from Kodak, Ilford and Fujifilm. To 
add grain, choose from the Film drop-down menu.

The Amount slider controls the strength of the effect, while the 
Size slider adjusts the scale of the grain.

GLOW

This pane adds a soft-focus glow to the image, which can be 
accentuated by using different blending modes. The Styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall strength of the glow.

• Halo: Sets the radius of the glow effect; higher numbers 
create more ‘fuzziness’ to your image’s edges.

• Mode: Lets you set the blending mode for the glow 
effect.

GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Like the Dynamic Contrast 
filter, HDR Look will often benefit from masking or via blend 
modes. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Masking Bug to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.

• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.

• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has  a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. 

Photo RAW can import common LUT file formats, including .3DL 
and .CUBE file types.

• Category: This pop-up menu lets you choose from one 
of the pre-installed LUT categories, or any categories you 
have imported into Photo RAW.

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See “Extras” on page 26 for information on how to use the Extras 
Manager to import LUTs into Photo RAW.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied 
just to the color or chroma of the image.

• Detail: Controls how much edge detail is protected. Hold 
down the Alt/Option key to see the edge mask while 
adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on 
color or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range (or ‘fuzziness’) of the 
color range to apply the noise reduction to.
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PHOTO FILTER

This filter recreates traditional color lens filters used for warming, 
cooling, gradients and more. You choose the filter type from the 
pop-up menu at the top of the pane, then adjust the settings to 
your liking. Each type offers different options for selecting a filter 
color (or colors, in the case of the Bi-Color type), adding saturation 
or polarization, and more.

There are four Filter Types: Solid, Graduated, Bi-Color, and Center. 
The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong 
you want the effect, as well as a Saturation slider for boosting 
or reducing overall color. The Polarizer slider adds a polarization 
effect, which can sometimes help clear haze or enhance the blues 
and greens in an image.

The Bi-Color and Graduated filter types let you choose filter color 
(or colors), feather for the filter transition, and a direction for the 
effect.

The Center type works much like the Graduated option, with the 
difference being that the filter radiates from the center of your 
image, and you can choose the center to be either clear or colored.

REPLACE COLOR

This filter lets you select a color range and replace that range with 
one of a completely different color. When used with filter masks, 
you can achieve targeted color changes in a photo with ease, while 
retaining the other colors in the image.

The top section of the filter is used to select a target color, and the 
bottom section is where you pick a replacement color. 

First, use the eyedropper tool to select a color from your photo, or 
click on the color swatch to pick one from the color wheel. Adjust 
the Range slider to add or remove colors similar to your target. The 
Amount slider is similar to an opacity setting: anything less than 
100 (the default) will blend the new color with the original color. 
You’ll see the results in real-time, so you can get a good idea of the 
selection.

In the Color Change section, click on the swatch to set a new color, 
or use the Hue, Saturation and Brightness sliders to get the color you’re after. If you have areas where you 
don’t want the source colors changed, use the masking tools to paint the effect out.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Photo RAW 2021 offers three algorithms 
for sharpening, High-Pass, Progressive and Unsharp Mask. Which 
one you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the 
sharpening effect. Smaller amounts keep fine detail, 
while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the 
entire face. It is great for correcting overly yellow 
highlights, shadows that may be green or reducing 
redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.
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SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant. You can swap the Highlight 
and Shadow Colors by clicking the button to the right of the 
Highlight color.

The Mode pop-up sets the blending mode for the split tone. The 
options you can choose from are Normal (no blending), Color, 
Lighten, Darken, Multiply or Screen.

SUN FLARE

This filter adds realistic-looking sun flares, sun stars and bokeh 
overlays to a photo. You can resize, move and adjust the tone 
and color of the effect, and can also add toning similar to the 
standalone Sunshine filter. The Type pop-up lets you choose 
between the three options (bokeh, flare or star), and the Texture 
menu displays a range of options for the chosen type.

The Tone & Color section of the filter lets you adjust the 
brightness, saturation and hue of the current texture.

To move the position of the texture, click the icon next to the 
Transform label, then click and drag on the overlay to the desired 
spot. You can use the Scale slider to enlarge the overlay, and you 
can rotate or flip it by clicking on the icons to the left of the Fit to 
Canvas button.

The bottom of the Sun Flare pane includes a version of the 
Sunshine filter, letting you adjust the warmth and saturation of the 
overall effect. The Fade slider gives a matte look to the final effect.

NOTE: See “Extras” on page 26 for information on 
how to use the Extras Manager to import Sun Flare 
files into Photo RAW.
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SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.

TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Photo RAW 2021 comes with an extensive set of textures 
that you can add to your photos, ranging from fabric, metal, stone, 
text and more. You can also import your own textures directly 
into the Borders filter pane, or via the Extras Manager (available in 
Browse). Texture files can be almost any image format (JPEG, TIFF, 
Raw or Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top 
of the pane, used to help you narrow your texture search. There 
are nine texture categories, sorted by type, and any user-imported 
textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, 
saturation and brightness. Alternatively, if the texture is black or 
white, you can colorize it by clicking on the Colorize button in the 
bottom half of the pane.

The Transform section at the bottom of the pane lets you scale the 
texture up or down in size. You can also rotate or flip the texture 
by clicking the buttons at the bottom of the screen, which can be 
helpful to achieve the look you desire.

NOTE: See “Extras” on page 26 for information on how to use the 
Extras Manager to import textures (and other extras), along with additional 
information for preparing files for Borders and Textures.
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TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It offers similar 
controls to the Tone section of the Tone & Color pane, and also 
includes a curves dialog.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The curves dialog is a powerful, advanced tool for adjusting contrast and color. (See 
the section on Curves in the Develop section, on page , for more on adjust the curves.)

VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from 
square to round.

• Type: This menu lets you select a Normal, Subtle, or Soft 
vignette effect. The Priority option will let you preserve 
highlights when applying the vignette.
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The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.

VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century. 

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.

WEATHER

This filter adds weather-inspired overlays to a photo. The 
Precipitation section at the top lets you add rain or snow overlays, 
by choosing a type from the Texture pop-up menu. You can adjust 
the opacity of the effect, and can scale, flip or rotate the overlay 
via the Transform section of the panel.

You can also add fog effects to a photo. To turn this effect on, 
raise the Amount slider in the Fog section at the bottom of the 
pane. The Position pop-up menu includes a number of gradients 
for applying the effect (choose All to apply the effect to the entire 
image). Choose the one that is the best starting place for your 
photo.

The Distance and Transition sliders act upon the gradient, letting 
you choose the intensity and length of the Position gradient, while 
the Rotation slider lets you adjust the angle.
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RETOUCHING WITH PORTRAIT

Portrait AI was designed to help you retouch faces quickly and naturally, and with as little user intervention 
as possible. When you open a photo in the Portrait tab, Photo RAW automatically finds each face in your 
photo, analyses it individually, and adds just the right amount of retouching, based on your preferences.

Despite all the automation, you have full control over all aspects of retouching and finishing. Each face in 
your photo has independent settings and adjustments. You can manually adjust eye and mouth positions in 
each face, paint to refine the skin mask and use brushes to remove blemishes.

Portrait AI’s skin retouching uses frequency-separation techniques, which help to maintain natural skin 
texture while reducing color and tonal changes across the skin. It creates flawless, natural-looking skin.

In addition to skin smoothing and blemish removal, you can use Portrait AI to correct common errors in lens 
choice and lighting by adding fill-light to brighten the face or resculpt the face to thin the jawline. You can 
even adjust the eye size on each individual face.

The whites of eyes can be brightened and the iris can be sharpened, and there are automatic red eye 
removal options as well.  You can easily brighten the smile and adjust the color and saturation of the lips.

Portrait AI is easy to use: Faces tool in the Tool Well can be used to paint skin in or out—and the Portrait 
pane that contains settings for adjusting the skin, eyes and mouth in a face. Each face in your photo has its 
own pane, so you can adjust each face on an individual basis. 
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Inside the Portrait Pane
Each face in a photo will have its own Portrait pane, 
which contains the mask for the face, and settings for 
smoothing the skin, and adjusting aspects of the face, 
eyes and mouth.

You can view a face’s pane by clicking on the appropriate 
photo at the top of pane. (You can change the name of 
each pane by double-clicking on the ‘Portrait AI’ label at 
the top.) The top of the pane has the following items:

A.	Face selection: This includes the Add Face 
button and any faces found (or added) in your 
photo. Clicking on the face will select that 
face’s portrait pane.

B.	 Face and mask icons: The first icon is a small 
representation of that pane’s face, to help 
with identification in photos that have many 
faces in them. The mask is for that person’s 
face. To turn off all of the settings for that 
pane (to preview that face before and after, for 
example), click the control circle to the left of 
the face. If the circle is empty, it means that the 
adjustments are not currently applied.

C.	 Blending options, Reset and Delete: These 
icons are for changing the blend mode, to reset 
the pane to its original state, or to delete that 
portrait layer altogether.

D.	Opacity: Sets the overall opacity of the pane’s 
settings.

E.	 Style: Pop-up list of preset settings for that 
pane. The Default style uses Portrait’s Auto 
AI technology applying either Subtle or Strong 
retouching. (Subtle is the default AI approach, 
but this can be changed to Strong in the 
General Section of the Preferences window.) 
You can also save your own styles, based on 
individual preferences.

The bottom part of the Portrait pane includes four sections: Skin, Face, Eyes and Mouth. Each section 
has an on-off control circle immediately to the left of the label, which can be helpful if you don’t need to 
retouch the skin or the eyes, for example. The Skin section settings include:

F.	 Retouching: The amount of skin retouching, based on Portrait’s AI analysis of the face.

G.	Retouching Details: Clicking the triangle will give options for further adjustments to the 
overall skin retouching. (See page 157 for information on the options in the Details section.) 
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The Face section has four adjustments:

H.	Brightness: Adds to or removes brightness from the current face. 

I.	 Slim Face: Resculpts the face, slimming it along the jawlines.

J.	 Left Eye Size: Increases overall the size of the left eye.

K.	 Right Eye Size: Increases overall the size of the right eye.

The Eyes section has five adjustment options:

L.	 Brightness: Brightens the entire eye area; can be helpful when your subject is wearing a hat.

M.	Whitening: Whitens the eyes.

N.	Detail: Adds sharpness to the pupils.

O.	Dark Circles: Brightens circles and/or bags under the eyes.

P.	 Brow Enhance: Darkens the eyebrows.

Q.	Auto Red-Eye Removal: Clicking this button will apply red-eye removal to the eyes.

Clicking the icon to the right of the Eyes label will display an overlay with the eye control points when you 
move your cursor over the face. (See page 160 for information on adjusting the eye overlays.)

The Mouth section has four settings:

R.	 Teeth Whitening: Whitens the teeth.

S.	 Lip Vibrance: Increases the color in the lips.

T.	 Lip Brightness: Adjusts the brightness of the lips.

U.	Lip Hue: Adjusts the hue of the lips.

Clicking the icon to the right of the Mouth label will display an overlay with the mouth control points when 
you move your cursor over the face. (See page 160 for information on adjusting the mouth overlay.)

DETAILS

Most of the time, Portrait’s automatic AI-based skin-
retouching algorithms should do a good enough job 
that you shouldn’t have to do much more than adjust 
the strength of the Retouching slider to dial in your 
final settings (if at all). If you wish to adjust some of 
the parameters in the Skin section, click the Details 
triangle, and you’ll see a set of controls under the 
Frequency Separation section. 

These options include:

• Blemishes smooths facial elements, like 
fine lines and wrinkles. 

• Detail brings back some detail that might 
have been lost in the smoothing process. 

• Smoothing applies additional skin 
smoothing.

Clicking the triangle to the right of the Details label will open an 
additional set of controls you can use to fine tune the smoothing of the 
currently selected face.
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• Texture controls the amount of artificial texture applied as an overlay to the face.

• Shine lessens hot spots, evening out the skin’s tones.

NOTE: The Details pop-up contains two options, Frequency Separation and 
Surface Blur. The Surface Blur option is based on previous versions of ON1 
Photo RAW, and is solely included to provide backward-compatibility with 
presets created for those versions.

Portrait AI Workflow
Portrait AI was designed to automatically give you perfect retouching every time you open an image. As 
such, the basic workflow, for most images you will work with, is relatively simple:

1.	 Perform basic global edits in Develop (or your chosen image editing app, when using Photo 
RAW as a plug-in). This includes tone and color adjustments, as well as any noise reduction 
and lens correction. It’s best to leave sharpening to the final stages of editing.

2.	 Go to the Edit module and click on the Portrait tab, or, when using as a plug-in, choose 
Portrait AI from the appropriate menu in your editing app.

3.	 Go through each individual’s portrait pane and adjust individual settings as desired.

4.	 Use the retouching tools to remove or repair blemishes.

5.	 Apply any manual adjustments to the skin mask, or reshape the eye and mouth overlays, if 
necessary.

SUBTLE VS. STRONG PROCESSING OPTIONS

When ON1 Portrait AI 2021 applies its automatic retouching to a face in a photo, it uses one of two AI-
based processing options, Subtle and Strong. As its name implies, the Subtle setting—which is the default 
option—opts for a lighter touch when retouching. Strong applies a bit more processing than Subtle, but it 
still shouldn’t be over the top. Some situations might call for the Strong setting, or you might find that you 
prefer that setting. 

To change the default option, go to the General tab of the Preferences window, and choose the option you 
wish to use in the Portrait AI Default pop-up (see page 231).   

WORKING THE INDIVIDUAL PORTRAIT PANES 

Once Portrait has found the faces in your photo, select each face in turn by clicking on it in the face section 
at the top of the Portrait AI panel, or click on the pane itself. Work your way down the pane from the Skin 
section at the top, down to the Face section, and on to the Eyes and Mouth at the bottom. Making broad 
movements of the different sliders can give you an idea of how a setting gets applied, but be careful in 
making adjustments too strong, which can give your models a plastic look. Work in 100% view, so you can 
see the effects of your changes up close.

Portrait AI generally will do a good enough job in the basic skin smoothing and retouching that you 
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shouldn’t have to dig into the Details section; adjusting the Retouching slider left or right should often be 
all you need to do to fine tune the skin.  

NOTE: When working with multiple faces, you can name each Portrait layer 
individually by double-clicking on the word ‘Portrait’ in the title bar. 

USING THE RETOUCHING TOOLS

If you have portions of a face that have specific retouching needs (blemishes and other marks), use the 
Perfect Eraser, Retouch Brush, Clone Stamp or Healing Brush to make those changes. (See the Retouching 
Tools section, starting on page 102, for detailed information using on working with these tools.)

MAKING MANUAL ADJUSTMENTS IN PORTRAIT AI

Portrait uses sophisticated technology to find faces, but it’s not always perfect. Luckily, you have some 
tools to use to make further enhancements or adjustments beyond the controls in the Portrait pane. These 
include adjusting a face’s mask, to add or reduce the area that the retouching applies to, or making small 
adjustments to the areas around the eyes and mouth. In some very rare instances, you might find a ‘face’ 
that really isn’t a face, or that Portrait was unable to find a face. 

Fine-tuning a face’s mask

To keep Portrait’s retouching localized to each face, the app builds a mask for the face. Only inside the 
contents of the mask are the parameters of that face’s portrait pane applied. The rest of the image is 
‘masked out,’ meaning that the adjustments don’t apply to those pixels. The mask is represented by the 
mask icon at the top of each pane.

If you want, you can fine-tune a face’s mask retouching by painting skin in or out on your model as necessary with the Portrait AI brush. To 
view the mask, click the View Mask icon at the bottom of the window.
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When building a face mask, Portrait AI looks closely for the general contours of the face, but doesn’t 
include other skin. You might want to smooth some skin under the chin or on the neck, or you might want 
to paint out some areas—hair over the forehead—from the mask, so that they won’t be softened. 

You can view the mask for each face by selecting the appropriate pane and clicking the Show Mask icon at 
the bottom of the main Portrait AI window (to the right of the Before/After button). This will display the 
mask for the face, with a red overlay representing the area untouched by that pane’s settings. It will also 
select the Portrait AI brush, which you can use to ‘paint in’ more skin (enlarge the area), or ‘paint out’ areas 
that you might not want to have retouching applied. 

Next, you set the painting mode (Paint In/Paint Out), brush size, feathering, and opacity to make the 
changes to your mask. Performing your brushing with the mask view turned on helps show your progress. 
Use the Option key (Mac) or Alt (Windows) to change the brush mode in real time, to paint in and out with 
ease.

Adjusting the skin mask works best with the view mode on, and at 100% view (or larger, in some instances). 
When you’re done refining the mask, choose another tool and click the View Mask icon at the bottom of 
the screen to turn the mask off. 

Working with eye and mouth overlays

Portrait AI does an excellent job finding the eyes and mouth for each face in a photo, even three-quarter 
and side shots. For each feature, Portrait creates an overlay that functions similarly to the face mask. The 
eyes (or eye, if only one is in the photo) and mouth overlays define the boundaries of those features, and 
only the controls in the respective sections of each face’s pane are applied to those areas.

To view the different overlays on a face, click on either the Eye or Mouth icon to the right of that section’s 
label. When you move your cursor over the face, you’ll see the overlay for that feature.

Each overlay consists of a nodal point (in blue) and control points that define the boundaries of each 
feature. You can rearrange or modify the overlays: clicking and dragging the point lets you adjust the center 
of the overlay; clicking and dragging on any control point lets you readjust the boundaries of that area.

The mouth overlays are a bit more complex than the eye ones; they include control points for the top and 
bottom of each lip, which lets you adjust for the teeth. In most cases, you won’t need to adjust the overlays, 
but if you feel that you could get a better mask for either the eyes or the mouth, it’s best to zoom in fairly 
close, so you can adjust the overlay precisely.

Clicking the icon to the right of the Eye or Mouth label in a portrait pane will display the overlay for that feature. You can 
adjust the control points for each overlay by clicking and dragging them to reshape the area.
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Dealing with missing or ‘ghost’ faces

In the rare instance when Portrait doesn’t find one of the faces in your photo, click the Add Face button 
at the top of the Portrait tab. Then, position and size the box around the face you wish to add, and press 
Return, and the portrait pane will be created (and selected). When adding a face in this manner, you’ll need 
to manually add the eyes and mouth, and enable the different sections of that face’s pane. 

To add the eyes, click on the Eye icon to the right of the label. Then click the cursor in the center of 
each eye. When you’re done, Portrait will create the overlay for each eye, and you can readjust them as 
necessary. 

Adding the mouth is similar; click on the icon to the right of the Mouth label, and click on the corners of 
the mouth. Portrait will create the overlay, and you can adjust the control points to fit the contours of the 
mouth as needed.

Once you’ve added the eyes and mouth, you can work through the pane in the same manner you would 
with an automatically generated face.

Sometimes, you’ll find a pane that’s been generated for something that clearly is not a face. If you find one 
of these ‘ghost’ faces, right-click the ghost icon at the top of the Portrait AI panel and choose Delete Face.
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LOCAL ADJUSTMENTS
You can easily make local adjustments to portions of an 
image in ON1 Photo RAW 2021. You can apply these 
adjustments using either the Adjustment Brush or the 
Adjustable Gradient (or both, if desired). You can create as 
many local adjustments as you need on an image (by clicking 
on the Add Layer button at the top of the Local Adjustments 
section). 

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated 
vignette to an image. Local adjustments are in essence a 
mask that is applied to a portion of your image, and you can 
manipulate those masks in powerful ways with both the 
blending modes and the luminosity options in the Local tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), 
color (white balance, saturation and vibrance) and detail 
(structure and noise). Each local adjustment layer can have 
completely different settings and work on different parts of 
your image. You can also use local adjustments to paint with 
color over part of a photo, to perform specialized tasks such 
as skin retouching or to replace the color of an object. 

Like the rest of the Edit module, local adjustments are 
independent from the Develop, Effects and Portrait tabs; 
you can create a local adjustment while working in Develop, 
switch to Effects, and when you click on the Local tab, your 
local adjustments remain intact.

LOCAL TAB

To create a local adjustment, click on the Local tab. If there 
are no local adjustment layers present, Photo RAW will add 
one. If you want to add additional adjustment layers, click the 
Add Layer button. The top of each adjustment layer includes 
the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of canned styles for 
you to start with, including ones for lightening or 
darkening (dodging and burning), adding vibrance, 
fixing teeth or red eye, and many more. (You can 
also save your own styles via the More pop-up 
menu.)
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The main section of the Local tab has all of the same options found in the Tone & Color pane in the 
Develop tab: Exposure, Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation and 
Vibrance. In addition to those settings, the local adjustment pane includes a Noise slider, designed to help 
reduce noise on a targeted level (most often seen in the shadows).

These controls work the same way inside the Local Adjustments panel. One difference is that, since a local 
adjustment is actually a layer that sits on top of your global adjustments, ON1 Photo RAW 2021 provides 
you with a number of blending options for each adjustment. Blending modes determine how the selected 
layer blend with the items below it in the image stack.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options. The 
blending option controls are:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
also manually choose a color range by selecting the 
Dropper Tool in the pane and clicking on a color in 
your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, 
or saturation range specified. The Range slider 
expands or contracts the selected option, and the 
Highlights, Shadows, and Skin sliders protect those 
settings from your adjustments.

For detailed information on how the various blending modes work, see page 137

Painting with Color

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 

The Adjustment pane’s Blending controls give you extensive 
options for applying local adjustments to targeted tonal and 
color ranges in an image.
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The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a midtone section of skin, 
and, using a low opacity setting, paint over parts of the skin with the brush. This option is also useful when 
you are using custom brushes to add overlays to a photo. See page 165 for more on this.

WORKING WITH LOCAL ADJUSTMENTS

When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly 
to darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of 
the masking and blending options you have throughout Photo RAW, and you can use one or both tools—in 
addition to the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

TIP: To see the mask created by the Adjustable Gradient, choose Show Mask 
from the View menu. 

Manipulating a gradient mask 

Once you’ve added a gradient to an image, you can 
modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at 
the center of the gradient and drag. 

• To resize a radial gradient, click and drag on the 
solid line. 

• To adjust the feather (hardness) of the mask, 
click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near the gradient center and drag. 
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When working with local adjustment masks, all of the tools in the Refine group—the Refine Mask, and the 
Chisel and Blur tools—can be used to help give you create smoother and more realistic masks.

Other masking options

Every local adjustment has its own mask, and it uses the same masking options and controls found 
in throughout the Edit module. To access the mask, click on the mask icon in the title bar of the local 
adjustment layer. There you can copy and paste masks, create luminosity masks, and create masks based on 
color ranges. For specific details on how to work with these masking options, see “Masking Basics” on page 
105.

USING CUSTOM BRUSHES TO ADD OVERLAYS TO PHOTOS

One specialized use for local adjustment layers and the Paint With Color’s Solid Paint option is to add 
overlays with custom brush shapes. You can paint in stamps, watermarks, and other shapes to create 
specialized creations or enhanced photos. For example, you could use a custom cloud brush to add interest 
to a lackluster sky, or you could create your own watermark and apply it precisely. Photo RAW comes with 
a collection of custom brushes of all kinds, and you can import any black-and-white TIF file or Photoshop-
compatible brush file (.abr) for use in the app, via the Extras Manager (see ”Extras” on page 26).

Creating basic overlays with a custom brush is easy:

1.	 Create a new local adjustments layer by clicking on the Local tab.

2.	 If the Adjustment Brush isn’t selected in the Tool Options bar, select it, and choose a new 
brush from the Shape menu in the options bar.

3.	 Set the brush size and angle. In general, you’ll want to keep the Opacity and Flow high, and 
the Feather low (or 0), but that will depend upon the brush and the application.

Using custom brushes, available via the Brush Shape pop-up in the Adjustment Brush’s Tool Options bar, you can easily add realistic shapes as overlays 
to your photos.
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4.	 From the gear menu, turn the Manual Spacing option on. Depending 
upon the brush type and the application, you’ll have to play with the 
Amount slider, but the general rule of thumb is, for stamped brushes, 
where you wish the shape to be applied singly, set the spacing low. If 
you wish to apply the brush multiple times with a stroke—and have 
clear definition between the brush shapes—set the spacing higher (see 
the spacing chart below for an illustration of the different settings).

5.	 Turn the Paint With Color option on and set to Solid Paint. Choose a 
color for brush, and paint as desired on the image.

Tips for using custom brushes

• The best way to begin working with brush overlays is to practice. Use 
some of the default brushes, and play with them by adding them to a 
photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in Photo RAW is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

• The Paint With Color option applies to all brush strokes made on that adjustment layer. You 
can easily change the color via the color patch in the panel. If you want to apply the same 
stamp with different colors, create a new adjustment layer for each color.

This chart shows the effect of the Manual Spacing on a brush stroke for a star custom brush. With a spacing of 100, 
as you stroke, the stroke will be applied with plenty of space between the brush shape. With a spacing of 0, the 
shape will meld together as you apply the stroke. Depending upon the brush type, this might be acceptable for your 
purposes.

The Manual Spacing option is 
key when using custom 
brushes as stamps.
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PART 4: COMBINING PHOTOS WITH ON1 
PHOTO RAW 2021

For many photographers, editing in post-production doesn’t just mean working on a single image at time. 
When shooting out in the field they might capture multiple shots of a scene, to blend them later to achieve 
a greater dynamic range, to create expansive panoramas, or to build a perfectly focused scene from front to 
back. Or, they might be interested in creating sophisticated composites that can only be created within a 
layered workflow. For those photographers, ON1 Photo RAW 2021 includes a full set of combination tools 
to help them achieve their photographic vision with ease: 

• Layers: Photo RAW’s Edit module offers a full layered workflow, letting you create 
collages, perfectly blended composites from multiple images, and much more. (See 
page 168.)

• Panorama: The Panorama feature can create amazing, expansive views of a scene 
from two to 25 photos blending them together into a seamless whole. It can even 
create great panos from a handheld set of shots. You can even batch process a 
group of panorama shots. (See page 176.)

• HDR: This feature takes a group of photos shot at different exposure values 
and blends them to create photos that include a wider range of tones—from 
deep shadows to bright highlights—than can be achieved with a single shot. Like 
panoramas, Photo RAW’s HDR feature supports batch processing. (See page 
179.)

• Focus Stacking: Like the HDR feature, Focus Stacking takes multiple shots of the 
same scene, each shot with a different focus point, and blends them together into 
a perfectly focused final result. (See page 182.)

As is the case with all of the editing functionality in ON1 Photo RAW 2021, these features work non-
destructively. Your original photos are not changed, and the resultant, blended photos have all the re-
editability found throughout Photo RAW.
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WORKING WITH LAYERS

The Layers functionality inside ON1 Photo RAW 2021’s Edit module lets you create quick 
composites, blend multiple images together, paint in new skies or backgrounds, align 
layers based on their content, and much more. And, because Layers is tightly integrated 
within the Edit module, all of your work remains re-editable at all times: you can go back 
and add, change or update any setting made inside the Edit module, on any layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own. But more than that, each layer has its own non-destructive settings—just like any photo 
in Photo RAW, all the way back to the original raw data. That means you can use all of Photo RAW’s editing 
features—basic exposure changes, camera profiles, portrait retouching, Effects filters and more—as part of 
a layered photo.

When you add a layer to a photo, Photo RAW 
automatically creates a new document with an 
.onphoto extension, leaving your original photo 
intact. This document type, which is visible 
inside Browse, contains all the layer information 
and non-destructive editing operations made 
inside Photo RAW. (For information about the 
implications of using layered files with ON1 Cloud Sync, see “Using Layers with Synced ON1 Cloud Files” 
on page 175.)

The Layers feature inside ON1 Photo RAW 2021 is fully non-destructive. This means you can use all of the Edit module’s tools, tabs and filters, along with 
layer-independent masking capabilities, and still preserve your original photos—and can come back at any time to further enhance your creations. 
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Layers can be as simple as copies of the current photo, to apply more complex adjustments to portions of 
an image than you could with local adjustments. You can also add other documents as a layer inside the 
current document, for replacing skies or other backgrounds, for adding textures, or for when you wish to 
create complex collages. Photo RAW supports up to 14 layers in a document.

Once you have added a layer, the entire Edit module is available for that layer. When you click on a layer, 
you can add any adjustment from the four edit tabs, create masks, and more. You can use the Transform 
tool to move, rotate, and scale the contents of a layer independently from the complete document. 
(Because the Crop tool works at the document level, you can’t crop individual layers.)

ADDING A NEW LAYER

The easiest way to add a new layer to an existing image is to choose Add Layer from File item in the Layer 
menu. This will open the Add Layer window, which will two tabs in it: Extras and Folders. The Extras tab 
will display two folders, ON1 Extras and My Extras. The ON1 folder will include all of the Extras installed 
with your copy of Photo RAW, including backgrounds, textures, borders, skies, and more. The My Extras 
folder will include any similar files you have added to Photo RAW via the Extras Manager (as described on 
page 26).

If you wish to open a different file, click on the Browse button at the top of the Add Layer window, which 
will open your computer’s file selection dialog box, where you can navigate to the specific file. Any file 
compatible with ON1 Photo RAW 2020 can be opened and added as a layer.

When you choose Add Layer from File, a window appears with Extras and Folders tabs. The Extras tab contains backgrounds, textures (shown above) 
and borders supplied by ON1 with Photo RAW, as well as any extras you might have added via the Extras Manager. Clicking on the Folders tab (or the 
Browse button at the top right of the window) will let you browse your computer for photos and other supported files.
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Opening a layered Photoshop file

ON1 Photo RAW 2021 can open most layered Photoshop files in the Edit module. What happens depends 
upon the composition and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, Photo RAW will open the 
document inside Edit, with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles—Photo RAW 
will flatten the visible layers and will open the file as a composite image, with a single layer.

In either case, Photo RAW will convert the file to an .onphoto file, preserving your previous document.

NOTE: When using Photo RAW as a plugin to Lightroom, you can create 
layered files from multiple photos. See page 17 for details.

Creating an empty layered file

You can also start with a blank canvas, in either the Browse or Edit 
modules. Choosing New Canvas from the File menu opens a dialog box for 
creating a new file at whichever custom size you choose. When you click 
OK, Photo RAW creates a new .onphoto file with a single, transparent layer 
in it. You can then use any of the options detailed below to add photos and 
other extras to the file. (You can change the size of an existing canvas by 
choosing Canvas Size from the File menu inside the Edit module.)

Creating a Color Fill Layer

In addition to opening other document types, Photo RAW can create a new layer filled with a solid color, 
which can be quite useful when working with sophisticated composites or blend modes. Choosing Add 
Color Fill Layer from the Layer menu (or clicking on the Color Fill icon in the Layers tool bar) will open the 
system color picker, where you can choose a color for your new layer. You can change the color of any color 
fill layer by selecting it in the Layers pane and choosing Edit Color Fill from the Layers menu.

WORKING WITH THE LAYERS PANE 

The Layers pane has three sections:

A.	Layer Opacity: Reflects the opacity of 
the currently selected layer.

B.	 Layers: All of the layers in your 
document are listed here, with a 
thumbnail of the layer contents and the 
layer mask (if there is one); the currently 
selected layer has an colored outline 
around it (based on the Accent Color 
chosen in the System Preferences’ 
General tab). You can rename a layer by 
double-clicking on the title.

The New Canvas menu item is 
available in Browse and Edit.

The Layers pane in Photo RAW. This photo has three active layers.
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C.	 Layer Tools: The toolbar at the bottom of the Layers pane includes buttons for performing 
basic layer operations (described in more detail below). 

Layer Visibility 

A layer’s visibility can be turned on or off by clicking the button to the left of the layer thumbnail. When 
turned off, the layer has no effect on the composite image. 

Changing Opacity 

The opacity slider controls how opaque or how strong the selected layer is. The default is 100%. At lower 
settings, the layer will blend with the layer(s) under it. Altering the blending mode and opacity of a layer can 
create a wide range of color and tone effects. 

Changing the Layer Order 

You may change the order of layers by dragging and dropping layers into the order you prefer. 

Renaming Layers 

You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your 
preferred name and press Enter. 

Layer pane toolbar

All of the layer commands in Photo RAW can 
be accessed via the Layers menu and a pop-up 
menu that you get when you right-click on any 
layer. The toolbar at the bottom of the Layers pane, however, contains the basic commands you need when 
working with layers. From left, the icons represent:

• New Layer: Adds a new layer, opening the Add Layer from File window.

• Duplicate Layer: Makes a duplicate layer, including any Edit module adjustments made in the 
original .

• New Color Fill Layer: Creates a new color fill layer.

• Delete Layer: Deletes the currently selected layer.

• Merge Layer: Merges the currently selected layer with the one directly beneath it in the 
Layers stack.

• Blending Modes: Lets you select a blending mode for the current layer. (See page 137 for 
more about working with blend modes inside Photo RAW.)

Other layer commands, available via the Layer menu or pop-up, include:

• Reset Layer Properties: Deletes any layer masks or transform operations you have made to 
the current layer. To reset Develop, Effects, or Portrait settings or local adjustments made to 
a layer, click the Reset Layer button at the bottom right of the main Edit module window.

• Merge Visible: Unlike the Merge Layer command, this will merge all of the visible layers—
ones with the layer visibility status set to on—in a file into a single composite layer, with all of 
the merged layers’ effect applied.
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• New Stamped Layer: When you have the top layer in the stack 
selected, this option will create a new composite layer at the top of the 
stack, with all of the layers’ effect applied.

• Align Visible Layers: This will align the visible layers, based on the 
content of the layers. See page 173 for more information about this 
feature. 

Changing Blending Modes 

Blending modes determine how the selected layer blend with the layer(s) below 
it. The default blending mode is Normal. This maintains the full opacity of the upper layer. Layers also 
supports many other blending modes which can be used to alter the brightness, contrast and color of the 
image. See “Blending Modes” on page 137 for more detailed information on this topic. 

Layer Masks 

If you use any of the masking tools, a layer mask will be created automatically. Clicking on the layer’s mask 
icon will display the standard Photo RAW mask options, and you can use all of the Edit module’s masking 
tools to create or modify layer masks. You can also copy and paste layer masks—including masks from 
Effects filters—via the Mask options section or via the Mask menu. See “Filter Masks” on page 135 and 
“Masking Tools,” starting on page 94 for more on using Photo RAW’s masking tools.

Adding layers via Filmstrip view

In addition to the Add Layer options detailed above, if you are in Filmstrip view inside the Edit module, you 
can also drag photos from the strip at the bottom of the screen into the main window. This will create a 
new layer with that photo on it. (See “Working in Filmstrip View” on page 39 for more.)

NOTE: If the file you add is larger or smaller than the pixel dimensions of 
the document, use the Transform tool to resize it as desired. If you wish to 
preserve the original aspect ratio of the placed file, use the Shift key to resize it 
proportionally. 

USING THE TRANSFORM TOOL WITH LAYERS

Use the Transform tool (see page 86) at the top of the Toolbar to manipulate layers. A layer may be 
repositioned, sized or rotated using the tool. When selected, transform handles will appear on the edges of 
the selected layer. You use these transform handles to manipulate the image. You can only transform one 
layer at a time. 

Repositioning a Layer 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

Right-clicking on a layer 
brings up a list of available 
Layers operations.
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Resizing a Layer 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

Rotating a Layer 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 
Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer quickly in 90 degree increments, you can use the rotate left and rotate right buttons in the Tool 
Options bar. 

Flipping a Layer 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

NOTE: For detailed specifics on the Transform tool’s options, see page 86.

ALIGNING LAYERS

One of Photo RAW’s most advanced features is the ability to align multiple layers based on content. This 
can be a great aid when you’ve hand-held a group of shots, and want to blend portions of one image onto 
another, to use a better sky, for example. 

To align layers, open them in the Layers pane, and choose Align Layers from the Layer menu or pop-up 
menu. Photo RAW will then analyze the contents of the layers, and aligns them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content.

An example of Photo RAW’s layer alignment can be seen in the photos on the following page, which are 
handheld shots taken two days apart from the same location. The top photo is the base layer, shown after 
alignment, but with the second layer hidden.

The bottom photo shows the aligned layers, with a gradient mask blending the top part of the base layer 
with the bottom part of the other photo.  Despite the fact that the photos were shot days apart, Photo 
RAW has aligned the photos almost perfectly.
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The final aligned photos, blended together with a gradient mask from top to bottom. 

The base aligned layer. 
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USING LAYERS WITH SYNCED ON1 CLOUD FILES

If you wish to create a layered file with ON1 Photo RAW 2021 using a synced photo that resides on device 
other than the current device, you should be aware of two restrictions. 

First, because Layers requires the creation of a new file in ON1’s proprietary .onphoto format, this new file 
must be saved to the device it is being edited with. If you save this new file to a published folder or album, 
it will be synced. You will be able to edit the layered file on another computer running ON1 Photo RAW 
(see the section on working with existing layered files below for more).

Second, if the synced photo you wish to use is synced as an editable preview (as opposed to the original 
photo), Photo RAW will warn you that you will 
be working with a photo that has less fidelity 
than the original (see the dialog box on the 
right). For some uses, working with the preview 
might be good enough, but if you want to be 
sure that you are using the highest-quality base 
layer, either copy the file to your current 
computer, or change the sync option for the 
photo’s folder or album to Originals, and download that from ON1 Cloud Sync.

For more information on these settings, see “Managing Sync Options in Photo RAW” on page 74.

Using Existing Layered Files with ON1 Cloud Sync

If you create a layered file inside ON1 Photo RAW 2021 and sync it to the ON1 Cloud in any manner (folder 
or album, preview or original), that layered .onphoto file is fully editable on another synced device running 
Photo RAW. Any Edit module changes you make to that layered file on that device (on any existing layer), 
with the exception of adding or removing layers, will be synced back to the original file. If you add or remove 
layers, you will be prompted to save the newly edited file to the current computer.

Layered photos that have been synced to the ON1 Cloud are not editable on mobile devices using ON1 
Photo Mobile; they are viewable, however.
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STITCHING PANORAMAS
ON1 Photo RAW 2021 lets you stitch multiple images together to create a panorama, directly 
from within Browse. You can even batch process a group of panoramas. 

Panoramas are composite photos created from multiple individual frames of a scene (also 
known as ‘slices’). While they’re often thought of as wide, narrow images, panoramas can be 

horizontal or vertical, wide or compact. They give you a much higher quality final image, with added detail 
and a greater point of view. Photo RAW can create a panorama with as few as two images or more than 25. 

To create a panorama with Photo RAW, go to Grid or Filmstrip view in Browse and select the images you 
wish to use for your merger—or select a folder that contains the frames you wish to build into a panorama—
and click the Pano icon on the right side of the screen. 

Photo RAW will then display the Create Panorama window, which has two components: the Preview area, 
which displays the merged panorama, and the Options panel, which lets you adjust the type (spherical or 
collage) and the edges of your panorama; choose an output size (either 100% or 50% of the stitched file 
dimensions); choose a module to open the panorama after merging, and add panoramic metadata.

With most landscape-oriented panoramas, you will want to use Auto or Spherical projection type, which 
merges the photos as if they were mapped on the inside of a sphere. The Collage projection type lays 
merged photos flat (as opposed to mapping them on a curved surface), and is often called “scrapbook style.”

There are three cropping options available in the Edges pop-up menu: None, Crop and Warp to Fill:

• None will merge the panorama without cropping the finished image. 

• Crop trims the edges of your panorama to fit the best rectangular crop. 

• Warp to Fill uses ON1’s content-aware fill technology to stretch the edges of your scene to 
fill as much of the entire frame as it can, giving you bigger cropped area. 

ON1 Photo RAW’s Create Panorama window displays the projected panorama, and includes options for the type of merger, cropping options, file size and adding 
panorama-specific metadata. You can also specify which Photo RAW module in which you wish to open the finished panorama.
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Remember that no content-aware technology is perfect: If you use Warp to Fill option, make sure to check 
the edges of the frame after the panorama is built, making sure that there aren’t any smudged areas or bad 
fills. (It often works best on scenes with skies and large vistas, and less so on scenes with lots of detail at 
the edges.)

The Open In section of the Options Bar lets you choose what to do when your panorama has been built. 
You can stay in Browse, or open your finished panorama in either the Develop or Effects tabs.

The Add Panoramic Metadata option, when checked, will take advantage of the exploration features found 
in panorama-aware websites—like Facebook and Google—and apps, letting users click and spin around your 
panorama in real time.

When you click Save, Photo RAW will build your panorama, blending the exposures as necessary, saving 
the resultant file as an .onphoto file; it will then open it in the module of your choice (as determined by the 
Open In menu in the Panorama window.)

BATCH PROCESSING PANORAMAS

Processing a group of panoramas inside Photo RAW is easy: create a separate folder for each panorama 
you wish to build, putting the slices for that panorama in the folder. Then, in Browse, select the folders you 
wish to build, and Photo RAW will automatically go through each folder, building the panoramas using the 
default options: Auto, with edges cropped and built at 100% size. 

Each completed panorama will be placed in the same folder as the component slices.

TIPS FOR CREATING GREAT PANORAMAS

Creating panoramas can be a lot of fun, and can capture the grand vistas in a way that a single capture 
cannot. There are certain best practices that will help ensure you can create a great panorama:

• Use a tripod, and ensure that it—and your camera—are level throughout the entire arc of your 
scene.

• Lock your metering and your focus before you shoot: use the same aperture, shutter speed 
and ISO for all of the shots in your panorama.

• Overlap each shot by 50 percent, to give you plenty of data for which to build your final 
panorama.

• If your panorama isn’t quite what you had hoped for—especially in terms of exposure—
and you have enough overlapping frames, try removing a few frames and rebuilding the 
panorama.

• Once you’ve got your images in Photo RAW, perform basic edits on them in Develop and turn 
Lens Correction on. (Save styling for after your panorama has been merged.)
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PHOTO RAW PANORAMA EDGE OPTIONS

These panoramas demonstrate the three different edge options available via the Create Panorama feature. 
The top panorama was set to None, the middle to Crop, and the bottom the Warp to Fill. Because the scene 
included skies and grasslands at the edges, the Warp to Fill was able to add enough pixels to fill out the top 
of the panoramic frame.
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BLENDING HDR IMAGES
In addition to panoramas, ON1 Photo RAW 2021 has a second photo-merge feature: high 
dynamic range (HDR) photo creation. This feature lets you take multiple shots of a scene, at 
varying exposure levels—accurately capturing shadows, midtones and highlights in different 
frames across the series—and then blend them together to create a final image that has a 
much wider tonal range than a single shot could do. And, as is the case with the panorama 

feature, you can create multiple HDR composites via Photo RAW’s batch processing option.

To create an HDR image, go to the Grid or Filmstrip view in Browse and select the set of images that you 
wish to blend. Then click the HDR button underneath the module picker (or choose Create HDR from the 
File menu). You will then see the Create HDR window, which has the following options:

A.	The Preview window displays a rendition of your merged HDR image (and is resizable).

B.	 The Options bar has settings for adjusting ghosting, choosing a default look, and which 
module you wish the resultant image to open in.

C.	 The Reference panel includes the images used to build the HDR, with their exposure values 
relative to the base image. The image with the outline is the base version used for deghosting; 
the base image for exposure is represented by the lens aperture icon next to the checkmark.

D.	The Tone & Color pane from Develop (see page 123) and the HDR Look pane from Effects 
(page 146) are present to help you tune your image.

E.	 Save/Cancel buttons.
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Once the Create HDR window is open, you can use the various options to tune your image. You can adjust 
the base image: clicking on the different frames in the Reference panel will choose a different base image 
for deghosting; to select a different base 
exposure image, click on the small lens aperture 
icon in a different image of the series. (By 
default, Photo RAW chooses the image it felt 
was closest to the middle of the series for both 
exposure and deghosting.)

The Default Look options are also designed to 
help get you started, corresponding to style 
options in the Tone and HDR Look panes. 
Natural and Surreal use those styles from the 
HDR Look pane, and the Natural Auto and 
Surreal Auto options also add the Auto Tone 
option from the Tone & Color pane. They are only designed to be a starting point: You can override any of 
the options by adjusting the settings in the two editing panes.

The deghosting section of the Options bar has options to blend portions of the frame that might have 
shifted during the image series (things such as clouds, flowing water or moving branches). Depending upon 
the amount of ghosting, you can choose from four levels of deghosting (or none). If you wish to see those 
areas in your image that will need deghosting applied to them, click the Show Ghosting button. Those areas 
that have ghosting issues will be shown with a red overlay. Depending upon how much movement there 
was in your scene, you can then choose the appropriate level of deghosting, or, in some instances, cancel 
and choose a different set of images to blend into an HDR.

The Align button in the Options bar is on by default, which means that, during the HDR generation process, 
Photo RAW will attempt to automatically align the images, based on their contents. Turn the Align button 
off when the alignment process results in a bad composite, or when you don’t want Photo RAW to align the 
images (when working with star photography, for example). With the Align feature off, Photo RAW will use 
the selected base image for the HDR process.

The Open In section of the Options Bar lets you choose what to do when your merged HDR file has been 
built. You can stay in Browse, or open your finished panorama in either the Develop or Effects tabs.

Once you have your settings adjusted to the 
way you’d like them, you can click Save and 
Photo RAW will build your HDR, saving it in 
the .onphoto file format and opening it in the 
module of your choice. The beauty of Photo 
RAW’s HDR engine is that any of the edits 
you make to your image in the Create HDR 
window are reflected in the Tone & Color pane 
in Develop and the HDR Look pane in Effects. 
Because ON1 Photo RAW is non-destructive, 
you can re-edit your HDR to fit your wishes. If 
you decide that you wish to use a different HDR 
Look style, or want to add additional effects to 
your photo, you simply open the image in the 
appropriate module and edit.

The first time you launch Photo RAW’s HDR feature, you’ll be presented with 
this window, showing the different HDR toning options found in the Create 
HDR window. Once you’ve built your HDR file, you can go into the Edit module 
and edit any of the settings, add other filters and more.

The Create HDR preview window, with the Show Ghosting option turned on. 
Areas that have ghosting issues will be shown with a red overlay.
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BATCH PROCESSING HDR IMAGES

The HDR batch processing option lets you take a folder containing multiple sets of bracketed shots from 
a shoot, and automatically turns them into HDR photos ready for editing. The process creates separate 
.onphoto files that can be opened directly in the Edit module. 

To do this, create a separate folder for each HDR composite you wish to build, putting the different 
exposures into that folder. Then, in Browse, select the folders, click the HDR button and Photo RAW will 
automatically go through each folder, building the HDR composite using the default options. Each 
completed HDR image will be placed in the same folder as the component photos.

To batch process a group of different bracketed shoots for HDR creation, put the bracketed images into separate folders, and in Browse, select the 
group and click on the HDR button.
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FOCUS STACKING
When working in the field, achieving perfect focus in a photo from the foreground to the 
background can be difficult, if not impossible to achieve. With ON1 Photo RAW 2021’s Focus 
Stacking feature, you can blend a series of photos taken at different focus distances, giving  
you more depth of field than any single photo. And, you can adjust the focus in real-time, just 
like changing the focus on your lenses. Think of it like HDR, but for focus instead of exposure.

Like the Panorama and HDR features, you generate a focus-stacked photo in the Browse module. Simply 
select the photos that you wish to blend and click on the Focus icon in the selector on the right side of the 
window. This will launch the Focus Stacking dialog, which has the following components:

A.	The resizable Preview window displays a rendition of your blended focus-stacked photo.

B.	 The Options bar has settings for aligning photos; an option to create a final layered file (with 
masks); which module you wish the resultant image to open in; adjusting the depth of field; 
and for fixing problem areas between the base photos in similar areas.

C.	 The Reference panel includes the images used to build the focus-stacked image, with their 
focus values (taken from the photo’s metadata, if available). Clicking the check box on an 
image removes it from the focus operation.

D.	Save/Cancel buttons.
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If there is focusing metadata in the source images, Photo RAW will display the sources from closest to 
furthest, with the focus distance listed, and the Preview window will show the suggested final photo. Photo 
RAW will automatically try to create the greatest amount of depth of field possible, but you can use the 
Depth of Field slider to constrict the depth of field in the blended result. For example, if you wanted less 
sharpness in the areas that are closer, move the left slider; for less sharpness in the distance, move the right 
slider in. To get back to the maximum focus, click on the Max button.

The Despeckle slider can be used when you have some movement in parts of a scene between your base 
images, such as movement of leaves in a stand of trees. Increasing the Despeckle amount can sometimes 
help in removing ghosted elements or distractions.

The Threshold slider reduces noise in smooth areas of the image set, although it may knock out subtle 
detail if driven too hard. Sensitivity biases the decision of final “winner” (which image is declared sharpest) 
for each pixel. Low values rely more on low-frequency portions of the image, where high values leverage 
high-frequency aspects of the image and may help reduce noise. Adjusting these are similar to adjusting 
noise reduction, you are looking for the best compromise of the the two.

When you have the result you desire, click the Save button, and Photo RAW will blend your source photos 
together and create a new photo saved in the .onphoto format. Depending upon your choice in the Open In 
portion of the Focus Stacking window, the photo will open in Browse or the Develop or Effects tab. If you 
chose the Layered Results option, all of the separate images will be displayed in their own layer, with the 
layer masks attached. 

Like all other image types inside Photo RAW, you can edit focus-stacked photos non-destructively in any of 
the Edit module tabs.



ON1 Photo RAW 2021 User Guide	 Part 5: Output and Sharing	 184

PART 5: OUTPUT AND SHARING
While editing and organizing your photos are probably the most important tasks you’ll do on a regular basis 
inside ON1 Photo RAW 2021, there will be times when you want to “do something else” with your photos. 
Whether it’s enlarging photos for high-quality prints, sharing your photos with others or on social media, or 
printing to your desktop printer, Photo RAW has all the functionality you’ll need to get your photos where 
you want them to be. 

In this section, you’ll find detailed information on the following topics:

• ON1 Resize: The industry standard for image enlargement and printing. (See page 185)

• Export: The power of Resize in a quick and easy-to-use panel, letting you export your photos 
with flexibility, ease and control. (See page 201)

• Print: Print your photos in any size, as individual photos, or in contact sheet form. (See page 
206)

• Share: A quick way to share your photos, including via SmugMug. (See page 212)

• Send To: Edit photos in other photo apps. (See page 212)
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ON1 RESIZE
ON1 Resize lets you get the highest quality enlargements of your photos, using the 
patented, industry-standard Genuine Fractals algorithms to enlarge photos without the loss 
of sharpness or detail. It includes the following features:

• Complete control over adjustment size and resolution

• Crop to common preset sizes for different paper and screen sizes

• Multiple resize algorithms let you get the highest quality results with any subject matter

• Perform precise print sharpening, and add film grain

• Add gallery wrap wings for printing on canvas

• Divide an image into tiles for printing mosaics or murals

• Hundreds of presets to create the desired size print and adjust options for your printer

When Should I Use ON1 Resize?
ON1 Resize should be used as one of the last steps in your workflow before printing. The power of ON1 
Resize is in the concept of resolution on demand. You can work with a modest size file, which makes your 
editing faster and takes less hard drive space and memory. Then when you are ready to output your file, 
you resize it with ON1 Resize to the desired size and sharpen it for output. This means you don’t have to 
keep multiple versions of a file at different print sizes; you just create what you need on-the-fly. ON1 Resize 
also supports layered Photoshop files so you can maintain all your layers in the entire process.

NOTE: A fuller discussion of resolution and print size can be found in “How Big 
Can I Print?” and “How Much Resolution Do I Need?”, starting on page 199.

USING RESIZE WITH ON1 CLOUD SYNC FILES

To use Resize with a file that resides on device other 
than the current device, you should be aware of two 
restrictions. First, Resize requires the creation of a 
new file, and this new file must be saved to the device 
it is being edited with. 

Second, if the synced photo you wish to use is an 
editable preview, Photo RAW will warn you that you 
will be working with a photo that has less fidelity than the original. If you want to be sure that you are using 
the highest-quality base layer, either copy the file to your current computer, or change the sync option for 
the photo’s folder or album to Originals, and download that from ON1 Cloud Sync.

For more information on these settings, see “Managing Sync Options in Photo RAW” on page 74.
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ON1 Resize Main Screen Overview

Below is an overview of the main sections of the ON1 Resize window:

A.	Tool Well: This is where the tools are located.

B.	 ON1 Cloud Sync Status/Settings/Help: Icons for displaying ON1 Cloud status, preferences 
and help. The button at the bottom shows/hides the Presets pane.

C.	 Presets: Contains a library of presets for different printers, paper types and print sizes.

D.	Search: This is where you can search for presets.

E.	 Preview Window: This is the main section where you preview and work on images.

F.	 Zoom view/Soft Proofing: The slider sets the zoom level; the icon turns soft proofing on or 
off.

G.	Tool Options bar: Lists options for the currently selected tool. 

H.	Navigator/Levels/Info Pane: Navigator, levels (histogram) and general photo information.

I.	 Pixel Dimensions: Displays the pixel dimensions of your image.

J.	 Document Size: This is where you set the size of your resized photo.

K.	 Settings: Primary section for adjusting Resize’s scaling algorithm.

L.	 Control Panes: Access image settings, sharpening, film grain, tiling and gallery wrap options.

M.	Cancel/Done: Buttons to reset, cancel and/or close your image.

N.	Module Selector: Takes you to Browse or Edit.

O.	Export/Share Buttons: Export or share your image (separately from Resize).
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Navigating the Preview Area
The Preview area is the main section where you preview and work on images. You can use the View tool for 
navigating this window.

This tool, which is the default tool selected when you open an image in the Resize module, adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in the Preview 
window to zoom in and center the image at the location clicked. 

Hold down the Option/Alt key to pan around the magnified image. You can also double-click the View tool 
in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows every pixel. This is best 
when examining small details, and when previewing the effects of Resize’s sharpening on your photo.

NAVIGATOR, LEVELS AND INFO

At the top of the control panel on the right of the main window are the Navigator, Loupe, Levels, and Info 
panes. These four panes can be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image. The white 
square region marks the image area that is visible in the 
preview pane. You can pan view by clicking and dragging 
inside the white region.

At the bottom of the Navigator pane are several Zoom 
presets. Click on a Zoom preset to activate.

• FIT: Zooms to fit the current canvas size.

• 100: Zooms to 100% or actual pixels.

• 50: Zooms to 50%

• 25: Zooms to 25%

The Levels Pane

This gives you a color chart of the shadow, mid-tone and 
highlight areas based on the image RGB values (often called 
a histogram). This is useful to show areas within the image 
that may be clipping. Clipping is when your image contains 
pure blacks or white and can signify loss of highlight or 
shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of each end is a triangle. If the triangle is lit, there is 
clipping on that side of the histogram. If you click on the arrows, you will activate the clipping overlay on 
your image. The areas of your image with a blue overlay are pure black, while the areas with the red overlay 
are pure white. You can turn the clipping view off again by clicking on one of the triangles. You can also 
temporarily enable clipping view by holding down the J key at any time. The clipping view is useful when 
you are making adjusts to the brightness and contrast of your image.



ON1 Photo RAW 2021 User Guide	 Part 5: Output and Sharing	 188

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

The Info Pane

The info pane displays photo metadata, including:

• Camera type

• File type

• Focal length and lens information

• Date and time captured

• Exposure information

• ISO

• Shutter Speed

• Aperture

• Exposure Value

• Filename

• Color Space

• Dimensions

• File Size

CROP TOOL

The Crop tool is used to crop and resize the entire image. Unlike the non-destructive Crop tool in the Edit 
module, Resize’s Crop tool removes pixels outside a crop box and changes the canvas size at the same time.

To crop the image, select the Crop tool. Then adjust the corner handles of the crop tool overlay. The area 
outside the crop box appears darkened for guidance. You can resize and move the image inside the crop 
box. When you are satisfied, press the Apply button in the Tool Options bar or press Enter.

The Crop Overlay in Resize.
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Working with the Crop Tool Overlay

• Moving the Image: To move the image inside the crop box, click and drag inside the box. You 
can also nudge the image using the arrow keys on your keyboard.

• Resizing a Crop Box: To resize the Crop Box, click and drag on any of the resize handles. 
Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on a side 
handle allows you to adjust that side. If you hold the shift key down while adjusting the size, 
the proportions of the box are maintained. To rotate the crop box, move outside a corner 
until the tool changes to rotate. You can also set the aspect ratio or size of the crop box in the 
Tool Options bar.

Crop Tool Options Bar

• Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Units: Determines the unit of measure: Pixels, inches, centimeters, etc.

• Leveling tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotate: Rotates the image 90 degrees.

• Cancel: Resets the crop tool.

• Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop tool works in three modes, which are all accessible via the Preset 
pop-up in the Tool Options bar:

• Freeform: In this mode you can adjust the crop box any way you like. 
The image will not be resized. Any area outside the crop box will be 
trimmed off. Use this mode if you just want to change the shape or 
recompose your image for general use.

• Aspect Ratio: You can lock the crop box to an aspect ratio. This 
makes sure the crop box shape doesn’t change, just the size. Use 
this option to trim existing pixels while maintaining a ratio without 
resizing the image.

• Document Size Presets: These let you crop and resize your image 
at the same time. If you know your intent is to print the image at 
a certain size you can crop and resize the image at the same time. 
Many common sizes are included plus you can create your own.

The Crop tool preset pop-up 
includes options for nearly every 
aspect ration or print size.
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Leveling the Image

The Crop tool has a special Leveling tool for automatically rotating your image to be level. To access it, first 
select the Crop tool, then perform the following:

• Select the Leveling tool from the Crop tool options bar. Your cursor will change to the 
Leveling tool.

• Click and drag a line across your image that should be level, either horizontally or vertically. 
When you release the mouse the image will be rotated automatically to the correct angle.

ADJUSTING THE IMAGE SIZE

In Resize, you can adjust your image size using either the 
Document Size pane or the Crop tool options bar. The information 
in these areas are interrelated and locked together. Adjusting the 
values in either pane will lead to changes in the other pane.

The Document Size pane displays the current desired Document 
Size, or the original size if you have not adjusted anything. Type 
into the Width or Height fields to change the Document Size.

The Width and Height fields are locked together to maintain the 
photo proportions. Changing the width will change the height 
proportionally. Resize does not support non-proportional scaling. 
If you would like to change the proportions of the image, use the 
Crop tool.

NOTE: If you need to stretch a photo non-
proportionally, use the Transform pane in Develop. 
(See page 86 for more.)

The Document Size Presets make it easy to crop and resize your photo at the same time. Simply select one 
to set the width and height automatically. This also selects the Crop tool, so you can adjust the document 
size to fit your photo. You also control your resolution, known as pixels per inch or dots per inch. This is 
important to adjust based on your output device.

The Pixel Dimensions pane displays the image size in pixels, the file size, bit-depth and scaling factor.

Using Document Size Presets

Document size presets allows you to crop and resize your image simultaneously. Often, when you are using 
ON1 Resize it is to create a file for print output at a known common size. In these cases, using a Document 
Size Preset can be the fastest way to set your Document Size and crop your image to the needed 
proportions.

Follow these instructions to use a Document Size Preset:

1.	 Select your desired size from the Document Size preset pull-down in the Document Size 
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pane, or Crop tool Options bar. You will see that the Document Size fields will be completed 
automatically for you and that a crop box is drawn on your image matching the proportions 
of the document size preset that you selected.

2.	 If needed, select the rotate crop box to rotate your 
crop box to the proper orientation. It will automatically 
rotate to match the orientation of your image, but if you 
want to crop differently you may need to rotate it.

3.	 You can use the Crop tool to reposition and change the 
size of the crop box so that it contains the image area 
that you want. Note that the crop box proportions and 
Document Size are locked so that you will always have 
the finished document size that you requested.

4.	 Adjust your resolution to what is needed for your 
output device. If you are unsure what to select, use the 
resolution drop-down menu for common settings.

Resize comes with many commonly used print, paper and video document size presets but you can also 
create your own:

• Select your image and launch Resize.

• From the Document Size Preset pull-down, 
select Custom > Manage Custom Sizes.

• Click on the Add button.

• Double-click on the highlighted untitled name 
and name your preset.

• Double-click on the width and height and fill in 
the proper values.

• Click on the units and select the proper unit.

• Click on the OK button.

TIP: If you select the incorrect Document Size Preset you can change it by 
selecting a different one. If you do not wish to use a Document Size Preset 
after you have selected one you can press the Reset button in the Document 
Size pane or the Cancel button in the Crop tool options bar. 
 Also, the Lock Crop option locks the proportions and document size settings 
for the given crop. This is on by default when you use a Document Size Preset.

The Photographic Document preset category 
contains many traditional print sizes.

You can easily create your own custom print size presets inside 
Photo RAW.
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SETTINGS PANE

The Settings pane contains the controls for selecting the 
resizing method, or algorithm and its settings. Every image is 
different and selecting the correct settings here can improve 
the quality of the results. 

Image Type

To help you get started, try one of the presets in the Image 
Type drop-down menu. This pop-up contains presets for 
different image categories (portraits, landscapes, etc.). 
Choosing one will adjust the settings for Texture, Threshold 
and Smoothness automatically.

Method

The Method drop-down selects the method, or algorithm, used to resize 
the image. The options are:

• Genuine Fractals: This is the classic, patented, fractal-based 
algorithm that has made Perfect Resize the standard for over a 
decade.

• ON1 Resize Portrait: This is a new variation on the Genuine Fractals algorithm designed for 
portrait images. It is slightly softer and does a better job representing skin and hair textures.

Texture Controls

When you select the Genuine Fractals method there are several other controls—Texture, Threshold, and 
Smoothness—that tune the resizing algorithm based on the image. These all have to deal with the texture 
of the image. If you were to analyze an image from a detail perspective you could break it into three 
categories: Edges, Continuous Tone and Textures.

Edges are the sharp details that define the edges of the subject in your image. It’s paramount that these be 
maintained in order for your enlargement to maintain quality. Continuous tone areas—like skin or skies—are 
mostly solid or graduated color. These resize easily as there is little detail in these areas.

Texture, in Resize’s nomenclature, are the areas that fall between these two. They are areas that still 
contain detail but are not sharp edges. These are things like the surface of rocks, tree bark, fabric, animal 
fur, etc. The amount of detail in these texture areas can have a large impact on the perceived sharpness and 
quality of an image.

With ON1 Resize you can control the key algorithm variables that effect these areas. And, you can use 
presets for different image types and subject matters that help you get the best results in reproducing 
these textured areas.

Here’s how to think of the sliders in the Settings pane, as you adjust the look of an image:

• Texture: This controls the amount of detail in flat, non-edge areas of an image. If your image 
contains lots of small detail that does not have defined edges (many organic patterns like 
leaves, rock, bark; or man-made patterns like fabric) it may be good to increase the amount 

Options for the Settings pane’s Image 
Type menu.
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to a setting of 4 or 5. Settings beyond 5 will often introduce a bumpy noise pattern which 
is undesirable unless your original image was from scanned film. Settings lower than the 
default 3 are useful for images with large areas of continuous tone that have no appreciable 
detail (sand, snow, sky) but have hard edged foreground subjects such as landscape images, 
architecture or portraiture.

• Threshold: This controls the amount of hard edge detail that is enhanced. The default setting 
is 25. Decreasing the threshold will focus the algorithms on edge information. This may 
be useful for portraiture or for reducing noise in your image. Settings higher than 25 will 
increase the amount of small detail in flatter areas of the image. Settings as high as 100 are 
useful for highly detailed images (hair or feathers). Higher threshold settings will also make 
ON1 Resize process faster. A good way to start adjusting these controls is by setting the 
threshold to 100 and then move the Amount up until the image is too noisy (bumpy) and then 
reduce the threshold to smooth out the noise in continuous tone areas. For detailed images 
with no little or no continuous tone, you might try the amount at 4 and the threshold at 
100. For portrait images or images with JPEG artifacts you should try an amount of 2-3 and 
threshold of 25 or lower.

• Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use 
the lowest setting needed.

The last item in the Settings pane, Preview Using Genuine Fractals at 100%, will use that algorithm to 
preview quality at 100% zoom, so you can more accurately adjust the items in the settings pane, as well as 
controls in the Sharpening pane.

SHARPENING PANE

The Sharpening pane contains the controls to add additional 
sharpness to your image.

ON1 Resize features three sharpening methods:

• Unsharp Mask: Good for general sharpening. 
Similar to Photoshop’s Unsharp Mask function. 
Resize’s sharpening is different in that it is only 
applied to the luminance of the image, to prevent 
color artifacts.

• High Pass: High Pass sharpening is helpful when 
the original image is not sharp.

• Progressive: Similar to Unsharp Mask, except it 
sharpens different amounts depending on the 
size of the details in the image. Small details are 
enhanced more than large ones.

Using the Sharpening controls can save you the workflow 
step of adding additional Sharpening before printing and can help compensate for loss of sharpness due 
to dot gain from your printer. Sharpening should only be applied at the end of your workflow just before 
printing. If you plan to do additional retouching or compositing work after resizing your image, you should 
disable the Sharpening controls.
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To sharpen your image for output, use these steps after you have adjusted the Document Size pane 
controls:

1.	 Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2.	 Enable the Sharpening controls by toggling the on/off control in the pane’s title bar.

3.	 Select the sharpening method that will provide the best results for your image. You may 
need to experiment to determine this.

4.	 Adjust the amount slider to determine the amount of sharpening desired.

5.	 Use the Highlight and Shadow sliders to limit the sharpening from being applied to the 
darkest and lightest areas of the image which can prevent sharpening of noise.

6.	 Similarly, adjusting the Skin slider can help protect skin tones from being oversharpened in 
the resizing process.

FILM GRAIN PANE

The Film Grain setting controls the amount of simulated 
Film Grain (noise) to your image. Adding a modest amount of 
grain can make your image appear sharper visually and can 
help hide imperfections (such as JPG artifacts).

Adding film grain can be especially useful for monochrome 
images, and should be added just before printing. If you need 
to do other retouching or compositing work in Photoshop or 
Layers after resizing your image, you should disable the Film 
Grain controls in Resize.

To add Film Grain to your image follow these steps:

1.	 Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2.	 Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.

3.	 Adjust the slider up or down until the desired amount of Film Grain is added.

You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.
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TILING PANE

The tiling feature in Resize divides an enlargement into smaller pieces so that the image can be printed 
on a smaller printer. For example, you might want to create a mural that is 8 feet tall by 12 feet wide, but 
your printer can only print 24-inch wide strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you have to print on and if you would like the 
pages to overlap. Then ON1 Resize will resize your image and section it down into the individual tiles.

To use the Tiling pane:

1.	 Turn Tiling on by toggling the on/off switch in the pane header.

2.	 Set the Width and Height fields to the size and orientation of paper that you wish to print 
on, or you can select the number of rows and columns instead.

3.	 Set the Overlap size. The overlap makes each tile overlap so you can tape multiple panels 
together and corrects for printer margins if you are not printing borderless.

4.	 Set the file type for the newly created files for each tile.

5.	 Set the destination folder for the new files. Each file will be named with the original filename 
and the tile indicated in the filename.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will 
tell you how many tiles will be created.

When you want to print big, but lack the big printer, Resize’s Tiling feature lets you create flexible, tiled prints on smaller paper sizes.
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GALLERY WRAP

The Gallery Wrap feature is designed to help you print on canvas. When making enlargements for canvas it 
is common to wrap a portion of the image around wooden stretcher bars. These can be several inches thick 
and help mount the canvas. These are commonly called gallery wraps. However, if you had important detail 
near the edges of the image, it might be lost in the wrapping process. ON1 Resize’s Gallery Wrap feature 
automatically creates extended margins by reflecting or stretching the areas near the edge of the image 
without having to sacrifice any of the original image. You can select the thickness of the mounting bars and 
use different options for creating additional margins.

To use the Gallery Wrap feature:

1.	 Turn on the Gallery Wrap feature by toggling the on/off switch in the pane’s title bar.

2.	 Set the Thickness control to the amount of margins you would like to add. A good rule of 
thumb is to use the thickness of the stretcher bars, plus half an inch.

3.	 Select the Type you would like to use (see the list below for details on the different options).

4.	 If you wish to add a color overlay to the gallery wrap wings set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general-purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 

The Gallery Wrap feature lets you choose from four different wrap types,with adjustable thickness and opacity settings for the edges to be wrapped.
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to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders. 
(The Opacity’s default is 0, which means that there is no color overlay added.)

PRESETS

Resize has a preset system built into it, much like the one used 
by Develop and Effects, but which is designed to help you get 
very specific crops for a wide range of paper and printer types. 
These include settings for photo lab print sizes, and many 
Epson, Canon and HP large-format printers, with Matte, Resin 
Coated, and Canvas types.

In addition to being able to set document size and settings, 
and settings in any of the other panes, Resize presets always 
contain a Crop adjustment. What that means is that any time 
you apply a preset, Resize selects the Crop tool and places 
the crop overlay on top of your file. There, you can move the 
overlay to the appropriate crop area (or resize the crop) for your 
photo.

To apply a preset, choose the category you would like to use 
from the Presets panel. The category will expand to a list of the 
available presets for that group. Then, just click on the preset 
you want to apply.

Saving a Preset

Once you have your settings that you wish to save, go to the 
Preset menu and select Save Preset, and choose a category you 
would like to save it in. If you have applied a preset to an image 
and make adjustments to any of the settings in the left panel, 
you can update that preset with the new setting by choosing 
Update Preset with Current Settings from the Preset menu.

To delete a preset, right-click on the preset in the Presets 
Browser and choose Delete Preset.

NOTE: You can also import and delete Resize presets from within the Extras 
Manager. See “Extras” on page 26 for more.
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SOFT PROOFING IN RESIZE

ON1 Photo RAW’s soft proofing feature lets you see how a photo will look when printed, using the color 
profiles that get installed with your printer. Soft proofing helps you determine where there might be issues 
when you print, so that you can adjust your tone, color and effects to give you a print that is closer to your 
editing vision.

Normally, when you’re viewing an image in Photo RAW, 
you are viewing it through the lens of your monitor’s 
display profile. The color gamut of your computer’s 
display is wider than that of most photo printers, which 
means that some colors you are able to view on-
screen are not reproducible when you print. When this 
happens, the color profile conversion that happens in 
the print engine will cause substitutions of colors that 
the printer cannot print to the closest color that it can. 
This means that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by 
clicking on the soft proofing icon to the left of the 
Preview button at the bottom center of the main Resize 
window. The background of the main preview window 
will change to approximate the color of the paper you’re 
profiling. 

Additional soft proofing options are available 
underneath the Enable Soft Proofing command in the 
View menu. The options are as follows:

• Gamut warning: When checked, this displays 
colors in the image (via a red overlay) that 
don’t correspond to the current printer profile 
being soft proofed.

• Profiles: The Profiles submenu lists the 
currently available printer profiles. Choosing 
one will change the on-screen display to use 
that profile.

• Intent: Photo RAW offers two different 
rendering “intents” when soft proofing, 
which are used to convert the color from 
display to print. Perceptual shrinks the color 
gamut during the conversion, which works to 
preserve the relationship between colors in 
the image. The other intent type, Relative, only 
converts colors that are outside the current 
color gamut, but this can sometimes cause 
two colors, one in gamut, and one outside, to 
be identical after conversion.  

These three screen shots show the results of soft proofing options, 
as viewed in Resize. The top image is with soft proofing off (and is 
using the display color profile). The middle image is with soft 
proofing turned on, and using a printer profile for Epson’s 
Exhibition Fiber Paper. The bottom image has the Gamut warning 
turned on; out of gamut colors are highlighted by the bright red 
overlay.



ON1 Photo RAW 2021 User Guide	 Part 5: Output and Sharing	 199

	 Neither rendering intent is perfect or desired; it often is a matter of the makeup of the 
image, your editing intent, the paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause Photo RAW to use the white point 
for the chosen paper type (instead of the white point of your monitor), and the paper’s actual 
black density (instead of the display’s black point). If you’re trying to match a print, you will 
usually want this setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. It’s easy to get caught up in eliminating 
out-of-gamut colors, but most modern photo printers—both home printers and online print services—do a 
pretty good job of approximating colors properly. 

NOTE: Since you can’t edit the tones in your photo from within Resize, it’s a 
good idea to perform a soft-proof check in the Edit module before taking an 
important image into Resize. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. When using a home printer, use test prints to hone in on the right mix of Edit 
module adjustments. Photo RAW’s Versions feature can be extremely helpful when you’re tweaking 
settings to get a print just right (see page 69 for more on working with Versions).

UNDERSTANDING RESIZE: HOW BIG CAN I PRINT?

People often ask how large a print can be made with ON1 Resize. If your original image is sharp, has good 
details and little noise, you could go as large as 1000% of the original size. 1000% is ten times the size of 
the original file. For example, an original file that is 8" x 10" could be resized to 80"x100". Viewing distance 
plays a big part of this. Standard viewing distances are two-times the diagonal of a print. For example, for 
an 8"x10" it would be about two feet away. An 80"x100" would be about 21 feet. That seems like a lot 
but that image is almost 7'x9'. Keep in mind that many photographers scrutinize their images closer than 
standard viewing distances.

Images are perceived in color, tonality and sharpness. Other interpolation techniques maintain color and 
tonality but sacrifice sharpness by “inflating” the image uniformly. The image still looks familiar but will not 
be crisp. Depending on the amount of interpolation, this can be severe and noticeable even at standard 
viewing distances. ON1 Resize maintains the color, tonality, and sharpness of an image at all sizes. It will 
always look the same when viewed at the proper distances.

It is unrealistic to assume that the fidelity when viewed at 100% will be the same for an 8×10 and an 
80×100 created by ON1 Resize. ON1 Resize will maintain the edges which perceptually make the image 
sharp, but it cannot create detail where there was none in the past. When the shutter is pressed, a finite 
amount of detail is captured. A good way to think about this is to look at an insect on a leaf. If you look at 
it with a magnifying glass, you will see more detail than you did than when looking at it with the naked eye. 
Now if you take a digital photograph of that same insect and look at it in the computer and zoom in past 
100% you do not see any more detail. The information you see is limited by what the camera captured. 
ON1 Resize works the same way, it cannot create new detail but instead takes the finite amount of detail 
available and increase it in size.
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ON1 Resize isn’t magic. We have all watched CSI, where they take a security photo and enlarge the 
reflection in the victim’s eye to see the killer, with results that look amazing. This is science fiction. You 
cannot create detail where there was none before. But if your original file has good detail and little noise, 
you will be able to make very good looking enlargements from your files. This is what ON1 Resize does 
better than any other software.

HOW MUCH RESOLUTION DO I NEED?

To answer this, you need to know two things:

1.	 The size of the print you need to make.

2.	 The resolution that your printer needs for best results.

The size of the print is as large you would like. This may be limited by the size of your printer. Resolution 
is the density of the pixels for a given distance, usually measured in pixels or dots per inch. Most modern 
inkjet printers print anywhere from 1200 to 4800 dots per inch (what the printer manufacturers really 
mean is 1200-4800 droplets of ink per inch). Inkjet printers use many tiny round droplets of 4-12 ink colors 
to reproduce one square pixel in your image that could be one of any millions of colors. A common mistake 
is to set the resolution of the file to the resolution of the printer. In all but a few special printers this will 
lead to huge files that will not print well, if at all. The secret is that the human eye cannot see more than 
250-300 pixels per inch. So the ideal resolution for your files should be close to this. Once you know the 
print size and resolution, it is easy to use ON1 Resize to resize your file to the desired output. Simply input 
the resolution and then either the print width or height. You’ll see that the corresponding dimension is 
automatically filled in by ON1 Resize based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors and paper can all be 
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the 
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5×11 inches or about 
1:1.25. These kind of proportion mis-matches are common and require that the original image be cropped 
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition 
then you will need to adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This process is called 
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most 
common method used by many pixel editing applications is called bicubic interpolation. Bicubic along with 
its newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring 
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not 
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize’s patented scaling algorithm is fundamentally different from bicubic or other interpolation methods. 
While other methods sample nearby pixels and decide new pixel values one by one, ON1 Resize uses a 
sampling technique called Fractal Scaling. Fractal Scaling samples nearby “blocks,” square groups of pixels, 
and varying sizes, compares them to smaller versions of the original image and mosaics these patches 
together to create a larger version of the original. By doing this repeatedly, often the characteristics of the 
image like edges, smooth areas, and textures are reinforced for each larger version. Noise is de-emphasized 
and sharp details are maintained. All this number crunching may take a bit longer than the single pass 
interpolation methods like bicubic, but good things come to those who wait and the reward is far superior 
results.
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EXPORT
Export is a special panel that is available throughout 
ON1 Photo RAW 2021. It the engine for the export 
process, whether you’re exporting final files from 
within Browse, Edit or even Resize. The Export pane 

gives you much of the power of Resize in an easy to use panel, 
letting you export your photos with incredible flexibility, ease and 
control.

The Export pane is always available, from any module, as long 
as you have a photo selected (you can also batch export files 
selected as a group in Browse).

To open the panel, click the Export icon in the lower right corner 
of the module selector, or choose Export from the File menu. 
Once selected, the Export panel opens on the right side of the 
Photo RAW window, letting you select a group of options as you 
prepare to export a photo. By default, the panel includes three 
active panes, which are fairly straightforward to use: File Type, 
Location, and Rename, which are all located at the bottom of the 
panel. These are the minimum options needed to export a file, 
but you can also add the following panes to the panel, expanding 
your export controls: Photo Size, Watermark, Sharpening, Tiling 
and Gallery Wrap.

FILE TYPE

The File Type lets you choose what format you want your photo 
to be exported as, along with a color profile that you wish to 
assign to the exported file. The type options are Photoshop, 
Photoshop Large Document, JPEG, TIFF, and PNG.

Saving as JPEG lets you choose a Quality setting, with 100 being 
the highest.

LOCATION

Click the Choose button to select a location, or click on the Save 
To pop-up for more options, including:

• Current Folder will write the file to the same location 
as the original file.

• Folder lets you choose a location by pressing the 
Choose button

• Round Trip (only available when exporting through 
Adobe Lightroom) saves the file tover the original and 
uses the same format, bit-depth, color space and name.
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With regard to the other options in this pane, If Prevent Overwrite is selected the word ‘copy’ will be added 
to the file(s); otherwise it will overwrite your original image if the destination is set to Current Location. 
You can also have Photo RAW open the folder you exported your image to by choosing the Show in Finder 
(MacOS) or Show in Explorer (Windows) option from the After Export menu.

RENAME

This option may be used to rename the file name. The options 
include: Current Name, Text, Date and Number. The field to the 
right allows you to enter a custom name. The plus and minus 
icons will allow you to add or remove naming elements. Current 
Name will use the source name without the file extension. Text 
is used for assigning a custom text string. Date lets you add 
today’s date in any one of 12 standard formats. Number creates an automatically incremented number, 
starting with the number input in the field. Reset will clear all current settings.

PHOTO SIZE

The Photo Size pane displays the original image size when you 
first open it. You can simply type into the Width or Height fields 
to change the document size, or you can choose from a variety 
of preset sizes—including standard photo paper sizes—by clicking 
on the pop-up menu underneath the Resize To pop-up.

Keep in mind that the Width and Height fields are locked 
together to maintain the photos proportions. Changing the 
width will change the height proportionally. Export does not support non-proportional scaling. If you would 
like to change the proportions of the image it requires cropping.

The Long Edge and Short Edge options in the Photo Size pane are useful when you want to lock one edge 
to a specific length or width and don’t care about the sizing of the other edge. Simply choose which option 
is the important one for your photo, enter the dimensions, and Export will resize your photo accordingly.

NOTE: Export does not offer any options for cropping, and if you choose an 
aspect ratio that is different from that of your photo, on export, your photo will 
be cropped from the center point out to meet the new ratio. If you wish to crop 
to a different ratio, it is better to use Resize.

The units of measurement can be switched by clicking the down arrow. You also control your resolution in 
pixels per inch. Use this setting to optimize for your output device.

The Photo Size presets make it easy to set the width/height of your image in a preset size. Use the drop 
down menu to select a preset size or choose custom to create your own.

The Image Type drop down provides a few options for resizing:

• General (ON1 Resize) uses the ON1 Resize algorithm also known as Genuine Fractals: This is 
the patented, fractal-based algorithm that has made Resize the standard for over a decade.
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• Low-Res JPG is best for enlarging low resolution JPEGs (this setting use the bicubic algorithm 
method).

• Portrait works well for resizing portraits protects skin tones from artifacts (uses bicubic 
algorithm method).

• Landscape is great for Landscape photos (uses ON1 Resize algorithm).

• High Detail is great for images with many small items (uses ON1 Resize algorithm).

WATERMARK

The Watermark module allows you to add an overlay to the 
image, most often used for your logo, signature or copyright. 
Watermarks generally need a transparent background, so make 
sure your watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it 
to appear 2 inches wide on a 300-ppi image, your watermark 
needs to be at least 600 pixels wide. Or if you want it to appear 
across an entire photo—such as when posting to social media—it needs to be the same size as what you 
are exporting for the web, typically over 1000 pixels. Using a watermark file that is too small will create a 
pixelated watermark appearance.

SHARPENING

The Sharpening pane adds additional sharpness to your image, 
and are designed to be general options for screen or print work. 
Using these controls can save you the workflow step of adding 
additional sharpening before printing and can help compensate 
for loss of sharpness due to dot gain from your printer. Sharpening should only be applied at the end of 
your workflow, just before printing. If you plan to do additional retouching or compositing work after 
resizing your image, you should disable the sharpening controls.
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TILING

The tiling feature in Export divides an enlargement into smaller 
pieces so that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet tall 
by 12 feet wide, but your printer can only print 24-inch wide 
strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create 
your mural in sections.

With the tiling feature all you do is specify the size of paper 
you have to print on and if you would like the pages to overlap. 
Then Export will resize your image and section it down into the 
individual tiles.

To use the Tiling pane, follow these instructions:

1.	 Set the Width/Height fields to the size and 
orientation of paper you wish to print on, or select 
the number of rows and columns instead.

2.	 Set the Overlap size. The overlap makes each tile 
overlap so you can tape multiple panels together and corrects for printer margins if you are 
not printing borderless.

The preview will show cyan guide lines for each tile that will be created.

GALLERY WRAP

The Gallery Wrap feature is designed to help you print on 
canvas. When making enlargements for canvas it is common 
to wrap a portion of the image around wooden stretcher bars. 
These are used for mounting the canvas. These are commonly 
called gallery wraps. However, if the photo has important detail 
near the edges of the image they may be lost in the wrapping 
process. The Gallery Wrap feature in ON1 Resize automatically 
creates extended margins by reflecting or stretching the areas 
near the edge of the image allowing the photographer to create 
a gallery wrap without having to sacrifice any of the original 
image. The Gallery Wrap feature allows you to select the 
thickness of the canvas mounting bars and offers a variety of 
techniques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:

1.	 Set the Thickness control to the amount of margins 
you would like to add. A good rule of thumb is the 
thickness of the stretcher bars, plus half an inch.

2.	 Select the Type you would like to use.

3.	 If you wish to add an overlay to the wrap wings, set the color and opacity.
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The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap. The 
Type pop-up has four options:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can also darken the wrap or add a solid color to the wrap area with the Overlay Color add Opacity 
sliders.

EXPORT PRESETS

Presets remember all of the settings and details selected in the Export window pane. To save a group of 
settings as a preset, click the Save Preset button at the bottom of the panel. Give the preset a name, and it 
will appear in the Presets pop-up at the top of the Export panel.

NOTE: Unlike presets in other parts of ON1 Photo RAW 2021, you can’t 
export or import presets from the Export panel.

EXPORTING OPTIONS

When your export settings have been set, you have two options for exporting, accessible via a pop-up in 
the Export button at the bottom of the pane:

• Export in the Background: If you wish to keep working inside ON1 
Photo RAW during the export process, choose this option. It will 
take more time, since not all of the app’s processing power will be 
dedicated to the export operation.

• Export Now: Choose this if you wish the export process to happen 
more quickly. You won’t be able to work inside Photo RAW until the exporting is done.

To get the options, press and hold your mouse button over the down arrow in the Export button at the 
bottom of the pane, then make your selection. If you just click the button without holding, the default is 
Export Now, although Photo RAW will remember your last setting if you change it.
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PRINTING
ON1 Photo RAW 2021 has a flexible print engine that can print photos at any size. You can print photos 
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating 
images. You can print from any module, even when using Photo RAW as a plug-in. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo or photos being printed.

B.	 View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C.	 Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D.	Page view: Displays the number of pages being printed, and lets you move from page to page.

E.	 Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F.	 Print Area pane: Contains options for fitting and selecting the print image size.

G.	Watermark pane: For adding a watermark to printed photos.

H.	Sharpening: Options for sharpening during the print process.

I.	 Print/Cancel: Print One (current image), Print All, or Cancel.
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Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that 
has between 240 and 360 ppi. (Photo RAW will use its internal 
resampling engine to ensure that your photo is at the print 
resolution you choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. (You can use Photo RAW’s Soft 
Proofing feature to look at out-of-gamut colors in your photos. See “Soft Proofing” on page 116 for more.)

NOTE: Photo RAW’s Print feature will work with borderless printing options 
as well. Be sure to choose your printer’s borderless options in the page setup 
pop-up. Different printers will have specific borderless settings, so check the 
manual to see how to turn borderless printing on.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Photo RAW will ask you for a filename and a location to save the 
file. Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When 
you choose Print, Photo RAW will create a PDF of the photo (or photos) and save it with the name and 
destination you specified earlier.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually, package-style, or to 
create a contact sheet for evaluative purposes. 

The top of the pane includes preset styles for either fitting the 
current photo inside the print size, or filling the entire print size;  
options for printing at common print sizes, including 8x10, 5x7, 
4x6; and options for printing to a contact sheet. You can also 
create custom print sizes via the Custom section at the bottom 
of the pane; just set the width and height of the print size, and 
whether you wish to fit the image to the print size, or to fill the 
frame with it. If you would like to save this print size as a style, 
click on the More pop-up at the top of the pane, and choose Save as New Style from the menu. You’ll then 
be able to recall that style from the More pop-up whenever you print.

If you are printing multiple photos, Photo RAW will attempt to put as many photos at your chosen print size 
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the 
bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Edit module. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Basic printing with Photo RAW
Printing is available throughout the ON1 Photo RAW 2021 interface. If you are viewing a photo in either 
the Edit or Resize modules, or if you have an image selected in Browse’s Grid or Detail views, clicking the 
Print icon will open the Print window with that image. There, you can set any of the options in the four 
panes on the right, and click the Print button to output your photo. 

Use the Sharpening pane to add additional 
sharpening to your printed image.
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If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for 
the media type you are using, click the soft proofing icon underneath the preview area.

PRINTING PHOTOS FROM ON1 CLOUD SYNC DEVICES

Any photo that can be displayed on your computer can be printed, even proxies of photos that reside on 
one of your ON1 Cloud Sync devices. In most cases — especially at smaller print sizes (8x10 and under), the 
proxy photo will have more than enough resolution to print at high quality. If you are printing at larger sizes, 
or wish to use all the available image data for your photo, either copy the file from your synced device to 
your computer, or change the sync setting for the photo’s enclosing folder on the synced device, so that the 
original is in the ON1 Cloud.

PRINTING MULTIPLE PHOTOS

To print multiple photos—as a package or contact sheet—select the images you wish to print from the Grid 
or Filmstrip views (in Browse or Edit), and click the Print icon. The photos you’ve selected will be displayed 
in the filmstrip at the bottom of the window, and the preview area will display the current page (at the 
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from 
page to page via the Page View buttons under the preview. To see more pages,  click on the Facing Pages or 
Show All Pages icons at the bottom left of the window.

The Print feature gives you extensive options for printing multiple pages package style. Here, we have selected 24 photos to 
print at 5x7 inches on a letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the 
preview window, you can see all of the photos to be printed. Clicking Print One will print the currently selected page; clicking 
Print All will print the collection.	
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If you decide that you don’t want to print a photo, click the checkmark for that photo in the filmstrip. To 
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page, 
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

Printing contact sheets

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the 
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the 
Printer pane, and click on the Contact icon in the Print Area pane.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of 
the Print Area pane:

• Columns: lets you set the number of columns across the page width. The smaller the number 
of columns, the larger the individual cells.

• Captions: Currently, Photo RAW lets you add the filename as a caption underneath the 
printed photo. Click the button to the left of the label to turn this on or off. (We will be 
adding additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when 
you’re ready to print, click the Print All button to print the contact sheets.

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.



ON1 Photo RAW 2021 User Guide	 Part 5: Output and Sharing	 212

SHARING TO SMUGMUG
If you are a member of the SmugMug photo sharing and hosting service, ON1 Photo RAW 
2021 offers an easy to use mechanism for posting one or multiple photos to the service. 
This is accessed via the Share menu, which is found throughout Photo RAW in the lower 
right section of the Module selector. On Windows, the Sharing button’s pop-up contains 

only the SmugMug option; on MacOS, there are additional sharing options beyond SmugMug (see page 
213 for more information on these options). 

You can share a the currently selected photo or a group 
of photos by choosing SmugMug from the Sharing pop-up 
menu. The first time you access the service, you’ll receive an 
authorization window inside Photo RAW; fill out your account 
information and password, and then click on the Authorize 
button. 

Once authorized, you’ll be presented with a window that lets 
you upload your photo or photos. The window contains a 
handful of options:

• Click the “Use photo metadata” control to include 
the photos’ metadata for use in the title, caption and 
keyword.

• The Gallery pop-up lets you add the photos to an 
existing gallery, or lets you create a new gallery. 

• The Open Gallery link to the left of the pop-up will 
open the currently selected gallery in your default 
web browser.

• The Size pop-up has three options, full-size, and 
either 4000 or 2000 pixels (on the long side).

Once you have selected the appropriate options, click the 
Share button. Photo RAW will create high-quality JPEGs of the 
chosen photos and publish them to SmugMug.

More information about SmugMug can be found at smugmug.
com.

The first time you share to SmugMug, you’ll be asked to 
log in to your account, and verify that you want to let 
Photo RAW post to your galleries on the site.

When you post to SmugMug from Photo RAW, you can 
include metadata, choose the gallery to you want the 
photos to go into, and the size of the uploaded photos.
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OTHER SHARING OPTIONS (MACOS ONLY)
In addition to SmugMug publishing, the MacOS version of ON1 Photo RAW 2021 includes 
other photo-sharing options, including:

• Mail: Creates a new email message in Apple Mail with the shared 
photo.

• Messages: Shares photo to Apple’s Messages app.

• AirDrop: Uses Apple’s AirDrop networking feature to share with 
local MacOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can choose 
to create a new note, or add the photo to an existing note.

• Add to Photos: Adds the photo to Apple’s Photos app.

• Reminders: Adds to the Reminders app.

• SmugMug: Post photos to the SmugMug service (see page 212 for details).

All of the sharing options perform the same operation: Photo RAW exports a full-size JPEG of the selected 
photo and shares it with the selected target from the list. 
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SEND TO OTHER APPLICATIONS
The Browse module inside ON1 Photo RAW 2021 can send images you are 
viewing to other applications for editing. This is done via the Send to option, 
which is available from the right-click contextual menu or the Edit menu. 
ON1 Browse automatically detects the following common photo managers 
or editors and lists the latest installed version:

• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos to. Simply 
select the Send to Other Application option. Then select the application you 
want to send your photos to. The application will be remembered and listed 
with your other Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will be presented with 
the Edit in dialog box from ON1 Photo RAW 2021. There you’ll have the 
option to send either the edited photo or the original, unedited image. If you 
choose to send a copy, you’ll have options for choosing the file type, color 
space, bit depth and resolution. If you use the same set of options every 
time, you can check the “Don’t ask me again” box in the window, and you 
won’t be prompted again. (To change this setting, go to the File pane in 
Photo RAW’s Preferences.) The Send To... section is available 

when you right-click on a photo inside 
Browse pop-up menu. 

The Edit In dialog, with the Copy Options section expanded.
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Browse menus
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW 2021: Opens the about box, 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2021.

File Menu

• New Canvas: Creates a new .onphoto file at the 
dimensions you choose and opens it in Layers.

• Browse Folder: Opens the browse dialog where you can 
select which folder you would like to browse.

• Browse Home: Navigates to your home Pictures folder.

• Browse Desktop: Navigates to your desktop.

• Import from device: Opens the Import window.

• Add Cataloged Folder: Lets you choose a folder to add 
to the Cataloged Folders section of the Folders pane.

• Copy to My Catalogs: Copy or move a group of selected 
photos to a specific cataloged folder.

• Remove Cataloged Folder: Removes the selected folder 
from the Cataloged Folders pane.

• Manage Extras: Opens the Extras Manager for 
importing and exporting backgrounds, presets, textures 
andt more.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Open as Layers: Opens the selected files as layers in 
Edit.

• Edit Single Image: Opens the selected files in Edit’s 
Single Image mode.

• Send to (list): Sends your image to the selected 
application in the list.

• Group RAW Plus JPG: Stacks RAW and JPG pairs 
together, reducing clutter.

• Merge to Panorama: Takes the selected images and 
opens the Create Panorama window.

• Create HDR: Takes the selected images and opens the 
Create HDR window.
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• Create Focus Stack: Takes the selected photos and 
opens the Focus Stack window.

• Export: Opens the Export side panel.

• Print: Opens up the print window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Select All: Selects all the images in the current folder.

• Select None: Deselects all the images in the current 
folder.

• Deselect: Deselects the current item.

• Copy: Copies the currently selected items.

• Paste: Pastes the items in the clipboard to the current 
location.

• Duplicate: Makes a physical copy of the selected file, in 
the same location as the original.

• Rename Files: Renames the selected file or folder.

• Delete: Moves the selected files and/or folders to the 
trash.

• Add Subfolder: Adds a new empty subfolder inside the 
current selected folder.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.

Album Menu

• Create Album: Creates a new Album.

• Rename Album: Renames selected Album.

• Delete Album: Deletes selected Album.

• Add to Album: Add selected photos to available Albums.

• Remove from Album: Removes selected photo(s) from 
Album.
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Photo Menu

• Color: Sets the color rating of a photo (None, Red, 
Yellow, Green, Red, Purple)

• Rating: Sets star rating (0 to 5 stars)

• Like: Sets a photo to Like, Reject or Not Set

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 
90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise by 90°

• Edit Capture Date: Let’s you adjust the date captured 
metadata, including a setting to take account for time 
zone changes.

• Set Location from GPS Coordinates: Looks up the place 
name information from the stored GPS coordinates and 
embeds it in the appropriate IPTC metadata fields.

• Embed Metadata: Stores adjusted metadata to the 
selected photo. (Only applicable to certain file formats.)

• Read Metadata from Photo: Reads the embedded 
metadata from a raw file, overwriting any data that 
might be in the XMP sidecar files. (Useful for times 
when the metadata appears out of sync with different 
apps.)

• Save Metadata Preset: Lets you save some or all of the 
current image’s metadata fields as a preset.

• Delete Metadata Preset: Lets you delete a saved 
metadata preset.

• Refresh Preview: Rebuilds the preview of the selected 
images. (Helpful if there are issues that are causing an 
image to display incorrectly.)
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Settings Menu

• Reset All Settings: Resets all the applied settings on a 
photo.

• Reset Develop Settings: Resets only the settings 
applied in the Develop tab.

• Reset Effects Settings: Resets only the settings applied 
in the Effects tab.

• Reset Portrait Settings: Resets Portrait settings.

• Reset All Retouching Tools: Resets any retouching 
applied in the Edit module.

• Reset Local Adjustments: Removes all local adjustments 
made to a photo.

• Reset Crop: Resets the current image’s crop to its 
original state.

• Reset Text: Removes text blocks from the current 
photo.

• Copy Settings: Copies all of the Edit module settings 
applied to a photo.

• Paste Settings: Pastes the copied settings (with options)

• Paste Settings from Previous Edit: Applies the Develop, 
Effects and Local settings from the last-edited file.

• Sync Settings: Selectively applies Edit settings from 
the primarily selected image (represented by the 
superselection) to the rest of the images in a selection 
(with options).

• Sync All Settings: Syncs all Edit module settings from the 
primarily selected photo to the rest of the images in a 
selection.

• Create Version: Makes a virtual copy of a photo, 
without duplicating the file on your hard drive.

• Save Settings as Preset: Saves the editing settings of 
the selected photo as a preset.

• Update Preset with Current Settings: If an image with 
a preset has had some settings changed, this lets you 
update the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1.com’s Photo Presets 
page.
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Cloud Sync

• Configure Cloud Sync: Opens the Cloud Sync 
Preferences window.

View Menu

• Bigger Thumbnails: Increases the size of the thumbnails 
in Grid view.

• Smaller Thumbnails: Decreases the size of thumbnails.

• Zoom In: Zooms into your image in Detail, Filmstrip or 
Compare view, displaying more detail.

• Zoom Out: Zooms out, fitting more of your image in the 
window.

• Fit to Screen: Resizes your image on-screen, to fit it 
entirely in the preview window.

• Actual Pixels: Zooms in to the 100% view.

• Square Thumbnails: Changes your thumbs to square.

• Always Show Filename: Keeps the filename label turned 
on in the thumbnails while in Grid view.

• Enable Advanced Search: Enables/Disables the 
Advanced Search pane.

• Search Text: Opens the Advanced Search text box.

• Search by Label: Filters images by color.

• Search by Rating: Filters images by star rating.

• Search by Likes: Filters images by likes/dislikes.

• Reset Advanced Search: Resets any filters in the 
Advanced Search pane.

• Sort: Sort by filename, date, rating, label and more.

• Sort Subfolders at the Top: When sorting, puts 
subfolders at the top of the grid.

• Show Clipping: Displays the clipping overlay view, 
displaying the pure white or black pixels in the current 
image. 

• Show Focus Mask: Displays a green overlay on those 
portions of the current image that are in focus.

• View Mode: Select from Thumbnail (grid), Photo (detail), 
Filmstrip or Compare views.

• Preview Background Color: Change the preview 
background color.

• Preset Browser Mode: Sets the Preset panel browser 
view to 1, 2 or 3 columns.
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Window Menu

• Minimize: Minimizes ON1 Photo RAW 2021.

• Zoom: Zooms your window.

• Full Screen Mode: Enters or exits full-screen mode.

• Dual Mode: Adds new browser window for use in a 
second display.

• Full Screen Preview: Displays the current photo full-
screen, without any additional interface elements.

• Quick Slideshow: Displays the current group of photos 
in a slideshow, with customizable time and transition 
effects.

• Folders: Opens and hides the Folders pane.

• Albums: Opens and hides the Album pane.

• Advanced Search: Opens/hides the Advanced Search 
pane.

• Tethered Shooting: Opens/hides the Tethered Shooting 
pane.

• Recent: Opens and hides the Recent pane.

• Info: Open and hides the Info pane.

• Metadata: Open and hides the Metadata pane.

• Keyword List: Opens and hides the Keyword List pane.

• Show Browse Panel: Hides/reveals the Browse Panel.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Photo Panel: Hides/reveals the Photo Panel.

• Hide Panels: Hides/reveals both left and right panels.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub inside Photo 
RAW. 

• ON1 Photo RAW 2021 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Photo RAW startup 
screens.

• Check for Updates: Checks the ON1 update server to 
see if you are running the current version; it notifies you 
about updates and will walk you through the update 
process.
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• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW 2021 (Windows Only): Opens 
the about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Photo 
RAW 2021.
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Edit Menus
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW: Opens the About box and 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2021.

File Menu

• New Canvas: Creates a new layered .onphoto file at the 
specified dimensions.

• Canvas Size: Lets you change the size of the current 
layered file.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Export: Opens the export side panel.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the 
current location.

• Delete: Deletes the current image (Filmstrip mode only).

• Revert: Reverts to the original state of the current 
photo.

• Preferences (Windows): Opens the Preferences dialog.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.
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Layer Menu

• Add Layer from File: Lets you add a new file to the 
current document as a layer.

• Add Color Fill Layer: Adds a new layer consisting of a 
solid color.

• Edit Color Fill: Lets you change the color of a selected 
color fill layer.

• Delete: Deletes the currently selected layer.

• Duplicate: Duplicates the currently selected layer.

• Reset Layer Properties: Removes any applied layer 
masks or transforms to the current layer.

• Merge Layer: Merges the current layer with the one 
beneath it.

• Merge Visible: Merges all of the visible layers into a 
new, merged layer.

• New Stamped Layer: Merges the visible layers into a 
new, composite layer, leaving the visible layers intact.

• Align Visible Layers: Aligns visible layers based on their 
content.

Photo Menu

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 
90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise by 90°

Mask Menu

• Invert Mask: Inverts the mask, what was hidden is 
revealed and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer 
mask based off of a photo’s black or white tonal values.

• Show Mask: Displays the current mask either as a red 
overlay or as grayscale.

• View Mode: Sets the Show Mask mode to either red 
overlay or grayscale.
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Settings Menu
• Reset All Settings: Resets all of the Edit module settings 

on a photo.

• Reset Develop Settings: Resets settings applied in 
Develop.

• Reset Effects Settings: Resets settings applied in 
Effects.

• Reset Portrait AI Settings: Resets settings applied in 
Portrait AI.

• Reset All Retouching Tools: Resets retouching applied 
in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Reset Text: Resets any text blocks made to a photo.

• Copy Settings: Copies all of the settings (Develop, 
Effects, retouching) applied to a photo.

• Paste Settings: Pastes the copied settings (with options)

• Paste Settings from Previous Edit: Applies (to the 
current photo) any Edit module adjustments made to 
the previous photo.

• Sync Settings: Selectively applies the Edit module 
settings from the primarily selected image to the rest of 
the images in a selection.

• Sync All Settings: Applies all of the Edit module settings 
from the primarily selected image to the rest of the 
images in a selection.

• Create Version: Makes a virtual copy of a photo, 
without duplicating the file on your hard drive.

• Save Settings as Preset: Saves the editing settings of 
the selected photo as a preset.

• Update Preset with Current Settings: If an image with 
a preset has had some settings changed, this lets you 
update the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web 
page.
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View Menu

• Zoom In: Zooms the preview window in one increment. 
This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. This is the setting you will 
use most of the time.

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This is 
useful when making precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 
1, 2 or 3 columns.

• Show Clipping: Shows the clipping overlay view, 
displaying the pure white or black pixels in the current 
image.

• Show Focus Mask: Displays a green overlay on those 
portions of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of 
the current image, with the Before view on the left side 
of the preview area.

• View Mode: Toggles between Filmstrip and Detail view.

• Preview Background Color: Lets you set the 
background color options.

• Enable Soft Proofing: Turns on soft proofing for the 
current image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display 
profiles; choosing a profile will apply soft proofing for 
that profile’s paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Photo RAW 
will set the white point and black point of the display to 
account for that of the chosen profile.
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Window
• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Dual Mode: Turns on dual-display mode

• Navigator: Hides or shows the Navigator, Loupe, 
Histogram and Info pane.

• Layers: Collapses the Layers pane.

• Solo Mode: Keeps only one pane open at a time.

• Show Layers: Completely hides/shows the Layers pane.

• Open Quick View Browser: Opens the Quick View 
Browser overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub. 

• ON1 Photo RAW 2021 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Photo RAW startup 
screens.

• Check for Updates: Checks with the ON1 update server 
an updated version. If there is a newer version, you will 
be notified and be walked through the update process.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW (Windows Only): Opens the 
about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with Photo RAW.
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Resize Menus
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW: Opens the About box and 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2021.

File Menu
• Done: Saves the current image and returns to Browse 

(or external source).

• Cancel: Cancels any Resize operations and returns to 
Browse (or external source).

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format

• Export: Calls up the Export pane.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu
• Undo: Removes the last file operation.

• Redo: Redoes the undo operation.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes the items in the clipboard.

• Preferences (Windows): Opens the Preferences dialog.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.
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Settings Menu
• Reset all Settings: Resets any settings made in Resize.

• Reset Resize Settings: Resets changes made in Settings.

• Reset Crop: Resets the crop.

• Save Settings as Preset: Saves the current Resize 
settings as a preset.

• Update Preset with Current Settings: If an image with a 
preset applied has had some settings changed, this lets 
you update the preset to reflect those new settings.

• Rename Preset: Renames the current preset.

• Delete Preset: Deletes the currently selected preset.

• Export Preset: Exports the current preset.

• Import Preset: Imports ON1 Resize preset files.

• Get More Presets: Opens ON1’s Presets page in your 
web browser.

View Menu

• Zoom In: Zooms the preview window in one increment. 
This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. 

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This is 
useful when making precision adjustments.

• Show Clipping: The clipping overlay view displays the 
pure white or black pixels in the current image.

• Preview Background Color: Lets you set the 
background color options.

• Enable Soft Proofing: Turns on soft proofing.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display 
profiles; selecting a profile will apply soft proofing for 
that profile.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: Sets the white point and black 
point of the display for that of the chosen profile.
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Window

• Minimize: Minimizes your screen.

• Zoom: Zooms window to full-size.

• Full Screen: Toggles full-screen mode (hides menu bar).

• Navigator/Loupe/Histogram: Hides or shows the 
Navigator, Loupe, Histogram (Levels) and Info pane.

• Pixel Dimensions: Toggles the Pixel Dimensions pane.

• Document Size: Toggles the Document Size pane.

• Settings: Opens or closes the Settings pane.

• Sharpening: Opens or closes the Sharpening pane.

• Film Grain: Opens or closes the Film Grain pane.

• Tiling: Opens or closes the Tiling pane.

• Gallery Wrap: Opens or closes the Gallery Wrap pane.

• Solo Mode: When enabled, this feature keeps only one 
control pane open at a time.

• Show Control Panel: Hides or shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub inside Photo 
RAW. 

• ON1 Photo RAW 2021 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page.
• Getting Started: Opens the initial Photo RAW startup 

screens.
• Check for Updates: Checks with the ON1 update server 

for an updated version.
• Sign-In/Sign-Out: Uses your ON1 account login 

information to authenticate your copy of Photo RAW.
• Provide Feedback: Opens the default web browser and 

goes to the feedback page of the ON1 website.
• About ON1 Photo RAW (Windows Only): Opens the 

about box with the version number displayed.
• Help Improve ON1 Products: Opens the Improve ON1 

Products dialog.
• Show ON1 Log: Diagnostic tool that can help ON1 

support when you’re having issues with ON1 Photo 
RAW 2021.
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Preferences
ON1 Photo RAW 2021 has a number of system-wide settings that you can set via the Preferences 
window. To access Preferences, either click on the gear icon at the lower left side of the screen, or choose 
Preferences from the ON1 Photo RAW 2021 menu (MacOS) or the Edit menu in Windows.

The Preferences window has seven tabs: General, Files, Plug-Ins, System, Services, ON1 360 and Auto 
Mark. The settings in each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Photo RAW workspace, including 
background color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of 
the preview window. 

• Preview Pan: Pans the image.

• Brush Size: Adjusts the size of the 
current brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items in the Photo RAW interface.

Application Language

Lets you change the display language for Photo RAW. Auto will use your system’s default language.

Legacy Browse Tab

Checking this will change the separate My Catalogs and Browse panels to the single Browse panel found in 
earlier versions of ON1 Photo RAW. (See “My Catalogs, Browse and Presets Panels” on page 35.) 

Show Folder Previews

When checked, will display a thumbnail of an image from the enclosing folder in Browse.
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Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Open External Files

When double-clicking a photo in Photo RAW from either MacOS Finder or Windows Explorer, specifies 
whether to open the file in the Browse module (default) or the Edit module, the latter by using Edit a Single 
Photo mode (see “Edit a Single Photo” on page 34).

Double-Click in Browse

Sets the behavior when double-clicking on a photo in Browse’s Grid view. The default is to zoom in to the 
photo; the alternative is to open the photo in the Edit module.

Default Browse Location

By default, the Pictures short cut in Browse is either Pictures (Mac) or My Pictures (Windows). You can 
change that location via this setting.

Portrait AI Default

Sets the strength of Portrait AI’s retouching algorithms when you open a photo in the Portrait tab. There 
are two options, Subtle and Strong. The default is Subtle. (See page 158 for information on the options.)

FILES

The Files tab is used to determine what file type 
ON1 Photo RAW will create when opening a file 
in Resize, or when creating copies to send to an 
external editor from within Browse. It also lets 
you apply camera-based presets.

What to Edit

There are five options in this tab:

1.	 File Format: Sets the file type you 
wish to create: PSD, TIFF, or JPEG. If 
you wish to use a layered workflow, 
you must choose PSD.

2.	 Color Space: Sets the default color 
space when opening a copy of a file; 
the list includes Adobe RGB 1998, 
Apple RGB (MacOS), sRGB, ProPhoto 
RGB, or ColorMatch RGB. (If you 
imported a profile, it will also be 
available here.)

3.	 Bit Depth: Sets the bit depth for the file when opening a copy of a file.
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4.	 Resolution: Sets the resolution when opening a copy of a file.

5.	 Show these options every time: If you do not wish to use a predefined set of file 
characteristics for opening photos from Lightroom or Photoshop, click this box.

Sidecar Options

Click this box if you wish ON1 Photo RAW 2021 to create ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using the same image library with multiple computers (on an external hard 
drive, for example), and want your edits to be visible on each machine. 

Treat RAW+JPG Pairs as a Single Photo

If you shoot RAW+JPG, you can use this option to ‘stack’ both photos inside Browse. (RAW+JPG pairs are 
shown with a small icon in the lower left corner of the thumbnail.)

Default Processing

The Default processing section contains three options, for lens correction, base level raw-file corrections, 
and applying camera-based presets. The first, Apply Lens Correction Automatically, will use the lens 
correction automatically on any raw photo when you view it in Detail, Filmstrip or Compare modes. The 
Disable Base Corrections option turns Photo RAW’s basic raw-file correction settings off. This can be 
helpful for scientific/technical photography, time-lapse, and other specialized applications.

The Camera-Based Presets section at the bottom of the Files pane will contain a list of known cameras you 
have shot with. You can have Photo RAW automatically apply any preset to a specific camera by choosing 
the preset from the appropriate pop-up. (See page 114 for more about using camera-based presets.)

PLUG-INS

The Plug-Ins tab is specific to using Photo RAW 
as a plugin for Photoshop or Lightroom, setting 
conditions when opening files from these apps.

Photoshop

• Apply Results to: When editing in 
Photoshop you can choose to have 
your effect added to a copy of your 
current layer or to the current layer. 
You can also choose to start with the 
last used settings when launching 
ON1 Photo RAW.

Lightroom

This preference lets you choose the specific options for files opened via the Plug-In Extras menu in 
Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The 
default is PSD, which maintains layers. You can also select ON1’s Smart Photo format to 
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preserve re-re-editability from within Lightroom, or JPEG or TIFF if you prefer those formats 
and are not concerned about maintaining layers. The last option is Same as Source, which 
maintains the file type of the original file, except for raw files, which are exported as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, the original file 
will be edited directly, rather than having a copy made.

• Ask Every Time: Presents these export options whenever you chose an item from the Plug-In 
Extras submenu. Turning this option off will bypass the file-export window, using the options 
in the Plug-In Preferences window every time.

NOTE: For detailed information about the Smart Photo format and re-
editability options from within Lightroom, see page 18.

Apple Photos (MacOS only)

• The Enable Helper option works to ensure a smooth connection between Apple Photos and 
Photo RAW. It should remain on by default.

SYSTEM

The System tab displays performance-related 
characteristics of Photo RAW 2021.

Memory Usage

• System Usage: Specifies the amount 
of RAM that is used by the application. 
The maximum (default value) is 80%.

• VRAM Usage: Specifies the amount 
of video memory (VRAM) used. The 
maximum (default) is 80%.

Scratch Folder Location

Lets you move or reset your memory cache, to 
speed editing operations while you’re running 
Photo RAW. This is helpful if your system 
drive has limited space and wish to use a faster 
external drive as a cache. This cache information 
is purged each time you quit the application.
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Browse Cache

ON1 Photo RAW 2021 stores thumbnails previews on disk so that the next time you browse a folder it 
loads much faster. This setting lets you adjust the memory cache size as well as empty the cache, move it to 
another location, or reset it if you are having issues with Browse. 

TIP: If you use cataloged folders and have a small SSD boot volume, move the 
Browse cache to another drive for performance and space considerations.

Performance

The Performance section is designed to help you optimize Photo RAW for your specific setup. The 
adjustments you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of 
brushes and gradient tool overlays. If your brush is sticking try turning it down. If you have a 
high-end video card try turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to 
improve performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, 
sharing and caching. This can greatly improve performance. It is on by default for systems 
that support it. It may be disabled on lower-end GPUs.

Lightroom Migration Cache

If you run into problems with the Lightroom Migration Assistant, you can clear the cache here. (See 
“Moving Your Lightroom Catalog to Photo RAW” on page 18.)

SERVICES

This tab controls which online storage services 
are displayed in the Sources pane in Browse 
and Layers. Currently, ON1 Photo RAW 2021 
supports Dropbox, Google Drive, and Microsoft 
OneDrive. Photo RAW 2021 will automatically 
add any of the services if finds them on your 
computer during the installation process, but if 
you add (or remove) any of these services later, use this tab to manage them.
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CLOUD SYNC

If you have subscribed to the ON1 Cloud Sync 
service, this tab lets you set the name for your 
device (which will be displayed on your other 
synced devices), as well as whether or not you 
wish to publish RAW+JPG pairs and your presets 
and imported extras.

The Reset Cloud Sync button will return your 
sync setup to its original state, removing all 
photos and devices. 

Detailed information about Cloud Sync can be found starting on page 71.

AUTO MARK

This tab lets you set the various criteria Photo 
RAW uses when using the Smart Organize 
feature in Browse.  See page 61 for details 
on Smart Organize, and how to adjust the Auto 
Mark settings to fit your needs.
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Windows macOS
Change Modules/Tabs

Browse G

Develop D

Effects S

Portrait I

Local Adjustments A

Resize Y

Preview Nagivation

Zoom-in ⌃ + ⌘ +

Zoom-out ⌃ — ⌘ —

Fit to Screen ⌃ 0 ⌘ 0

Zoom to 100% (1:1) ⌃ ⎇ 0 ⌘ ⌥ 0

Pan Photo hold space

View & Window Modes

Grid View G

Photo View E

Filmstrip View F

Compare View (Browse) C

Fullscreen n/a ⌘ ⌃ F

Hide Right Panel ⌃→ ⌘ →

Hide Left Panel ⌃← ⌘  ←

Hide Both Panels ⇥
Split-Screen Compare (Develop/Effects) ⌃ Y ⌘ Y

Preview and Masking Views

Original View (Preview Off) \

Show Mask O

Show Clipping hold J

Enable Soft Proof ⎇ S ⌥ S

Browse

Change Thumbnail Size + /—

Browse a Folder ⌃ B ⌘ B

Select All ⌃ A ⌘ A

Select None ⌃ D ⌘ D

Deselect /

Set Rating 1-5

Set Label 6-0

Dislike X

Like P

Clear Like/Dislike U

Delete ⌦

Enable Filters ⌃ l ⌘ l

Search Text ⌃ F ⌘ F

Presets

Open Quick View Browser ⎇ ↑ ⌥ ↑

Insert Preset ⎇ click ⌥ click

Windows macOS
Photo Settings

Rotate 90 ⌃ ] ⌘ ]
Rotate -90 ⌃ [ ⌘ [
Reset All Settings ⇧ ⌃ R ⇧⌘ R
Copy Settings ⇧ ⌃ C ⇧⌘C
Paste Settings ⇧ ⌃ V ⇧⌘ V
Sync Settings ⇧ ⎇ S ⇧ ⌥ S
Create Version ⌃’ ⌘’

Brushing
Bigger Brush ]
Smaller Brush [
Increase Brush Opacity ⎇ ] ⌥ ]
Decrease Brush Opacity ⎇ [ ⌥ [
Increase Brush Feather ⇧ ]
Decrease Brush Feather ⇧ [
Rotate Brush Clockwise ⇧⎇ ] ⇧⌥ ]
Rotate Brush Clockwise ⇧⎇ [ ⇧⌥ [
Set Brush Opacity ⎇ 1-0 ⌥ 1-0
Toggle Perfect Brush ⌃ R ⌘ R
Hold Perfect Brush Color hold ⌃ hold ⌘
Toggle Paint-in/Paint-out ⇧ X or hold ⎇/⌥
Invert Mask ⌃ i ⌘ i
Draw Straight Line ⇧ click

Misc
Quick Export ⇧ ⌃ S ⇧⌘ S
Print ⌃ P ⌘ P
Undo ⌃ Z ⌘ Z
Redo ⇧ ⌃ Z ⇧ ⌘ Z
Quit ⌃ Q ⌘ Q

Tools
Crop C 
Adjustment Brush K
Adjustable Gradient ⇧ K
Spot Healing Brush Q
Perfect Eraser ⇧Q
Retouch Brush R
Clone Stamp S
Masking Brush B
Gradient Mask/Masking Bug M
Refine Mask N
Zoom/Pan Z
Move/Transform V
Text T
Portrait ⇧ I
Chisel H 
Blur L 

⌃ Control         ⌘  Command         ⎇  Alt       ⌥  Option        ⇧  Shift       ⇥  Tab

ON1 PHOTO RAW 
Common Keyboard Hotkeys
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